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2
About

Section 508 Compliance / Keyboard
Accessibility
The Xerox Nuvera User Interface is fully compliant with Section 508 of the Rehabilitation
Act Amendments of 1998. All controls on the user interface can be accessed using either
keyboard or mouse.

Copyright and Trademark Declarations
©1998-2014 Xerox Corporation. All rights reserved. Xerox ®, Xerox and Design ®, Xerox
Nuvera ®, and FreeFlow ® are registered trademarks of Xerox Corporation in the US
and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated. TIFF
is a copyright of Adobe Systems Incorporated.

AppleTalk, LaserWriter, and Macintosh are trademarks of Apple Computer, Inc.

Digi is a trademark of Digi International.

IPDS is a trademark of IBM Corporation.

Microsoft is a registered trademark of Microsoft Corporation. Windows ® and Windows
Vista® are registered trademarks of Microsoft Corporation. Internet Explorer is a copyright
protected program of Microsoft Corporation.

Novell® and NetWare® are registered trademarks of Novell, Inc.

PCL® and HP-GL® are registered trademarks of Hewlett-Packard Corporation.
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Solaris and Java are trademarks of Oracle and/or its affiliates.

VTAM® is a registered trademark of IBM Corporation.

WinZip® is a registered trademark of Nico Mak Computing, Incorporated.

May 2014

Symbol Usage
Symbols are used on the Xerox Nuvera to draw your attention to important safety notices
and useful information. Observe all cautions, hazards and warnings closely.

When performing maintenance or clearing jams on the machine, be sure to pay attention
to these symbols wherever they appear. The fuser, for example, will be marked with a
warning icon wherever there is a hot surface that could burn your hand if touched.

Flash content
Macromedia Flash version 6 plugin is required to view interactive content and videos.

Third Party Licenses
This product includes the following Third Party software:

• JDOM Project ( http://www.jdom.org )
• Apache Software Foundation ( http://www.apache.org )
• Free Software Foundation ( http://www.gnu.org )
• Java 2 Runtime Environment (J2RE) (

http://www.redhat.com/licenses/thirdparty/sun_j2re.html)

GNU source and object code is subject to the terms of the GNU GPL. Please review the
GNU GPL terms and conditions to understand the restrictions under this license. For
more information on GNU, please go to http://www.gnu.org/licenses/gpl.txt.

As a requirement of the GNU GPL terms and conditions, a list of the source code for the
above programs can be found in the www.xerox.com web site for the product or can be
ordered from Xerox.
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About Xerox Nuvera 100/120/144/157
EA Production System
This printer configuration may be acquired with a simplex, letter size / A4 speeds of 100,
120, 144 or 157 impressions per minute.

The basic configuration of a Xerox Nuvera 100/120/144/157 EA Perfecting Production
System includes:

• Up to four feeders (4-Tray Feed Modules or 2-Tray Feed Modules)
• Control Console
• Sheet Enhancement Module
• Up to two Sheet Insertion Modules (4-Tray or 2-Tray)
• Up to three Xerox Production Stackers (XPS) Modules

A single BFM (BFM, BFM Plus or BFM Direct Connect) can be installed on a 517 or 314
system but only with a Sheet Retime Module (SRM) that is installed before the BFM.
The SRM enables BFM stapling capabilities and increases the arrival time of standard
size sheets to match the 157 speed.

About the Xerox Nuvera 100/120/144 MX
Production System
This printer model may be acquired with simplex, letter size / A4 speeds of 100, 120,
and 144 impressions per minute.

About the Xerox Nuvera 200/288/314 EA
Perfecting Production System
The basic configuration of a Xerox Nuvera 200/288/314 EA Perfecting Production System
includes:

• Up to four feeders (4-Tray Feed Modules or 2-Tray Feed Modules)
• Control Console
• Dual Print Engines (two tandem Xerox Nuvera 100 ppm engines become 200 ppm,

or two 144 ppm engines become 288 ppm, or two 157 ppm engines become 314
ppm)
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• Sheet Enhancement Module
• Up to two Sheet Insertion Modules (4-Tray or 2-Tray)
• Up to three Xerox Production Stackers (XPS) Modules

About the Xerox Nuvera 200/288 MX
Perfecting Production System
The Xerox Nuvera 200/288 MX Perfecting Production System is a digital black and white,
MICR Toner production publishing system. It offers dual print engines for high speed
and high quality duplex printing with numerous finishing options.

Xerox® Nuvera®2-4
User Guide and Training Aid (UGTA)

About



3
Xerox Nuvera 200/288/314
EA Perfecting Production
System

The basic configuration of a Xerox Nuvera 200/288/314 EA Perfecting Production System
includes:

• Up to four feeders (4-Tray Feed Modules, 2-Tray Feed Modules or 3-Tray Feed Modules
• Control Console
• Dual Print Engines (two tandem Xerox Nuvera 100 ppm engines become 200 ppm,

or two 144 ppm engines become 288 ppm, or two 157 ppm engines become 314
ppm)

• Sheet Enhancement Module
• Up to two Sheet Insertion Modules (4-Tray or 2-Tray)
• Up to three Xerox Production Stackers (XPS)

Modules
Your Xerox Nuvera 200/288 EA/MX Perfecting Production System can be configured
with a variey of modules. Select the link below for information on the modules that can
be installed.

4-Tray Feed Module - two standard stock size and two large stock size feed trays. Either
the 4-Tray or 3-Tray SFM must be used with the Roll Feeder option.

Sheet Feed Modules (SFM)

2-Tray Feed Module - two high capacity large stock feed trays.
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Sheet Feed Modules (SFM)

Sheet Enhancement Module - located directly to the right of the A2 print engine, this
module is used to remove upcurl or downcurl in paper as it passes through the module
from the print engine.

Sheet Enhancement Module (SEM)

DS3500 - enables inline finishing by providing document transport capability and full
DFA support to DFA-compliant finishing devices.

DS3500 Specifications

Special Features
The Xerox Nuvera 200/288/314 EA/MX Perfecting Production System is a high speed,
duplex, black and white Production printing system with the following unique features:

• Two EA/MX Production System print engines that print up to 200/288/314 IPM in
duplex mode

• Pass Through Mode feature
• Tabs Optimization Mode feature
• Sheet Enhancement Module
• EA Toner (For MX MICR dry ink)
• Parallel RIP feature
• Image Quality Matching between the print engines
• Ability to connect to many third party finishing devices

Module Options

Basic Finisher Module - stacker/stapler with top tray.

Basic Finisher Module Plus - stacker/stapler with bypass paper path unit.
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Basic Finisher Module Plus Top Tray with Direct Connect - stacker/stapler with bypass
paper path unit with a selectable Top Tray. Directly connects to 3rd party devices via
standard DFA interface and locking pins.

Sheet Retime Module - Required for 157 or 314 systems with a single BFM. The SRM
is installed before the BFM to process sheets at the same system speed going into the
BFM.

Insertion Module - As an option, both the 4-Tray and the 2-Tray Feed Modules can be
used as Insertion Modules.

3-Tray Feed Module - The 3-Tray Feed Module is a modification of the 4-Tray Feed
Module. It can be combined with a 4-Tray or a 2-Tray module. Either the 4-Tray or 3-Tray
SFM must be used with the Roll Feeder option.
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Roll Feeder - provides up to 25,000 11 x 17 inch size sheets and 5 hours of continuous
run time between roll changes.

Optional Inline Finishers - There are a number of DFA compliant external finishers that
can be installed on a Production System. You must have a DS3500 installed to add an
inline finisher.

• C.P Bourg BDFx Booklet Maker
• Xerox SQUAREFOLD Booklet Maker(SQFBM)
• GBC Fusion Punch 11 with Offset Stacker
• Xerox DB120-D Document Binder
• Xerox Manual and Book Factory
• Xerox Tape Binder
• GBC AdvancedPunch Pro (hole punch)
• Xerox Dual Tape Binder - This configuration allows for increased productivity; especially

for booklets 10 to 50 pages in length.

Licensed Features
The software options available to you depend on the licenses that were installed and
enabled on your system at installation. The following lists some of the major licenses
available for the system. Check with your System Administrator for more information
on what licenses are enabled.

• Productivity Pack - when enabled, this license provides multiple print queues instead
of one queue, Stock Library management, shows all media attributes, and is required
for LCDS and IPDS printing. Also includes the ability to enter exactly the paper weight,
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between 56 gsm and 250 gsm (upper weight depends on finisher type) for the stock
that is being loaded.

• Enhanced Line Screen - when enabled, this license allows all valid halftones to print
(85 lpi, 106 lpi, 125 lpi, 134 lpi and 156 lpi) and offers additional halftone image
quality settings.

• PCL License
• Ethernet License - Bus & Tag are optional
• PS License
• DFA License
• Imposition License
• LCDS License
• IPDS License
• VIPP License (FreeFlow VI Interpreter)
• Disk Overwrite License
• Full, Basic, CPW (XPP) or ISO Diagnostics License
• Speed License

FreeFlow Print Server and Print Engine
Control Console - houses the computer components that drive your Xerox Nuvera system.
The mouse driven UI provides access to the tools to manage jobs and the system.

Control Console

Print Engine - xerographics module

Print Engine Module
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4
Xerox Nuvera EA/MX
Production System

The Xerox Nuvera EA/MX Production System includes a wide range of configuration
options based on your printing and publishing needs. You can select certain types of
Sheet Feed Modules and Finishing modules to install with your system, as well as choose
certain feature software licenses.

Basic Configuration
The basic configuration of a Xerox Nuvera EA/MX Production System includes the
following:

• 4-Tray or 2-Tray Sheet Feeder Module (SFM)
• Control Console
• Print Engine
• Sheet Enhancement Module (not available if an MFF module is attached)
• Multifunction Finisher (either the Professional MFF or the Pro Plus MFF) or Basic

Finishing Module (BFM)
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• The base FreeFlow Print Server licensing includes 100 or 120 print speed, EA dry ink
(toner), single print queue, no Stock Library, 125 lpi halftone screen for use with
PS/PDL, TIFF, ACSII and PCL

Sheet Feed Modules
4-Tray Feed Module - two standard stock size and two large stock size feed trays. It can
be used with the Roll Feeder option.

2-Tray Feed Module - two high capacity large stock feed trays. Sheet Feed Modules
(SFM)

3-Tray Feed Module - The 3-Tray Feed Module is a modification of the 4-Tray Feed
Module. It can be combined with a 4-Tray or a 2-Tray module. It can be used with the
Roll Feeder option. Sheet Feed Modules (SFM)

Roll Feeder - provides up to 25,000 11 x 17 inch size sheets and 5 hours of continuous
run time between roll changes.

Integrated Scanner - scans single pass duplex at 120 ppm.
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Post Process Module
Sheet Enhancement Module - located directly to the right of the print engine, this
module is used to remove upcurl or downcurl in paper as it passes through the module
from the print engine.

Sheet Enhancement Module (SEM)

FreeFlow Print Server and Print Engine
Control Console - houses the computer components that drive your Xerox Nuvera system.
The mouse driven UI provides access to the tools to manage jobs and the system. Control
Console

Print Engine - xerographics module Print Engine Module

Additional Configurations
You can customize the system by identifying whether to include an integrated scanner,
a second Sheet Feeder Module, an insertion module and the complexity of your finishing
devices. The type of finisher you select can determine what other modules and license
configuration options can be included.

The following modules are available for your system:

• Additional 2-Tray or 4-Tray Sheet Feeder Modules for a total of up to four SFMs
• An optional 3-Tray Sheet Feeder Module (either the 3-Tray or 4-Tray SFM can be

used with the Roll Feeder if attached)
• The optional integrated Document Scanner Module (available only with the 4-Tray

Sheet Feeder Module)
• Up to two Insertion Modules (a 2-Tray or 4-Tray SFM)
• Multifunction Finisher (Professional or Pro Plus)
• One or two Basic Finishing Module (BFM or BFM Plus)
• Up to three Xerox Production Stackers
• DS3500
• Third party finishing devices
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Finisher Modules
Multifunction Finisher Professional - Professional model offers stacking/stapling, booklet
making and c/z-folding.Multifunction Finisher (MFF)

Multifunction Finisher Pro Plus - The Pro Plus model adds to the Professional capabilities
by also offering hole punching and an insertion module. Multifunction Finisher (MFF)

Basic Finisher Module - stacker/stapler with top tray. Basic Finishing Module (BFM/BFM
Plus) Specifications

Basic Finisher Module Plus - stacker/stapler with bypass paper path unit Basic Finishing
Module (BFM/BFM Plus) Specifications. Not compatible with the 157/314 systems.

Basic Finisher Module Plus Top Tray with Direct Connect - stacker/stapler with bypass
paper path unit with a selectable Top Tray. Directly connects to 3rd party devices via
standard DFA interface and locking pins. Basic Finishing Module (BFM/BFM Plus)
Specifications. Not compatible with the 157/314 systems.

Xerox Production Stacker - Optional finisher that works with the Nuvera Model IV.
Available on both single and dual configurations this stacker allows unloading of the
stacker at any time.

Insertion Module - As an option, both the 4-Tray and the 2-Tray Feed Modules can be
used as Insertion Modules.

DS3500 - enables inline finishing by providing document transport capability and full
DFA support to DFA-compliant finishing devices. DS3500 Specifications

Optional Inline Finishers - There are a number of DFA compliant external finishers that
are DFA compliant and can be installed with the system. You must have a DS3500
installed to add an inline finisher.

• Xerox DS5000 High Capacity Stacker
• C.P Bourg BDFx Booklet Maker
• Xerox SQUAREFOLD Booklet Maker(SQFBM)
• GBC Fusion Punch 11 with Offset Stacker
• Xerox DB120-D Document Binder
• Xerox Manual and Book Factory
• Xerox Tape Binder
• Dual Xerox Tape Binder - This configuration allows for increased productivity; especially

for booklets 10 to 50 pages in length.
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Xerox Production Stacker (XPS)

The Xerox Production Stacker (XPS) with Document Finishing Architecture (DFA) Finishing
is a finishing option available for the Model IV Nuvera.

This finishing device provides output trays that eject and rise to near waist height of
the user. If the height selected is not appropriate, this height can be adjusted. The sheet
capacity for these output trays is increased from other stackers. The XPS stacks 5,700
(2 stacks of 2,850). The stacker can be released to unload while the system is still running
and printing, which allows for constant production. This is also true when using a single
stacker.

For more detailed information about the XPS, refer to the Xerox Nuvera® Xerox
Production Stacker Operator Manual.

Licensed Features
The software options available to you depend on the licenses that were installed and
enabled on your system at installation. The following lists some of the major licenses
available for the system. Check with your System Administrator for more information
on what licenses are enabled.

• Productivity Pack - when enabled, this license provides multiple print queues instead
of one queue, Stock Library management, shows all media attributes, and is required
for LCDS and IPDS printing. Also includes the ability to enter exactly the paper weight,
between 56 gsm and 250 gsm (upper weight depends on finisher type) for the stock
that is being loaded.
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• Enhanced Line Screen - when enabled, this license allows all valid halftones to print
(85 lpi, 106 lpi, 125 lpi, 134 lpi and 156 lpi) and offers additional halftone image
quality settings.

• PCL License
• Ethernet License - Bus & Tag are optional
• PS License
• DFA License
• Imposition License
• LCDS License
• IPDS License
• VIPP License (FreeFlow VI Interpreter)
• Disk Overwrite License
• Full, Basic, CPW (XPP) or ISO Diagnostics License
• Speed License - 100, 120 or 144 ppm are available on systems with a BFM/BFM Plus

and/or DS3500. The 100/120 license is on systems with MFF.

Flex Speed Option
Note
The Flex Speed option is only available for 10.x version software and above. Systems
that contain a Multifunction Pro or ProPlus finisher are not eligible for the Flex Speed
option.

The Flex Speed option allows you to upgrade the license of certain Xerox Nuvera systems
for a period of 30, 60 or 90 days.

Available Flex Speed OptionsOriginal Xerox Nuvera Speed

Xerox Nuvera 120 EA/MX Production System or
Xerox Nuvera 144 EA/MX Production System

Xerox Nuvera 100 EA/MX Production System

Xerox Nuvera 144 EA/MX Production SystemXerox Nuvera 120 EA/MX Production System

Xerox Nuvera 288 EA/MX Perfecting Production
System

Xerox Nuvera 200 EA/MX Perfecting Produc-
tion System

For more information on enabling Flex Speed, contact your Xerox representative.

Loading Paper
Load paper as indicated by the labels on each paper tray. If you are using the 2-Tray
Feed Module, load paper as indicated for trays 3 and 4 of the 4-Tray Feed Module.

Note
If printing on coated stock but only one side is coated, load the coated side up.
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Systems with the Multifunction Finisher DO NOT support coated stock.

Note
Stocks greater than 250 gsm are not recommended for use with the Xerox Nuvera . For
details on using the correct stocks, see Supported Paper.

Note
Loading papers of varying types and weights may warrant adjustment of the Sheet
Enhancement Module. For details, see Managing Paper Curl.

Note
It may be possible to configure your Xerox Nuvera with two or more SFMs, effectively
doubling the feed capacity of the system. See your Xerox sales representative if you
wish to configure your system in this way.

Paper Tray Programming
When you load paper in a paper tray, you must program the tray for the paper it contains.

To avoid loading a paper stock unsupported by the machine, see Recommendations for
Paper Usage.

For details on paper handling and storage, see Handling and Storing Paper.

For details on loading special papers, see Loading Special Stock for Proper Finishing
Output.

Caution
Paper trays do not lock and can be opened while paper is being fed from the tray, resulting
in misfeeds and/or paper jams. Wait for the LED light on the tray to turn OFF before
opening the tray.

Solving Image Quality Problems
The Xerox Nuvera is capable of reproducing and generating high-quality images.

However, image defects may occur. These image quality problems are usually attributed
to a defective original, or the user applying too much, too little, or the wrong type of
image quality control.
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Contacting Xerox
Before contacting Xerox for a service problem, perform the following steps:

• For image quality problems, first attempt to resolve the problem using the image
quality troubleshooter.

• For worn out customer replaceable units, first attempt to replace the component
yourself.

Sheet Feed Modules (SFM)
The Sheet Feed Modules hold your paper and feed the appropriate stock for the current
job settings. The Xerox Nuvera System can be configured with a 4-Tray Feed Module, a
2-Tray Feed Module or a 3-Tray Feed Module. Your system can include up to two SFMs
in any combination of 4-Tray, 2-Tray or 3-Tray.

The 2-Tray Feed Module has two large format large capacity trays. These trays are
similar to trays 3 and 4 on the 4-Tray Feed Module but with a larger capacity, holding
up to 1,600 sheets. Refer to the Feed Module Specifications.

The 4-Tray and the 2-Tray Feed Modules can be used as post fuser Insertion Modules.

The SFMs support automatic tray switching and the ability to load while printing.

For details about the 4-Tray Sheet Feed Module and its trays, capacities, features and
functions, browse the links below. The links are grouped according to the numbered
areas in the diagram.
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Feed Module Specifications

Areas 1, 2, & 3 Paper feed path

• Clearing paper jams

Area 4 Paper trays

• Loading paper trays
• Configuring paper stocks and tray settings
• Handling and storing paper
• Using special paper stocks
• Clearing paper jams
• Supported paper types
• Recommendations for paper usage
• Expected paper handling and copy performance

Print Engine Module
The Print Engine houses the xerographic components that transfer the digital image to
the paper at the photoreceptor. The toner from the dry ink container is then fused to
the paper in the Fuser. Xerox Nuvera EA Production Systems do not support MICR printing
and uses EA dry ink only. The Xerox MX Perfecting Production Systems do support MICR
printing. For details, features and functions of the various components, browse the links
below.
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For print engine specifications, refer to Printer capabilities.

• 1. Developer Waste Container: Replacing the Developer Waste Container when full
• 2. Dry Ink (toner) Container: Replacing the Dry Ink Container
• 3. Paper Path: Clearing paper jams
• 4. Fuser and Decurler: Clearing paper jams and Adjusting the Decurler
• 5. Dry Ink (toner) Waste Container: Replacing the Dry Ink Waste Container when full

Control Console
Jobs are programmed using the keyboard or mouse to click the buttons on the control
screen. The Xerox Nuvera can also print jobs stored on CD. Browse the links below for
more details about features and functions.

• 1. Keyboard and mouse: Keyboard, mouse and display specifications, Cleaning the
mouse, and Cleaning the keyboard

• 2. Control Screen: Keyboard, mouse and display specifications and Cleaning the
display

• 3. Media Drive Bay: Media Drive specifications and Printing from the Media Drive
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• 4. Power Switch: Power procedures

Multifunction Finisher (MFF) Interface
The Interface Module on the Multifunction Finisher Professional is part of the paper
path that allows the Xerox Nuvera to connect to the Multifunction Finisher. For the
Multifunction Finisher Pro Plus, it is also an Insertion Module that includes an Insertion
Tray on top and a Hole Punch unit and waste bin inside.

The MFF Pro Plus

To learn about clearing jams in this area, refer to Clearing paper jams.
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MFF Professional

Multifunction Finisher (MFF)
The Multifunction Finisher adds a publishing capability to the Xerox Nuvera system. The
MFF Professional can fold documents, make booklets, staple bindings, collate and stack
output. If your system has the MFF Pro Plus model, Pro Plus provides the same
functionality but adds post process insertion capability (covers, preprinted sheets, tabs)
and hole punch finishing.

The Interface Module on the Multifunction Finisher Professional is part of the paper
path that allows the Xerox Nuvera to connect to the Multifunction Finisher. For the
Multifunction Finisher Pro Plus, it is also an Insertion Module that includes an Insertion
Tray on top and a Hole Punch unit and waste bin inside.

To learn more about its features and functions, browse the links below.

• 1, 2. Paper Path: Clearing paper jams
• 3. Top Tray: Finisher specifications
• 4. Main Tray / Stacker: Finisher specifications, Using Offset to separate documents

in a stack, and Using the stacker
• 5. Main Stapler: Stapler specifications
• 6. Lower Tray: Finisher specifications
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• 7. Booklet Maker: Making a booklet and About impositions

MFF Pro Plus: Insertion Module

To learn about the MFF models and their features, refer to Finisher specifications.

To learn about clearing jams in this area, refer to Clearing paper jams.

Automatic Document Feeder
Use the Automatic Document Feeder for rapid scanning of stacks of documents. Browse
the links below for more information.

• 1. Document Glass (not shown): Scanning from the Document Glass and Cleaning
the Document Glass
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• 2. Document Input Tray: Scanning from the Document Feeder, Clearing paper jams,
Document Feeder and Scanner specifications, and Cleaning the Document Feeder

• 3. Document Exit Tray

Sheet Enhancement Module (SEM)
The Sheet Enhancement Module on the Xerox Nuvera EA Production System and the
Xerox Nuvera 200/288 EA/MX Perfecting Production System is a standard component
on all configurations except for those with a Multifunction Finisher.
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Located to the right of the print engine, it is used to remove upcurl or downcurl in paper
as it passes through the module from the print engine. This feature is performed
automatically by the system when the Decurl Automatic Mode is selected. You can also
manually adjust the amount of decurl to apply for the job if more decurl is needed.
Select the Manual or Automatic mode settings at the FreeFlow Print Server from the
Printer menu. For more information, see Managing Paper Curl.

Sheet Enhancement Module Specifications

• Height: 41.5 "
• Width: 14.25 "
• Depth: 28.25 "
• Weight: 168 lbs.
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Sheet Retime Module (SRM)
The Sheet Retime Module (SRM) is a paper path timing module required to be installed
only on 157 or 314 systems with a single Basic Finishing Module (a BFM, BFM Plus or a
Direct Connect BFM).

The SRM is located before the BFM in the configuration. It enables BFM stapling
capabilities and increases the speed of the sheets as they enter the BFM. It provides the
needed gap between prints for the BFM to process sets at 157 or 314 ppm and staple
sets at this full speed.

Note
Only A4/8.5 x 11 inch paper will run at the full 157 ppm or 314 ppm speed. Tab jobs
and stock sizes less than 8.2 inches will run at reduced productivity.

Note
Small stock sizes less than 6.9 inches (175mm), such as A5 paper, cannot be run through
the SRM.

Note
When running tab stock mixed with 8.5 x 11 in/A4 body stock enable the Improve Initial
Pages Registration within Set feature from Print Manager/Stacking area.
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5
Managing System
Resources

This section provides an overview of system management and some of the key
configuration tools, such as Queue Manager, that operators may need to use. For detailed
information, see the System Administrator's Guide.

• Managing the Printer
• Getting Billing Information
• Reading the Billing Meters
• Managing System Software and Hardware
• Managing the Stocks Library
• Working with Queues
• Changing DFA Configurations for 3rd Party Finishers

Managing the Printer
You can use the Printer menu to globally manage all aspects of the printer, including
print quality, what types of papers are loaded, and tray enabling/disabling. Review the
sections below to familiarize yourself with this part of the Xerox Nuvera user interface.

Printer Menu Selections

Paper Trays

Shows the status of all the paper trays, as well as the types of stocks assigned to them.
The columns show the properties of the stocks and the specifications that have been
made for the trays.
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Stock Library

If the Productivity Pack license is enabled on your system, the Stock Library database
is available. The Stock Library allows you to see the complete list of stocks present, as
well as all stocks compatible with the system. Also, new stock types can be added
through this tab. For details, see the online Help.

Finishing

Used to set up or enable the available finishing options. Right-clicking on a finisher
allows you to enable or disable a finisher or display its properties.

Stacking

Allows you to enable and disable the stacker (if stackers are present with your system).
It also allows you to view and control settings for all stackers on your system.

Image Quality

Used to modify the printer darkness/IQ parameters for PostScript/PDF jobs, PCL jobs,
and TIFF jobs.

Managing Paper Trays

The Paper Trays selection allows you to manage the following operations:

• Access paper tray properties
• Set stock properties
• Enable/Disable a paper tray
• Refill a tray
• Enable/Disable cleanup
• Enable/Disable stock size checking
• Load and program a stock

For more information, see Setup Paper Trays.

Managing Finishers

The Finishing selection allows you to view the status of Internal and External Finishers.

Tip
Before running any jobs, click Printer Menu > Finishing to quickly determine what types
of Finishing devices are currently available and configured.

Note
See your System Administrator to change any settings on the Finishing window.

What Are Internal and External Finishers?
• Internal Finisher: i.e., the Stapler and Bottom Tray/Booklet Maker.

Xerox® Nuvera®5-2
User Guide and Training Aid (UGTA)

Managing System Resources



Name: Shows the name of the device.-
- Status: Indicates whether the finisher is enabled or disabled.

• External Finisher: External finishing options include any DFA compliant 3rd-party
finishers that can be attached to the printer. If the printer is not configured with an
external finisher, this field is not available.

Managing Stackers

The Stacking selection allows you to view the status of Stackers which may be configured
on the system.

Tip
Before running any jobs, click Printer Menu > Stacking to quickly determine what types
of Finishing devices are currently available and configured.

Note
See your System Administrator to change any settings on the Stacking window.

Managing Image Quality

The Image Quality selection allows you to globally set the darkness and resolution levels
for system supported file types.

If you are having Image Quality problems on a consistent basis (for example, your entire
job is either too light or too dark), check image quality settings using the Image Quality
selection on the Printer menu. For more information, see Solving Image Quality Problems.

Tip
Before running any jobs, select Image Quality on the Printer menu to quickly determine
what global machine darkness and resolution settings are currently configured.

Note
See your System Administrator to change the darkness and/or resolution settings on
the Image Quality window.

User Interface Logging

This feature logs operator actions. It allows the customer to view the log and determine
actions taken by the operator such as changing job parameters, queue settings, system
settings or printer properties.

To enable and view the Log Console:
1. Select System  > Log console.
2. Click Enable Logging.
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Getting Billing Information
The Billing capability enables the user to view and print Xerox billing data.

Why would I need to access billing information?

A few examples of why you need to access billing data:

• You can gain system usage information to more accurately plan your supplies
re-ordering.

• During a service call, you may be asked to retrieve billing information to aid a service
representative in identifying any problems with your system.

• Depending on the terms of your purchase agreement, you may need to access and
print the billing data in order to be billed by Xerox.

• If the machine is used by personnel in shifts, billing data can be printed to track
system usage for each shift.

To access billing information
1. In the user interface, click Administration > Billing.

The Billing dialog box appears.
2. With the Billing dialog box open, you can then print the information, or relate it to

the service representative if contacting by phone.
For more information about what each Billing Meter is recording, see Reading the
Billing Meters.

3. Click Close.

Depending on your system's security setting, you may or not be able to access billing
data. Contact your System Administrator for adjusting your system's security setting.

Reading the Billing Meters

Following are descriptions of what each Billing Meter is tracking. Make sure you have
correctly identified your region.

Billing Regions

Region 4Region 3Region 2Region 1
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FXNASG-CANESGNASG-US

FXAPDMO-E

DMO-W

China

APO

Descriptions of Billing Meters

Billing Region 1

Meter A -Represents total impressions to output destination.

Meter B -Represents total impressions for each image of job up to and including the
last sheet of the 10th set.

Meter C -Total impressions for all jobs that reach a breakpoint value.

Meter D -Total impressions for all images of a job above a breakpoint value.

Meter E - Total impressions printed on sheets wider than 16 " (Nuvera Xerox Nuvera
200/288 EA/MX Perfecting Production System only)

Billing Region 2

Meter 1 -Total impressions to output destination.

Meter 2 -Total impressions printed on sheets wider than 16 ".

Meter 3 -Total impressions for sets 11-18.

Meter 4 -Total impressions for set 19.

Meter 5 -Total impressions for all jobs that reach a breakpoint value.

Meter 6 - Total impressions for all images of a job above a breakpoint value.

Billing Region 3

Meter A -Represents total impressions to output destination.

Meter B -Total impressions for all jobs that reach a breakpoint value.

Meter C -Total impressions for all images of a job above a breakpoint value.

Meter D - Total impressions printed on sheets wider than 16" (Xerox Nuvera 200/288
EA/MX Perfecting Production System only)

Billing Region 4

Meter 1 -Represents total impressions to output destination.
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Meter 2 -Total impressions for each image of a job up to and including the last sheet
of the 10th set.

Meter 3 -Total impressions printed on sheets wider than 16 " (Xerox Nuvera 200/288
EA/MX Perfecting Production System only).
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6
Managing System Software
and Hardware

In the event you need to install a software patch or upgrade, or attach new hardware,
this can be done with the Xerox System Install Service Utility.

To access the Xerox System Install Service
Utility
1. In the Xerox Nuvera user interface, click System > Software Install.
2. Choose from one of the utilities.
3. Follow on-screen instructions.

See the Xerox Nuvera online Help--accessed directly from the user interface--for
details about this utility.

4. Click Close.

To perform Disk Overwrite
This procedure enables the System Administrator to erase sensitive data from all hard
disks (for example, the system disk and image disks). The Disk Overwrite feature is based
on the current FreeFlow Print Server data overwrite feature. The erase algorithm and
patterns conform to U.S. Department of Defense overwrite requirements.
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Note
This feature requires the presence of the Disk Overwrite software and license in order
to function. The Disk Overwrite software is on a CD included as part of the Disk Overwrite
kit. The software must be installed before enabling the license. Contact your System
Administrator to perform any activity related to Disk Overwrite.

Xerox® Nuvera®6-2
User Guide and Training Aid (UGTA)

Managing System Software and Hardware



7
Managing the Stock Library

Note
The Stock Library selection, located on the Printer menu, is only available on systems
that have the Productivity Pack license installed and enabled.

The Stock Library selection enables you to add to the group of stocks that are eligible
to print. You can define attributes for a stock (such as size, color, type, and weight) and
assign a name to identify the stock and its associated attributes. The standard stock
names Main, Aux, and Auto are also available.

Stock Management
Once a stock type has been defined, named, and saved as a new stock, it can be easily
referenced from the Stock List, which is accessible from many different locations in the
FreeFlow Print Server software.

You can perform the following tasks from the Stock Library tab:

• Set up a new paper stock in the stock list
• Modify a stock entry
• Copy a stock entry
• Delete a stock
• Assign stock to a paper tray
• Remove stock from an assigned tray
• Add stock to a preferred tray
• Enable/disable cleanup
• Hide/Show stock entries
• Import/Export stock settings
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Note
If a user submits a job that specifies a user-defined stock not available in the Stock
Library, the job is still submitted to the FreeFlow Print Server. However, the job is faulted
until the requested, or user-defined, stock is programmed into the Stock Library.

The Stock List

The Stock List is a GUI screen that is accessible from many different locations in the
FreeFlow Print Server software. A named stock can be easily selected from this list and
used in a variety of situations. Examples of activities during which the Stock List is
accessed include (but are not limited to):

• Assigning a named stock to a job
• Assigning a named stock as default for a queue
• Assigning a named stock as default for slip sheets
• Assigning a named stock as one or more cover pages
• Assigning a named stock to be used as an exception page

To set up/manage paper stock
1. On the Printer Menu, select Stock Library.
2. Select the New Stock to display the New Stock dialog.
3. Enter a new stock name in the Name field.
4. Select the tray for this stock by using the Add to Trays button, click OK.
5. Select stock properties from the Size/Color, Type/Weight, and Coating controls.
6. Enter any desired stock comments by selecting the Options button.
7. Click Close.

Note
When loading stock, it is recommended that you either enter a specified name for all
stocks, or use "unspecified" as a name value for all stocks. You should never mix named
stocks with "unspecified" stocks since Required Stock Not Loaded issues may arise.

For more information about the Stock Library, see the online Help on the system user
interface.
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8
Expected Paper Handling

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system; either through the
paper feed trays or the Document Feeder.

Expected Performance Tables
Table 1: Paper and Tray Performance Matrix -- 20 lb standard paper

Table 2: Paper and Tray Performance Matrix -- 80 gsm standard paper

Table 3: Stock Types Performance Matrix

Table 4: Plain Paper Performance Matrix

Table 5: Paper and Tray Performance Matrix -- Loading Special Stock

Table 6: Paper Through Document Feeder Performance Matrix

Paper and Tray Performance Matrix -- 20 lb standard paper

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system.

Note3,41,2Trays

Common Sizes

BestBestLEFLetter (8.5 x 11 /
216 x 279mm)

GoodGoodSEF

BestNASEFLegal (8.5 x 14 /
216 x 356mm)
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Note3,41,2Trays

Common Sizes

GoodNASEFLedger (11 x 17
in. / 297 x
420mm)

See Note belowNAFairSEFStatement (5.5 x
8.5 in. / 140 x
216mm)

GoodGoodLEFExecutive (7.25 x
10.5 in. / 184 x
267mm)

GoodGoodLEFExecutive (8 x 10
in. / 203 x
254mm)

GoodNRSEF

GoodNRSEF12 x 18 in. / 305 x
457mm

Table Legend

• SEF: Short Edge Feed
• LEF: Long Edge Feed
• Best: Best system performance
• Good: Good system performance
• Fair: Significant performance degradation is likely, particularly paper handling.
• NR: Not Recommended. Exceeds system design. Unacceptable performance likely.
• **: Same performance as shown in 20 lb. Standard Paper Table for the corresponding

paper sizes.
• NA: Not Applicable. Not possible to load.

Note
The output will go to the Top Tray in an MFF-equipped machine, and cannot be stapled.

Paper and Tray Performance Matrix -- 80 gsm standard paper

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system.

Note3,41,2Trays

Common Sizes

BestBestLEFA4 (210 x 297mm
/ 8.27 x 11.69)

GoodNASEF
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Note3,41,2Trays

Common Sizes

GoodNASEFA3 (297 x 420mm
/ 11.69 x 16.54)

See Note belowNRGoodLEFA5 (148 x 210mm
/ 5.83 x 8.27)

See Note belowNRNRSEF

GoodNASEFB4 (257 x 364mm
/ 10.12 x 14.33)

GoodGoodLEFB5 (182 x 257mm
/ 7.17 x 10.12)

GoodGoodLEFA4 Cover Stock
(223 x 297mm /
8.78 x 11.69)

GoodNASEF

GoodGoodSEFSpanish (215 x
315mm / 8.46 x
12.4)

GoodGoodSEFFoolscap (215 x
315mm / 8.46 x
12.4)

FairNASEFFoolscap (220 x
330mm / 8.66 x
13)

Table Legend

• SEF: Short Edge Feed
• LEF: Long Edge Feed
• Best: Best system performance
• Good: Good system performance
• Fair: Significant performance degradation is likely, particularly paper handling.
• NR: Not Recommended. Exceeds system design. Unacceptable performance likely.
• **: Same performance as shown in 20 lb. Standard Paper Table for the corresponding

paper sizes.
• NA: Not Applicable. Not possible to load.

Note
The output will go to the Top Tray in an MFF-equipped machine, and cannot be stapled.

8-3Xerox® Nuvera®

User Guide and Training Aid (UGTA)

Expected Paper Handling



Stock Types Performance Matrix

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system.

Note
Performance of the following stock types may not be equivalent to papers in the same
weight range.

NoteThroughput Material

Window Stock

Refer to notes 2 and 3 belowLetterhead

Refer to note 2 belowPre-printed forms

Refer to note 2 belowPre-drilled/pre-punched hole
(standard locations)

LEF (mylar on long edge)Mylar reinforced

SEF

Transparencies

Note
The paper path/sensors in the
Xerox Nuvera do not require
that you feed transparencies
with removable stripes. If you
have this type of media, you
can use it, but the stripe is not
necessary for proper function.

Note
For dedicated transparency
trays, first place approximately
half an inch (12 mm) worth of
plain paper at the bottom of
the tray. This will ensure that
all 50 of the transparencies get
used.

Refer to note 6 belowClear/plain

Refer to note 6 belowNon-removable white stripe

Refer to note 6 belowLEFRemovable Stripe

SEF

Refer to note 6 belowSEF DO NOT USEPaper backed

LEF

Refer to note 4 belowLEFLabels
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Refer to note 2 belowSEF

LEFGBC brand or pre-punched with
rectangular holes: (holes on
long edge). This type of paper
only works when holes are at
the rear of the paper tray.

Refer to note 4 below(Load
with holes AWAY from user.)

SEF

Never Tear Type

Drafting Film

Perforated:

Refer to note 5 belowPerforations parallel to feed
direction

Refer to note 5 belowPerforations perperdicular to
the feed direction

Envelopes (standard medium
to large lettersize)

Tabs

Carbonless

Refer to note 7 belowTextured papers, Vellum Bristol
papers

Smooth cover index stock

Table Legend

• SEF: Short Edge Feed
• LEF: Long Edge Feed
• Best: Best system performance
• Good: Good system performance
• Fair: Significant performance degradation is likely, particularly paper handling.
• **: Same performance as shown in 20 lb. Standard Paper Table for the corresponding

paper sizes.

Notes:

1. The output will go to the Top Tray in an MFF-equipped machine, and cannot be
stapled.

2. Refer to Table 5 or to the paper tray label for the correct paper loading orientation.
3. Embossed letterhead may cause degraded paper handling, and possibly image

deletion defects near the embossed area on either side of the paper.
4. Refer to Table 5 for more information.
5. Image deletion defects might occur near the perforation, especially if the perforation

is parallel to the feed direction.
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6. 2-sided copies or prints should not be selected when this stock is used.
7. Blank or preprinted covers are acceptable.

Plain Paper Performance Matrix

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system

NoteTray 3,4Tray 1,2Throughput Material
(8.5 x 11 inch or A4)

Paper Weight

Do Not UseDo Not UseLess than 56 gsm

Good/FairGood/FairBetween 16 - 20 lb. or
56 gsm

BestBestBetween 20 - 32 lb. or
75 - 120 gsm

GoodGoodBetween 32 - 110 lb.
(index) or 120 - 216
gsm

Do Not UseDo Not UseGreater than 110 lb.
(index) or 250 gsm;
Greater than 220 gsm
for systems with a MFF

Table Legend

• SEF: Short Edge Feed
• LEF: Long Edge Feed
• Best: Best system performance
• Good: Good system performance
• Fair: Significant performance degradation is likely, particularly paper handling.
• NR: Not Recommended. Exceeds system design. Unacceptable performance likely.
• **: Same performance as shown in 20 lb. Standard Paper Table for the corresponding

paper sizes.

Paper and Tray Performance Matrix -- Loading Special Stock

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system

NoteRecommendationCommon UsesStock Type

Use long edge feed for
best copy speed (load
with holes to the right).

Ringed bindersHole-Punched

Xerox® Nuvera®8-6
User Guide and Training Aid (UGTA)

Expected Paper Handling



NoteRecommendationCommon UsesStock Type

When printing on
coated stock that has
only one side coated,
load the coated side
UP.

Presentations, collater-
als

Coated (not supported
on MFF)

Where possible, load
with perforation paral-
lel to the feed direc-
tion.

Pages for partial re-
moval, such as order
forms and receipts

Perforated

• Use ultra-violet
cured or oxidative
inks to extend the
life of the feed roll
cartridges.

• Load face-up in
Trays 1 - 4.

Common correspond-
ence, mailings and ad-
vertising materials

Pre-printed and letter-
head

• Load reinforced
edge on the right
in Trays 1 - 4.

• Use long-edge feed
only.

Ring bindersReinforced Mylar edge

For best results, set
Heavy Weight attrib-
ute when program-
ming Trays 1 - 4.

Covers, signsCard stock
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NoteRecommendationCommon UsesStock Type

Note
The paper
path/sensors in the
Xerox Nuvera do not
require that you feed
transparencies with re-
movable stripes. If you
have this type of me-
dia, you can use it, but
the stripe is not neces-
sary for proper func-
tion.

Note
For dedicated transpar-
ency trays, first place
approximately half an
inch (12 mm) worth of
plain paper at the bot-
tom of the tray. This
will ensure that all 50
of the transparencies
get used.

• For all transparen-
cies, refer to the la-
bel on the tray for
correct orientation.

• When using trans-
parencies with re-
movable stripes,
load with the stripe
down in Tray 1 - 4.

• Do not program 2-
sided.

• For best results, set
Heavy Weight at-
tribute when pro-
gramming Trays 1
- 4.

• Nuvera supports
only 8 1/2 x 11"
(A4) transparen-
cies.

PresentationsTransparencies
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NoteRecommendationCommon UsesStock Type

• Do not program 2-
sided.

• For best results,
feed labels into the
machine LEF only.

• Load face-up in
Trays 1 - 4.

• For best results, set
Heavy Weight at-
tribute when pro-
gramming Trays 1
- 4.

Self-adhesive labels for
envelopes and pack-
aging

Labels

Paper Through Document Feeder Performance Matrix

The Xerox Nuvera can process a wide array of stock types. Use the following topics to
learn how each stock type can be expected to perform in the system.

Tip
If you're having feeding problems through the Document Feeder, all problems can be
avoided by scanning directly from the Document Glass.

NotesRatingTypes and Condi-
tions of Originals

A 12x18 inch original actually will travel through
the Document Feeder, but there is a good chance
some information on the output will be lost. To
ensure all image information from a 12 x 18 inch
original is captured, use the Document Glass.

Do Not Feed12 x 18 inch origin-
als

Feeding lightweight coated originals (approxim-
ately 16 lb. or 61 gsm) will normally work fine. You
may experience problems with the alignment of
the copy images if a color image is within 0.4 inches
of the leading edge (the side of the document fed
first) of the original.

FairCoated paper

Originals with a high talc content may contaminate
the Document Feeder Feed Rolls, resulting in de-
graded performance.

Good / FairHigh Talc paper

On copies with a high-area coverage (pictures and
halftones) tends to rub off on Feed Rolls, causing
feeding faults.

FairOriginals produced
on a DocuTech
100/120

Oils used to fuse the copies need to dry at least 2
hours in order to prevent feeding problems.

Good / FairOriginals produced
on a DocuTech
100/120
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NotesRatingTypes and Condi-
tions of Originals

Use Document Glass to avoid feeding problems.Do Not FeedXerographic color
originals

Will transfer lead to the Feed Rolls, causing the
originals to smear. Originals with occasional marks
(i.e., a document with review markup) should feed
satisfactorily. To avoid problems, feed all pencil-
marked originals from the Document Glass.

Do Not FeedOriginals consisting
of mostly pencil
marks

Originals with dog-ears or folded corners on the
lead edge may cause a jam. Ensure that the folds
are removed.

Do Not FeedDog-eared originals
(folded corners)

Depending on the model, the Document Feeder
can feed up to 300 sheets of 20 lb. paper. The
quantity that can be fed decreases as paper weight
increases. Use Build Job to feed more than these
amounts as a single copy job

Do Not FeedToo many sheets in
the stack

Folded originals do not trigger the automatic
sensors in the Document Feeder. Ensure that the
folds are removed.

Do Not FeedFolded originals

May be fed after sticky notes removed.Do Not FeedOriginals with sticky-
notes attached

Copy from the Document Glass.Do Not FeedEnvelopes

Copy from the Document Glass.Do Not FeedTab stock

Copy from the Document Glass.Do Not FeedLabels

Copy from the Document Glass.Do Not FeedGBC-brand papers

Copy from the Document Glass.Do Not FeedGlossy photographs

Copy from the Document Glass.Do Not FeedTransparencies

Table Legend

• SEF: Short Edge Feed
• LEF: Long Edge Feed
• Best: Best system performance
• Good: Good system performance
• Fair: Significant performance degradation is likely, particularly paper handling.
• NR: Not Recommended. Exceeds system design. Unacceptable performance likely.
• **: Same performance as shown in 20 lb. Standard Paper Table for the corresponding

paper sizes.
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Paper Weight Conversion Chart
If the various g/m2 numbers describing paper weight confuse you, use this table to find
the equivalent weight (in pounds).

Paper Weight Conversion Chart

Paper Weight Conversion Chart

The following "Equivalent weights" chart shows you which weights of the different paper
types are equal to the same number of grams per square meter.

Note
Weights are based on stacks of 500 sheets of the size indicated at the top of each
column, under the paper type.

Tip
Print this topic and post near your system for quick reference to this paper data.

Table 1. Size of unfinished substrates before cutting to size.

Metric
(g/m2)

Index
25.5x30.5*

Bristol
22.5x28.5*

Cover
20x26*

Book
25x38*

Bond
17x22*

492722183313Bond

603327224116Xerograph-
ic

754234285120Ledger

905041336124Mimeo

1055848397128Duplicator

1206755458132Writing

442520163012

492722183313Book

593327224016Offset

673730254518Text

744134275020

814537305522

894940336024

1045747387028

1186554448031
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14882675510039

17898816612047

1357562509136

14982685510040Cover

16290746011043

17697806511947

189105867012850

216120998014658

2431351119016465

27015012310018372

1256957468433

1478167549939Bristol

17697806511947

2191211008114858

32918215012222287

16390746011043

199110917413453Index

2531401159417167
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9
Setup Paper Trays

You can print and copy with many types of papers with the Xerox Nuvera :

• You can load many types of cover and tabbed stocks, giving you the ability to create
professional-quality documents.

• You can load trays with special stocks, such as envelopes, transparencies, and labels.
• The Xerox Nuvera gives you many publishing options for enhancing your document.

Before you run your print or copy jobs, you must load and configure the paper trays with
the recommended stocks.

To learn more about these capabilities, explore the links at the left.

Note
For information about loading tabbed stock in the Feed Module, see Using the Feed
Module Tab Guides.

Paper Tray Programming
When you load paper in a paper tray, you must program the tray for the paper it contains.

To avoid loading a paper stock unsupported by the machine, see Recommendations for
Paper Usage.

For details on paper handling and storage, see Handling and Storing Paper.

For details on loading special papers, see Loading Special Stock for Proper Finishing
Output.

Caution
Paper trays do not lock and can be opened while paper is being fed from the tray, resulting
in misfeeds and/or paper jams. Wait for the LED light on the tray to turn OFF before
opening the tray.
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Tray Confirmation Options

When you change or add paper to a feed tray, you need to program the tray for the
stock you added. To avoid "Resource Not Available" faults, you can set a confirmation
option to match your workflow. The confirmation box displays asking you to confirm or
change the paper setting for a tray.

To set a confirmation option
1. Select Setup from the Menu bar.
2. Select System Preferences and the Stocks and Tray tab.
3. Under Tray Confirmations, select the type of confirmation to display every time you

change or add paper:

• None - No Confirm box is displayed (Default).
• When Tray Settings Change - Confirm box displays only if you add a different

sized stock and do not change tray programming.
• After Every Tray Cycle - Confirm box displays every time a tray is opened and

closed.
• Auto Accept Settings Changes - If you have the Productivity Pack license enabled,

this setting is available for selection. No Confirm box is displayed as the system
automatically senses the new stock size. You may need to change other stock
attributes based upon the stock you added to the tray.

Tip
When programming a stock in a feed tray or the stock library, it is important to set the
correct stock properties, especially the weight listed as gsm. Based on the weight of the
stock (gsm) setting, the feed tray 'fluffers' settings are modified to feed the programmed
stock. Taking time to verify the gsm setting increases runtime and productivity by
decreasing feed module paper jams.

To program paper trays

You can either load the paper in the tray first and then program the paper tray settings
for the job (Load and Program method) or program the paper settings and then load
the paper in the tray (Program and Load method).

Tray programming procedures vary depending on how you configure confirmation alerts
and on the particular system configuration.

Note
It is only possible to program and load fully adjustable trays. Only System Administrators
can change Dedicated tray programming.

Program and Load Method
1. Use the previous steps to select the Tray Confirmation option to use.
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2. Click Paper Trays.
For more information, see Managing the Printer.

3. Double-click or right-click a fully adjustable tray row.
A Tray Properties window appears.

4. Enter all choices pertaining to the stock you wish to load into the tray. Systems with
the Productivity Pack license enabled have a stock library from which you can select
a stock to program the tray. Click OK or Apply.

5. When the Tray In Use light turns off, open the fully adjustable tray you just configured,
as identified in the Tray Type column of the Paper Trays window.

6. Fan and load the paper stock that matches the settings you made in the Tray
Properties window.

7. For Tray 2, refer to the section below on using the Rear Stop Guide.
8. Push the tray closed. The system automatically confirms the size and attributes

programmed.

• For fully-adjustable trays, a "Confirm Tray Contents" alert window may appear.
Either Confirm the tray contents, or click Change to enter the correct stock
size/type.

• For dedicated trays, a "Dedicated Tray Contents" alert will appear.

9. Either make appropriate changes in the Tray Properties window (Fully Adjustable
trays) or re-load the correct paper (Dedicated trays).

Note
When entering the size of Catalog Envelopes, enter the dimension of the envelope with
the flap open. See Recommendations for Paper Usage for more information, as well as
a listing of all paper types the system will work with.

Note
Trays are identified as "Fully Adjustable" and "Dedicated" in the Tray Type column of
the Paper Trays window.

Load and Program Method
1. Open the fully adjustable tray.
2. Fan and load the paper stock.
3. For Tray 2, refer to the section below on using the Rear Stop Guide.
4. Push the tray closed. The system automatically senses the size. Depending on the

Tray Confirmation option selected, an alert window may display.

• For fully-adjustable trays, a "Confirm Tray Contents" alert window may appear.
Either Confirm the tray contents, or click Change to enter the correct stock
size/type.

• For dedicated trays, a "Dedicated Tray Contents" alert will appear.
• A Confirm Feeder Tray 1 message informs you of the last known paper loaded in

the tray.

5. The Tray Properties window displays.
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6. Either make appropriate changes in the Tray Properties window (Fully Adjustable
trays) or re-load the correct paper (Dedicated trays).

7. Click OK. New stock will be available from the Stock Library.

Rear Guide Stop for Tray 2 on the 4-Tray Feed Module

The Tray 2 Rear Guide Stop is designed for systems that dedicate tray 2 on the 4-Tray
Feed Module for 8.5 x 11" or A4 stock. It is designed to stabilize the rear guide in the
tray improving registration. The stop is installed in the back of the tray to restrict the
rear guide from opening. The stop is set for 8.5 x 11" stock and is in the disabled position
when the machine is shipped. The user can Enable the stop by rotating the gray colored
lever to the right or Disable the stop by lifting and rotating the lever to the left.

DisabledEnabledLocated in back of tray

Note
If A4 stock is to be loaded in tray 2, service must be called to adjust the guide level.

To enable a tray
1. Right-click one of the trays in the Paper Trays window.
2. Click Enable Tray from the Tray pull-down menu.

To disable a tray
If a tray is broken, in need of service, or you do not want it used for some reason, you
can disable it.
1. Right-click one of the trays in the Paper Trays window.
2. Click Disable Tray from the Tray pull-down menu.

About Auto Tray Switching and setting tray priorities

The Xerox Nuvera is designed to allow a job to be submitted using only job attributes,
and the system will then, based upon tray priorities, pull stock from the tray(s) containing
the programmed stock.
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You have the ability to control the order in which trays are used by the system, by setting
each tray's priorities. For example, if trays 1 and 2 contain the same type of paper, but
you are running a big job, you can set tray 2 to be chosen first, since it has a larger paper
capacity. In this case, the job pulls stock from tray 2 first. When tray 2 is out of stock,
the job switches to pull from tray 1. Once tray 2 is refilled, the job switches back to pulling
stock from tray 2.

Feed Until Empty

A user selected workflow, Feed Until Empty, tells the system to empty the second tray
before switching back to the original tray. In the above example, once tray 2 is empty,
the job switches to pulling stock from tray 1 and remains pulling stock from that tray
until it is empty. Once tray 1 is empty, the job immediately switches back to tray 2, if it
has be refilled.

To select Feed Until Empty

• Select System  > User Diagnostics > Feed System Optimization Customer Setup >
Feed Until Empty Algorithm to enable Feed Until Empty.

Note
To find out at a glance the priority setting of each paper tray,scroll to the right side of
the Paper Trays table. The Priority column shows the current setting for each tray.

To set tray priority
1. On the Home Screen, click Paper Trays and double-click the paper tray you want to

set.
2. On the Tray Properties window, click the Options button.
3. In the Tray Priority text box, type a lower number (the lower the number, the higher

the tray priority).
4. Repeat Steps 2-4 to check that the other trays are assigned priority numbers which

will cause the system to use them in the order you want.
5. When satisfied with the priority settings on each Tray Properties window, click OK.

Note
It is possible to configure your Xerox Nuvera with two or more Sheet Feed Modules
(SFM), effectively doubling the feed capacity of the system. Notify your Xerox sales
representative if you wish to configure your system in this way. See Sheet Feed Modules
(SFM) for more details.

Note
If your Xerox Nuvera is configured with two or more Sheet Feed Modules, pay special
attention to how the trays are displayed in the user interface. For example, tray 2 in the
first SFM will appear as "Feeder 1: Tray 2". Tray 1 in the second SFM will appear as
"Feeder 2: Tray 1."
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Avoiding Multi-Sheet Feeds When Using
Special Stocks
There may be times when the paper loaded in the paper trays do not feed correctly. The
Xerox Nuvera will notify you of the problem with a message on the user interface screen.

Certain stock types such as:

• paper backed transparencies
• envelopes
• some label types

If not properly loaded and programmed in the system, will be detected as multi-sheet
feeds.

The solution to avoiding multi-sheet feeds and/or jams is to make sure the actual contents
of a given tray match the settings you program using the user interface.

For more information, see Clearing Paper Jams.

Loading Paper
Load paper as indicated by the labels on each paper tray. If you are using the 2-Tray
Feed Module, load paper as indicated for trays 3 and 4 of the 4-Tray Feed Module.

Note
If printing on coated stock but only one side is coated, load the coated side up.

Systems with the Multifunction Finisher DO NOT support coated stock.

Note
Stocks greater than 250 gsm are not recommended for use with the Xerox Nuvera . For
details on using the correct stocks, see Supported Paper.

Note
Loading papers of varying types and weights may warrant adjustment of the Sheet
Enhancement Module. For details, see Managing Paper Curl.

Note
It may be possible to configure your Xerox Nuvera with two or more SFMs, effectively
doubling the feed capacity of the system. See your Xerox sales representative if you
wish to configure your system in this way.
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Fan the paper first
To aid in sheet separation and to prevent jams, always fan the reams of paper before
loading into the trays. To do so:
1. Place the new stack of paper on a flat surface.
2. Place the palm of your hand on the center of the stack to hold it firmly.
3. Place the other hand at one corner of the stack and fan through the paper.
4. Repeat this procedure for each corner.
5. Discard the top and bottom sheets of paper from the ream.

To load paper
For details on paper handling and storage, see Handling and Storing Paper.

Caution
Do not overload paper trays. Do not block or damage the stack height sensor.

1. Open the tray.
2. Move the paper guides apart.
3. If changing to a different sized stock, remove any unused stock from the tray.
4. Fan the paper ream before loading it into the tray and make sure the paper is in good

condition.
5. Place a ream of paper in the center of the tray between the guides, making sure the

feed direction is correct.
6. Move the paper guides inward until they touch the paper stack. Make sure the side

and trail edge guides are snug against the stack after loading the first ream.
7. Add more paper to the tray, up to the MAX line.
8. Make sure the height sensor is not pinned down by the paper stack. The stack height

sensor is located on the inside of the right paper guide. Remove any excess paper.
9. For Tray 2 of the 4-Tray SFM a Rear Guide Stop is installed and configured for either

8.5 x 11" or A4 stock. It is designed to stabilize the rear guide in the tray and improve
registration. When loading this tray with these stocks, enable the Rear Guide Stop
by lifting and rotating the lever to the right. Disable this guide for all other paper
sizes used in this tray by lifting and rotating the lever to the left.

Note
The stop guide is set to either 8.5 x 11 " or A4 paper size. If you need to change from
one of these sizes to the other, you must contact Service.

10. For tray 3 or 4, adjust the green baffle at the back of the tray to prevent the paper
stack (11 x 17 inch and larger) from skewing when closing the tray. Properly adjusted,
it should make light contact (or be within a few millimeters) with the loaded paper
stack. The trays in the 2-Tray Feed Module do not have the green baffles.

11. Close the tray.
12. Set the tray programming on the control screen to match the paper you just loaded

if you have not already done so.
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Loading Special Paper Types

Certain paper types (such as tabs, drilled stock, transparencies, etc...) require that they
be loaded in a certain way in order to achieve the correct output.

Additionally, the types of finishing devices you may have installed impacts the way in
which some stock types must be loaded to achieve correct output. For more information,
see Loading Special Stock For Proper Finishing Output.

For general guidelines for proper paper usage, see Recommendations for Paper Usage.

Definition of Leading Edge

Leading edge is the left side of the paper as you look down on it in the tray. Leading
edge means that this is the edge of the paper that first enters the print engine.

Definition of Trailing Edge

Trailing edge is the edge opposite the leading edge. It is on the right side and is the last
edge of the paper to go into the print engine. When the leading edge is the short edge
of the paper, the paper is loaded SEF (short edge feed). When the leading edge is the
long edge of the paper, the paper is loaded LEF (long edge feed).

Loading Special Stock for Proper Finishing Output

Depending on the finishing devices that are present on your system, special paper stock
must be loaded in certain ways to achieve correct output. To ensure correct output and
to avoid manual collation, load as indicated by the labels on each paper tray and follow
the guidelines below.

If you are using a 2-Tray Sheet Feed Module, follow the guidelines for loading stocks in
trays 3 and 4.

Note
For information about loading tabbed stock in the Sheet Feed Module, see Using the
Feed Module Tab Guides. You need to have the Tabs Guide installed in the feed tray
that contains the tabbed stock.

Note
As an aid to you, there are illustration decals on each paper tray which will help you to
load stock correctly.

Note
For best results and most efficient operation, load special stocks LEF in the paper trays.
Loading special stocks SEF may result in pages delivered with incorrect rotation and
face-up or face-down delivery. Special programming may be required to correct.
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Systems with SFM and/or Insertion Module and BFM

LoadingStock Type

Holes leadingTrays 1 and 2Drilled paper

Holes leadingTrays 3 and 4

Label side upTrays 1 and 2Labels

Label side upTrays 3 and 4

Tabs trailing - face upTrays 1 and 2Tabs (forward collated tabs
only)

Tabs trailing - face upTrays 3 and 4

Face up, left edge leadingTrays 1 and 2Preprinted stock

Face up, left edge leadingTrays 3 and 4

Tape edge leadingTrays 1 and 2Transparencies

Tape edge leadingTrays 3 and 4

Face up, 1-N orderTrays 1 and 2Ordered stock

Face up, 1-N orderTrays 3 and 4

Systems with MFF ONLY

LoadingStock Type

Holes trailingTrays 1 and 2Drilled paper**

Holes trailingTrays 3 and 4

Label side upTrays 1 and 2Labels

Label side upTrays 3 and 4

Tabs trailing - face upTrays 1 and 2Tabs** (reverse collated tabs
only)

Tabs trailing - face upTrays 3 and 4

Face up, right edge leadingTrays 1 and 2Preprinted stock

Face up, right edge leadingTrays 3 and 4

Tape edge trailingTrays 1 and 2Transparencies

Tape edge trailingTrays 3 and 4

Face up, right edge leading, 1-
N order

Trays 1 and 2Ordered stock

Face up, right edge leading, 1-
N order

Trays 3 and 4
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Special Case: Jobs with drilled paper AND drilled tabs when using the
MFF

When processing jobs which use drilled paper and drilled tabs together, load the tabbed
stock with tabs trailing as usual, but load the drilled paper stock with the holes leading.
This is contrary to what the label on the tray depicts, but drilled stock must be loaded
this way in order to achieve correct output. If the job includes drilled tabs or drilled paper,
but not within the same job, follow the diagram on the tray label and/or the information
in the table above.

Systems with SFM Insertion Module and MFF Professional
Note
No tabs can be loaded into an SFM Insertion Module (if present) if using a Multifunction
Finisher.

LoadingStock Type

Holes trailingTrays 1 and 2Drilled paper

Holes trailingTrays 3 and 4

Label side upTrays 1 and 2Labels

Label side upTrays 3 and 4

Tabs trailing (loaded into pre-
fuser FM only)

Trays 1 and 2Tabs

Tabs trailing (loaded into pre-
fuser FM only)

Trays 3 and 4

Face up, right edge leadingTrays 1 and 2Preprinted stock

Face up, right edge leadingTrays 3 and 4

Tape edge trailingTrays 1 and 2Transparencies

Tape edge trailingTrays 3 and 4

Face up, right edge leading, 1-
N order

Trays 1 and 2Ordered stock

Face up, right edge leading, 1-
N order

Trays 3 and 4

Systems with MFF Pro Plus ONLY

LoadingStock Type

Holes trailingTrays 1 and 2Drilled paper**

Holes trailingTrays 3 and 4

Holes trailingInsertion Tray
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Label side upTrays 1 and 2Labels

Label side upTrays 3 and 4

Label side upInsertion Tray

Tabs trailing - face upTrays 1 and 2Trays 1,2,3,4: reverse collated
tabs only **
Insertion Tray: forward col-
lated tabs only

Tabs trailing - face upTrays 3 and 4

Tabs leading - face upInsertion Tray

Face up, right edge leadingTrays 1 and 2Preprinted stock

Face up, right edge leadingTrays 3 and 4

Face up, right edge leadingInsertion Tray

Tape edge trailingTrays 1 and 2Transparencies

Tape edge trailingTrays 3 and 4

Face up, right edge leading, 1-
N order

Trays 1 and 2Ordered stock

Face up, right edge leading, 1-
N order

Trays 3 and 4

Face up, right edge leading, 1-
N order

Insertion Tray

More information about tabbed stocks

For more information, see Printing/Copying on Tabbed and Ordered Stock.

Handling and Storing Paper
Follow these recommendations to get the best performance and reduce system downtime.

To store and handle paper

Damaged, curled, or damp paper can cause jams and image quality problems. Follow
these guidelines to store paper:

• Store paper in dry conditions, away from extreme heat or cold, such as radiators or
open windows.

• Lay unused paper on a shelf or pallet above the floor level.
• If possible, leave the paper wrapped and boxed until you are ready to use it; otherwise,

re-wrap partly used packages of paper.
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Note
Paper stored in extremely humid conditions (i.e., left in a machine over an extended
period of time) may have to be replaced with fresh stock in order to ensure optimal
feeding and image quality.

Before you load paper

Before loading paper, unwrap the paper from the moisture resistant wrapping, discard
the wrapper and insert the paper in the tray (see figure below for proper loading
orientation). Fanning the paper edges is not required, but may be beneficial when using
certain stocks in dry environments.

Tip
If you are loading any type of drilled paper, to aid in sheet separation and to prevent
jams, it may be helpful to fan reams before loading them into the tray.

Load the paper in paper trays 1 - 4 "seam side" of the ream up. "Seam side" refers to the
side of the unwrapped ream containing the seam.

For more information about proper handling of Xerox supplies, see Xerox Supplies Library.

Using Special Paper Stocks
The Xerox Nuvera is capable of printing on much more than normal white paper.

The figures below provide a few examples of the special stocks you can use with the
system.

Once you have these types of papers properly loaded and programmed in the paper
trays, you can add them to your documents.

Special paper stocks can be used on this sytem. Some of the special stocks include:

• Carbonless papers can only be used on simplex priniting systems. When using
carbonless papers, additional cleaning time will be required.

• DocuCards can only be loaded 100 at a time in a tray. Run this paper stock until it is
almost empty, but not completely empty. This stock requires frequent reloading.

• Reinforced stocks such as Mylar tabs can be used 90 at a time.

• Transparencies is not available on the MX systems. The tray capacity when using
transparencies is up to 90 sheets at a time in a tray.

• Tabs can be used when following the proper tab guides.
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• Envelopes can be used and are limited to the total amount of 60 in a tray at one
time. Frequent reloading is required.

Paper Usage and Expected Paper Performance

For information on how each type of supported paper can be expected to perform with
the system, see Paper Performance Tables.

For information on proper usage of special papers, see Recommendations for Paper
Usage.

Figure 1. Label stock.

Figure 2. DocuCard stock.

Figure 3. Tabbed stock.

Figure 4. Transparency stock.
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10
Setting Up Complex Jobs

In addition to running basic jobs, you can also process more complex jobs such as:

• Converting single-sided (simplex) documents into 2-sided (duplex) documents
• Creating booklets
• Creating folded documents
• Printing on tabbed stock
• Running jobs with several types of paper stock
• Collate sets
• Adding pages to a document
• Using Background Forms

To learn about book printing productivity when setting up your job to print stock greater
than 9.0 inches wide up to 9.5 inches wide, refer to the Wide Stock Mode feature in the
Printer menu: Media Optimization window.

For special considerations around the 157/314 system configuration with a BFM, refer
to Basic Finishing Module (BFM/BFM Plus) Specifications

To learn more about the more complex tasks the Xerox Nuvera is capable of processing,
explore the links at the left.

Printing/Copying on Tabbed and Ordered
Stock
Because of the special procedures required to use tabs, take time to review this section
before attempting to use tabs with the Xerox Nuvera .
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Note
For information on loading tabbed stock in the Sheet Feed Module, see Using the Feed
Module Tab Guides. You must have the Tabs Guide installed in the feed tray that contains
the tabbed stock.

Note
Pre-cut tabs can only print 1-sided. Full-cut tabs can print on both sides, either simplex
or duplex.

For systems with a Multifunction Finisher (MFF)
• Use only reverse collated tabs.
• Load paper according to the labels on the feed trays (5, 4, 3, 2, 1 with 5 being on top)

with tabs on the trail edge.
• Program feed trays.
• Run job N-1, face-up.
• If printing on 8.5x11" tabs, set the properties for the tabs as single-sided Exception

Pages and set image shift to 1/2".
• If using preprinted tabs, add as Inserts.
• If the job uses hole-punched tabs and hole-punched body stock, make sure the both

stocks are loaded in the tray with the hole-punched edge leading.
• The system assumes tabs are right-edge portrait or bottom-edge landscape. If the

job is different you may need to select rotate 180 for the entire job.
• If using Build Job to program the tabs job, select Build Job Type > Contains Tab

Stock or Envelopes.
• Tabs cannot be loaded in the Insertion Module.

For systems with a DS3500/XPS or BFM type finishers
• Use only forward collated tabs.
• Load paper according to the labels on the feed trays ( 1, 2, 3, 4, 5 with 1 being on

top) with tabs on the trail edge.
• Program media for feed trays.
• Run job 1-N, face-down.
• If printing on 8.5x11" tabs, set the properties for the tabs as single-sided Exception

Pages and set image shift to 1/2".
• If using preprinted tabs, add as Inserts.
• If the job uses hole-punched tabs and hole-punched body stock, make sure the both

stocks are loaded in the tray with the hole-punched edge leading.
• The system assumes tabs are right-edge portrait or bottom-edge landscape. If the

job is different you may need to select rotate 180 for the entire job.
• If using Build Job to program the tabs job, select Build Job Type  > Contains Tab

Stock or Envelopes.
• Tabs can be loaded in the Insertion Module.
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For the Xerox Nuvera 200/288/314 Perfecting Production System
- Using Media Optimization mode for tabs

You can print jobs that contain a mix of sizes and media, including full-cut and pre-cut
tabbed stock. If you need to print a job containing 8.5 x 11 inch paper, for example,
containing 9 x 11 inch or A4 pre-cut tabs to be imaged, you must first enable the Pre-Cut
Tabs selection from the Media Optimization mode in the user interface. This provides
you with the best throughput and productivity rate when printing with tabbed stock.

Use Media Optimization mode to increase your job's productivity rate otherwise affected
by printing the tab portion of a duplex job, especially pre-cut tabs.

• If you are running a job that does not contain tabs, select Normal Mode from the
Media Optimization Switches for the best throughput rate.

• If you are printing on any size pre-cut tabbed stock, or printing on full-cut tabbed
stock greater than 8.5 inches (215.9 mm) in the process direction, select Pre-Cut Tabs
from the Media Optimization Switches window.

Caution
The maximum throughput rate when the Media Optimization Switch is set to Pre-Cut
Tabs is 200/240/261 ipm, regardless of whether the job contains tabbed stock. Therefore,
make sure the Media Optimization Switch is set to Normal Mode when printing jobs
without cut tabs or if the tabbed stock is smaller than 8.5 inches (215.9mm).

To enable Media Optimization mode when printing with tabs to be imaged:
1. Load paper according to the labels on the feed Trays (1, 2, 3, 4, 5 with 1 being on

top) with the tabs on the trail edge. If the job uses hole-punched tabs and
hole-punched body stock, make sure both stocks are loaded in the tray with the
hole-punched edge leading. Use only forward collated tabs.

2. Program media for the feed trays and run job 1-N, face-down.
3. The system assumes tabs are right-edge portrait or bottom-edge landscape. If the

job is different, you may need to select rotate 180 for the entire job.
4. From the FreeFlow Print Server user interface, select Printer  > Media Optimization.

The window containing Media Optimization Switches displays.
5. Select Pre-Cut Tabs and OK. You are now running in Pre-Cut Tab mode and the job

will print up to 240 ipm, regardless of whether or not the job contains tabs.
6. When you finish running jobs that include cut tabs, make sure you disable Pre-Cut

Tab mode by first selecting Printer > Media Optimization and then Normal from
the Media Optimization Switches dialog.

To set up and use ordered stock

Ordered stock is paper with multiple pieces, such as a carbonless form, multi-part colored
stocks, etc., which need to be kept in a certain sequence.
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Load tray with ordered stock
1. On the Home Screen, click the Paper Trays button.
2. Double-click or right-click a fully adjustable tray row.

A Tray Properties window appears.
3. Enter all choices pertaining to the stock you wish to load into the tray.
4. In the Type pull-down menu, choose Ordered Stock from the list of stock types.
5. Enter any descriptive name for the ordered stock (ex., "Carbonless" or "5-part Color")

in the Type text box (the cursor should have automatically placed itself there.). This
information will appear in the Type column of the Trays tab.

6. In the Sequence section, enter a number. This coincides with the number of parts in
your ordered stock.
For example, if want to load a 3 part carbonless paper stock, enter 3 in the Sequence
text box.

7. Open the fully adjustable tray you just configured, as identified in the Tray Type
column of the Paper Trays window.

8. Load ordered stock that matches the settings you made in the Tray Properties window.
For information on proper loading, see Recommendations for Paper Usage.

9. Click OK or Apply.

Submit job and choose ordered stock
With a tray properly loaded and configured with loaded stock, you are ready to submit
a job which uses ordered stock.
1. Initiate a print or copy job. For example, on a copy job, select Loaded Stock from

the Paper Stock menu on the Basic tab.
2. A list of loaded stock types appears. Choose the ordered stock you previously

configured and loaded.
3. Make any other programming choices.
4. When satisfied with your settings, click Copy or Print.

Note
When using tabbed or ordered stocks the system may instruct you to reorder the stock
in the tray to the first position if events such as a multifeed occur. Any time a tray
containing ordered stock is cycled, the system assumes that the stock in the tray has
been reset to the first position.

Use Media Optimization Mode to optimize job recovery on jobs with
Serialized Stocks

You can print jobs using serialized stocks, such as checks or statements, and disable auto
system job recovery. The system will require more active operator intervention to
manually insure proper job recovery following system shutdowns. A message will indicate
when this media optimization mode is enabled.
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If a system fault condition occurs and requires a dynamic purge of sheets, the machine
will shut down after the purge is completed. Similarly, if the system shuts down hard
with a fault condition, after clearing the jam the system will cycle up, purge the paper
path contents, and shut down again. After both of these two types of conditions, a status
message will display to instruct the operator about job recovery. Be sure to disable
Serialized Stock Mode when finished to restore full auto job recovery.

To enable Serialized Stocks mode:
1. From the FreeFlow Print Server user interface, select Printer > Media Optimization.

The window containing all selections displays. Serialized Stock is above the area
containing Media Optimization Switches.

2. Select Serialized Stock Mode and OK.
You are now running in Serialized Stock mode which will print your job as programmed
and will only prompt you for job recovery assistance following a system fault condition.

3. When you have completed running jobs that include serialized stock, make sure you
exit the Serialized Stock mode by selecting Printer > Media Optimization and clearing
Serialized Stock Mode from inside the window containing the selections.

For more information, see Using Media Optimization Mode on the Xerox Nuvera 200/288
EA/MX Perfecting Production System.

More on loading tabbed stock and other special papers

Load stock in the orientation indicated on the feed tray labels.

Programming Tabs with 2-sided Original for Tab Images
To program a tab job using 2-sided originals with images for the tabs, program as special
page exceptions on tab stock. Special page exception programming applies to the printed
output; exception pages do not affect scanned input. Programming a 1-sided exception
page for the tab image tells the system to print the page as 1-sided output, which
automatically forces the next image to be on the next side 1 in the output. To successfully
program the job:
1. Create a set of 1-sided originals to use in the SDDF using 2-sided to 1-sided output.

Remove the excess side 2 blanks from the stack, load them in the SDDF, and program
the job using 1-sided to 2-sided output. (This is how the job would be run on a 5090.)

2. Scan the 2-sided input with all of the Copy job and exception page programming.
However, instead of printing the job, save it.

3. Use the Editor feature to remove the excess blank pages prior to printing the job.

Supported Tab Media

The Xerox Nuvera 200/288 EA/MX Perfecting Production System supports the Xerox tab
media (9 x 11 inches) listed in the following tables. If you use tabs other than those
listed below, you may experience questionable results.
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Note
If you are printing a job with preprinted tabs, program the job using Exception
Pages/inserts. For more information on printing with preprinted tabs, refer to Adding
Pages to your Document with the SFM Insertion Module. For information on printing
with preprinted tabs on a Multifunction Finisher Pro Plus, refer to Multifunction Finisher
(MFF) Specifications.

Table 2. US Tab Stock – All 9 x 11 inches

Double ReverseSingle ReverseSingle StraightColorBankWeightType

3R54203R5422White390Xerox Tabs

3R5426White4

3R44053R44153R4417White5

3R53063R53083R5312Blue

3R53203R5322Gray

3R5316Ivory

3R57113R5713White8

3R5717White5110

3R121733R121753R12325White590Saver Tabs

3R55183R55203R5709Clear590Plastic Rein-
forced

3R5689Red

3R5693Blue

3R5650Rain-
bow

White590Ring-Tuff
Tabs

3R123633R12368White560Xpressions+
Tabs
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Table 3. FX Tab Stock – All 223 x 297 millimeters (A4 based)

Double reverseSingle ReverseSingle StraightColorBankWeightType

3R90871White3160Standard
Tabs

3R90872White4

3R909573R908733R91012White5

3R909473R908783R91025Rain-
bow

3R910003R91013White6

3R913913R93992Rain-
bow

3R93990Rain-
bow

8

3R93993Rain-
bow

9

3R909013R910013R91014White10

3R91023Gray

3R939883R91390Rain-
bow

3R910023R91015White12

3R93987Rain-
bow

3R97229White5160Laminated
Tabs

3R972333R97234Rain-
bow

3R97230White10

3R972310White5200Colotech Tabs

3R97232White10

Note
On Tab stock, intermittent marks from photoreceptor seams may be seen on the tabbed
area of the media.

For more information, see Loading Special Stock for Proper Finishing Output

Using the Feed Module Tab Guides
Use the Feed Module Tab Guides to improve the feeding of tab stock from any tray in
the Feed Module.
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Note
Do not use tab stock unless you install the appropriate Tab Guide in the paper tray where
the tab stock is loaded.

There are two Tab Guides:

• The A4/11" Tab Guide
• The A5/5.5" Tab Guide

Both of the Tab Guides are mounted on brackets or in a molded pocket located inside
the Feed Module Front Door.

Installing the Feed Module Tab Guides
1. Program your job as you normally would, including programming of Tabs stock as

either the main body of the job or as special pages or inserts.
2. Open the tray and remove the paper stock, if required. Move the paper guides to the

open position in order to accommodate the size of the tab stock.

3. Load the tabs into the tray. The label on the tray illustrates how to load the tab stock.
4. Adjust the paper tray guides. Ensure that the entire stack of tabs is positioned correctly

in the tray.
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5. Adjust any tabs that are misaligned.

6. Ensure that standard, uncoated tab stock is loaded a minimum inch (12.7 mm) below
the MAX line.

Approximately 100 laminated or coated tabs may be loaded at one time; this amount
is significantly less than standard, non-coated tabs. If a misfeed occurs while using
laminated or coated tabs, remove some of the tabs from the tray.

7. Open the Feed Module Front Door. Remove the appropriate Tab Guide (A4/11 or
A5/5.5) from the Feed Module bracket or the molded pocket on the front door.
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8. Install the appropriate Tab Guide (A4/11 or A5/5.5). Align the Tab Guide with the
Paper Tray Guide.

9. Ensure that the Tab Guide is positioned underneath the actuator arm of the Paper
Tray Guide.

Removing the Feed Module Tab Guides
1. Lift the Tab Guide until it touches the bottom side of the actuator arm.
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2. Rotate the Tab Guide toward the tab stock to disengage the guide from the actuator
arm.

3. Push the Tab Guide forward until the actuator arm is clear of the Tab Guide.

4. Remove the Tab Guide.
5. Place the Tab Guide into the bracket or molded pocket on the front door. Ensure that

the Tab Guide is positioned behind the hook.
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6. Close the front door.

More on printing with tabbed stock and other special papers

For more information, see Loading Special Stock for Proper Finishing Output.

Using Media Optimization Mode on the
Xerox Nuvera 200/288/314 EA/MX
Perfecting Production System
You can use the Media Optimization Mode for maximizing productivity in the following
job situations:

• Pre-cut tabs
• Small stock mixed with mostly large stock
• Wide Stocks measuring 9 - 9.5 process direction
• Optimization of job recovery for jobs containing Serialized Stocks

Optimizing productivity for jobs containing Pre-cut Tabs

You can print jobs that contain a mix of sizes and media, including full-cut and pre-cut
tabbed stock. If you need to print a job containing 8.5 x 11 inch paper, for example,
containing 9 x 11 inch or A4 pre-cut tabs to be imaged, you must first enable the Pre-Cut
Tabs selection from the Media Optimization mode in the user interface. This provides
you with the best throughput and productivity rate when printing with tabbed stock.

Use Media Optimization mode to increase your job's productivity rate otherwise affected
by printing the tab portion of a duplex job, especially pre-cut tabs.

• If you are running a job that does not contain tabs, select Normal Mode from the
Media Optimization Switches for the best throughput rate.

• If you are printing on any size pre-cut tabbed stock or printing on full-cut tabbed
stock greater than 8.5 inches (215.9 mm) in the process direction, select Pre-Cut Tabs
from the Media Optimization Switches window.

Caution
The maximum throughput rate when Media Optimization Switch is set to Pre-Cut Tabs
is 200/240/261 for 200/288/314 speed systems respectively ipm, regardless of whether
the job contains tabbed stock. Therefore, make sure the Media Optimization Switch is
set to Normal Mode when printing jobs without cut tabs or if the tabbed stock is smaller
than 8.5 inches (215.9mm).
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To enable Media Optimization mode when printing with tabs to be imaged:
1. Load paper according to the labels on the feed Trays (1, 2, 3, 4, 5 with 1 being on

top) with the tabs on the trail edge. If the job uses hole-punched tabs and
hole-punched body stock, make sure both stocks are loaded in the tray with the
hole-punched edge leading. Use only forward-collated tabs.

2. Program the media for the feed trays and run job N-1, face-down.
3. The system assumes tabs are right-edge portrait or bottom-edge landscape. If the

job is different, you may need to select rotate 180 for the entire job.
4. From the FreeFlow Print Server user interface, select Printer  > Media Optimization.

The window containing Media Optimization Switches displays.
5. Select Pre-Cut Tabs and OK.

You are now running in Pre-Cut Tab mode and the job will print up to 240 ipm,
regardless of whether or not the job contains tabs.

6. When you finish running jobs that include cut tabs, make sure you disable Pre-Cut
Tab mode by first selecting Printer  > Media Optimization and then Normal from
the Media Optimization Switches dialog.

Optimizing productivity for jobs containing predominantly large
stock mixed with small stock

You can print jobs that contain a mix of sizes and media, such as ledger size with letter
size. When jobs contain mostly larger stock (> 50%) along with a smaller percentage of
smaller stock, you should select Large Stock. In general, progressively larger stocks result
in a slower overall print rate. However, when smaller stocks are re-encountered during
a job, the time it takes the printer to re-adjust to the higher print speed of the smaller
stocks can be a detriment to the overall print speed of the job containing mostly larger
stocks.

When running Media Optimization for Large Stock, the printer will not re-adjust the print
rate when encountering the smaller stock but will instead maintain the print rate of the
largest stock encountered even when printing on smaller stocks. However, the printer
will re-adjust the print rate for even larger stocks as they are encountered during a job
and then maintain that print rate for all stocks. The effect will be to achieve an overall
print rate for the job that is consistent with the maximum print rate for the largest stock.
The effect of Large Stock mode will continue until the jobs are complete and the printer
goes into standby. Unless Large Stock mode is cleared on the FreeFlow Print Server user
interface, all subsequent jobs will run in this manner.

Note
The throughput rate when Media Optimization Switches is set to Large Stock will be
consistent with the rate of the largest stocks encountered. Therefore, for jobs containing
a low percentage of larger stocks make sure Media Optimization Switches is set to
Normal. This allows the printer to re-adjust to the higher print speed of smaller stock.

To enable Large Stock mode:
1. From the FreeFlow Print Server user interface, select Printer > Media Optimization.

The window containing Media Optimization Switches displays.
2. Select Large Stock and OK.
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You are now running in Large Stock mode and the job will adjust print speed when
encountering larger stocks but not re-adjust for smaller stocks.

3. When you finish running jobs that include predominantly large stocks, make sure you
clear Large Stock mode by selecting Printer > Media Optimization and then selecting
Normal from the Media Optimization Switches dialog.

Optimizing productivity for jobs containing wide stocks measuring
9 - 9.5 process direction
Note
This feature is not available on printing systems that use the Basic Finishing Module
(BFM) or MFF finisher.

Select the Wide Stock feature (Wide Stocks Optimize Print Speed) to enable stock sizes
up to 9.5 inches (241 mm) wide to run at a higher throughput rate. Wide stock sizes of
9.1 inch (230mm) to 9.5 inch (241mm) will print at the same speed as 9.0 inch paper.

When trying to select this mode for systems with the BFM, a fault status is raised which
prevents the printer from running. The Wide Stocks selection must be cleared to lower
this fault. With the BFM, the maximum rate is 192 ipm for these stock sizes.

To enable Wide Stocks mode:
1. From the FreeFlow Print Server user interface, select Printer  > Media Optimization.

The window containing all selections displays. Wide Stocks is above the area
containing Media Optimization Switches.

2. Select Wide Stocks (9.0 - 9.5 process direction) Optimize Print Speed and OK.
You are now running in Wide Stocks mode which allows the printer to run these stock
sizes at the same print rate as 9.0 inch stock.

There is no need to clear the Wide Stocks selection unless problems are encountered
running these stock sizes. The Wide Stocks mode can be left on permanently.

Optimizing job recovery for jobs containing Serialized Stocks

You can print jobs using serialized stocks, such as checks or statements, and disable auto
system job recovery. The system will require more active operator intervention to
manually insure proper job recovery following system shutdowns. A message will indicate
when this media optimization mode is enabled.

If a system fault condition occurs and requires a dynamic purge of sheets, the machine
will shut down after the purge is completed. Similarly, if the system shuts down hard
with a fault condition, after clearing the jam the system will cycle up, purge the paper
path contents, and shut down again. After both of these two types of conditions, a status
message will display to instruct the operator about job recovery. Be sure to disable
Serialized Stock Mode when finished to restore full auto job recovery.

To enable Serialized Stocks mode:
1. From the FreeFlow Print Server user interface, select Printer > Media Optimization.

Xerox® Nuvera®10-14
User Guide and Training Aid (UGTA)

Setting Up Complex Jobs



The window containing all selections displays. Serialized Stock is above the area
containing Media Optimization Switches.

2. Select Serialized Stock Mode and OK.
You are now running in Serialized Stock mode which will print your job as programmed
and will only prompt you for job recovery assistance following a system fault condition.

3. When you have completed running jobs that include serialized stock, make sure you
exit the Serialized Stock mode by selecting Printer > Media Optimization and clearing
Serialized Stock Mode from inside the window containing the selections.

About Impositions
Imposition is the process of positioning multiple page images on a single output sheet
to be printed at one time. Imposition has no effect on the content of any individual
page image; it only affects the size of the page image and where the pages are placed
on an output sheet.

Imposition options include the ability to create 2-up to multiple-ups documents including
custom multiple-up For a custom multiple-up, the Xerox Nuvera automatically calculates
how many images will fit on the sheet size selected for the job. Imposition settings are
provided for setting gutter margins and Repeated, Sequential, and Alternating image
on sheet outputs.

A Signature is the name given to a single sheet of paper or other substrate after it has
been folded. Many books are made up of signatures. The manner in which signatures
are bound influences the way that they must be printed.

For more information about setting up impositions, see Setting Imposition Options.

Impositions and Saddle Stitched Books

Saddle stitched books and calendars consist of all the signatures nested in one group
with staples inserted at the fold. When signatures are nested, the fold, or gutter, gets
wider the further a sheet is from the centerfold (see Figure 1).

Note
Page frame shifting is done automatically.

Therefore, page frames must be shifted slightly to compensate for the thickness of the
gutter. The page frames are moved slightly away from the fold and toward the outside
edge. This results in the outside margin becoming narrower. When finished, the sheets
closer to the centerfold (with the narrower fold) will have more trimmed from the outside
margin. When done properly, the images will appear in the same position on each page
as the pages are flipped.
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Figure 5. (left) Nested signatures forming a saddle stitched book. (right) Stacked signatures forming
a perfect-bound book.

Figure 6. Page order for a simple 4-page book.

Input pages are on the left. Output signature sheet is on the right. Numbers in
parentheses represent page numbers on back side of the signature sheet.

Figure 7. Page order for a calendar signature.

Input pages are on the left. Output signature sheet is on the right. Numbers in
parentheses represent page numbers on back side of the signature sheet.

Figure 8. (Top) Example of a signature layout for a perfect bound book. (Bottom) Example of a signature
layout for a saddle stitched book.

Tip
To become familiar with both print and copy impositions, refer to the Xerox Nuvera
online help.

Impositions and Perfect Bound Books

A perfect bound book consists of signatures gathered next to each other, not nested, so
that they can be attached together at the bind edge with glue. The groups are in multiples
of 4 pages (1 printed output sheet with 2 images on the front and 2 on the back).
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The page images are automatically centered within the page frame. The user may
request an Image Shift. This will shift the entire page frame on the output sheet. Margins
may also be specified; these will reduce the size of a page frame. The system must then
reduce the image to fit within the smaller page frame. If Image Shifts are combined
with Margins, the image cannot move outside the margin. Therefore, any part of the
image that goes outside of the margin will be cropped.

Figures
Figure 9. (left) Nested signatures forming a saddle stitched book. (right) Stacked signatures forming
a perfect-bound book.

Figure 10. Page order for a simple 4-page book.

Input pages are on the left. Output signature sheet is on the right. Numbers in
parentheses represent page numbers on back side of the signature sheet.

Figure 11. Page order for a calendar signature.

Input pages are on the left. Output signature sheet is on the right. Numbers in
parentheses represent page numbers on back side of the signature sheet.

Figure 12. (Top) Example of a signature layout for a perfect bound book. (Bottom) Example of a
signature layout for a saddle stitched book.

Tip
To become familiar with both print and copy impositions, refer to the Xerox Nuvera
online help.
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Setting Imposition Options

Impositions, or Printer Spreads are a way to arrange page data out of order, so that
when printed, it will be in the correct order when folded, bound or otherwise finished.

For more information, see About Impositions.

To set imposition options
1. Select the Job Manager button, then select your imposition print job and right-click

to select Properties. (Or, for systems with a scanner, place originals in the document
handler.)

2. In the Properties window, click the Output tab, then the Layout button.
3. Click the Layout Style pull-down menu. A list of imposition types appears.

• 1, 2, 4, 6, 8, 9, 16 up
• Custom multiple-up - automatically determines the number of images per sheet

based upon image size and sheet size
• Booklet
• Perfect Booklet

Other imposition settings include:

• Gutter margins
• Repeated, Sequential or Alternating image placement

Note
Depending on the type of job you are working on -- print or copy -- you may see
different imposition type choices.

4. When satisfied with your settings, click OK.
5. Make any other job programming choices and, depending on your system, click Copy,

Scan or Print.

Note
If you forward a job from one machine to another, the forwarded job will lose its
imposition attributes as well as Printer Darkness settings and annotation attributes.
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Related Hints and Tips

Hint/Tip DescriptionSubtopic

FreeFlow Print Server supports automatic cre-
ation of Signature Booklets and other multi-up
imposition formats. This can be done from any
Print job in the active or inactive job list or from
the Print from File pathway. This is supported
for jobs submitted from print drivers and from
print ready print submission tools such as
FreeFlow Print Manager and the WebUI. Sug-
gested workflow for creating such jobs is to do
one of the following:
1. Hold the job and reprogram it to per-

form the desired imposition.
2. Setup a queue with the default Layout

set to the desired imposition.
3. Submit the job directly to that queue

and the imposition will be applied to
the job.

Queue for imposition

The Imposition features in the print drivers of-
fer slightly different options and produce differ-
ent output than the Imposition features avail-
able in the Print from File pathway on the ma-
chine.

Imposition in print driver

Tip
To become familiar with both print and copy impositions, refer to the Xerox Nuvera
online help.

Adding Pages to a Document
You can add pages of several types to any original document. This allows you to create
professional quality document sets from otherwise disorganized and/or incomplete
originals.

Types of added pages can include:

• Covers: may be a heavier paper stock, put on the front and back of a multi-page
document. Covers can be blank, printed on side 1 or both sides.

• Exception pages: allows you to program special characteristics for specific pages or
a range of pages within a job (up to 1000 exception pages). For example, page 4 of
the document can be programmed to print on pink paper and on side 1 only. You
can also specify tabbed stock with the Exception Pages control. When printing on
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pre-cut tabs, you can only print on side 1. When printing on full cut tabs, you can
print on both sides.

• Inserts: An insert is a blank or pre-printed sheet of paper or other stock (such as a
tab) that is placed between the pages of the job. You can program up to 1000 inserts
for a job.

Paper trays must be loaded and programmed with the appropriate
stocks

The key to successful page insertion is having the paper trays correctly programmed
with machine-compatible stocks. See Paper Tray Programming for details.

Basic workflow to insert pages into a document

(The following example procedure applies to both copy and print jobs)

Here's an example of how to program a copy job that includes inserts, exception pages,
and covers. The steps to program a print job are very similar. The output will be a multi-
page, 8.5 x 11 inch document, with Exception Pages (one-sided output) on the 2nd and
3rd pages. In addition, there will be a one-page insert after the 3rd and 6th pages.
Finishing includes front and back covers with a staple in the top left corner.
1. If a copy job, place the original 2-sided (over 10 pages) document in the Document

Feeder.
2. Verify that the paper supply trays are properly loaded and programmed with the

appropriate paper stocks.
If they are not, and you need more information, see Paper Tray Programming.

3. From the Job Manager, set base job properties, such as 2-sided, paper stock, stapling,
etc.

4. Select the Special Pages tab.
5. Select the Exception Pages icon. Program From 2 to 3. Select stock size. Program

these pages for one-sided output. Select Add Exceptions.
6. Close Job Exception window.
7. Select the Inserts icon.
8. Program the first insert for After page 3, Insert 1 Pages. Program the paper type,

size, etc. Select Add Inserts.
9. Program the second insert for After page 6, Insert 1 Pages. Program the paper type,

size, etc. Select Add Insert.
10. Close Inserts window.
11. Select Front Cover icon.
12. Program the cover to be printed on the outside only. Select the cover stock from the

tray you loaded with cover stock. Select Add Cover.
13. Select Back Cover icon.
14. Select None from the pull-down menu. Select the cover stock from the tray you loaded.

Select Add Cover.
15. When satisfied with your settings, click Copy, Scan or Print.
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System Level (Administrative) Added Pages

The Xerox Nuvera can be configured to include Administrative information in each Job
output.

• Banner pages
• Error pages
• Job attribute report

For more information about these types of pages, see Adding System Level Pages.

Adding System Level Pages

The Xerox Nuvera can be configured to add "system level" or "administrative" pages:

• Banner pages
• Error pages
• Job Attributes report

These administrative pages not only provide a useful way to separate jobs in a Finisher
tray, but also provide information about each job processed by the system.

Enabling System Level Pages

You need to logon as a System Administrator to enable or disable the system level pages.

To enable or disable the system level pages:
1. Open a job or queue properties window.
2. Perform one of the following:

• Under the Settings tab select Administrative Pages. Then enable or disable each
of the pages.

• For Production System queues, right-click on a queue and select Administrative
Pages Control. Then enable or disable each of the pages.

Banner Pages

When enabled by your System Administrator, Banner Pages include the following
information:

• Job name
• Job sender
• Job recipient
• Banner Page message
• Date and Time of printing
• Number of copies
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• Product name and software level/version
• Account number
• Job ID
• Server/Queue name

Error Pages

When enabled by your System Administrator, Error Pages include the following
information:

• Job name
• Job sender
• Errors, Warnings
• Product name and software level/version
• Job ID

Job Attributes Report

The Job Attributes report is a summary of the job settings.

Printing an Image That Extends to the
Edge of the Page
Occasionally, you may need to print a document whose image extends beyond the edge
of the page. A document with a shaded background covering the entire page is a good
example. Printing this type of image is called a "bleed". The ability to print full bleed
(edge-to-edge) used to be only available through the use of offset printers. The Xerox
Nuvera platform is not a print to edge system due to potential image quality defects
on the edge of the page. The system default is set for a 3 mm border erase. Border erase
can be customized from 0 to 6 mm for each side; Inboard, Outboard, Trail and Lead
edge.

1. Select Printer and Switches.

2. On the right-side of the window, select the radio button next to Custom.

3. Change the measurements for each edge as desired.

4. Select Apply.

5. Select OK.
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Note
If you are using Edge-to-edge printing and your originals have dark or solid edges, you
may want to disable Electronic Hole Removal. If Electronic Hole Removal is enabled
while Edge-to-edge printing and your originals have dark or solid edges, there is a
possibility that your output will have unwanted markings along the dark or solid edge.
For more information on using Electronic Hole Removal, see Removing Drill Holes From
Output.

Edge-to-edge printing workflow starts at client desktop / driver,
and ends at the Xerox Nuvera

There are three elements that work together to enable edge to edge printing:

• Correct system Edge Improvement settings at the Xerox Nuvera .
• A document created with edge-to-edge marking.
• Correct Margins settings in the Client driver.

Note
See Printing a Job from your Networked PC for more details on client drivers.

Workflow to enable a "full-bleed" print job:
1. At the Xerox Nuvera , click Printer > Switches. Place a checkmark in the Edge

Treatment Off box.
The Edge Treatment must be off before sending the print job. Ask your System
Administrator to verify the system is configured in this way.

2. Create a document in a desktop application (Word, PhotoShop, Illustrator, etc.) that
includes marking/data all the way to the edge of the page area.

3. In the client desktop application, select File > Print.
The client driver window appears.

4. Click the Image Options tab. Click the Margins button.
Refer to the client driver's online help for details about setting selections.

5. When done with the settings, click OK to send the document to the Xerox Nuvera .
6. At the Xerox Nuvera , go to Job Manager.
7. Find the job you just submitted. Double-click it.

The Job Properties window appears.
8. When satisfied with your settings, click OK.

The document will be printed, and the marking extending to the edge of the output
page will be visible.
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Programming Multiple Stocks in a Single
Job
You can create new documents composed of different stocks, such as covers, tabs, normal
stock, etc.

To program a job to use multiple stocks
Note
Make sure the paper trays are configured with the correct stocks. If you attempt to
program a multi-stock job without the required stocks loaded, the system will generate
a series of system alerts prompting you to load required stocks, slowing your productivity.
See Paper Tray Programming.

1. Set the properties for a job on the Xerox Nuvera user interface. See Copying your
Document or Printing your Document for details.

2. Program papers trays with all stocks (cover stock, tabs, 8.5 x 11 white, 8.5 x 11 blue)
necessary to process the job.

3. Follow the procedure for Adding Pages to a Document.
4. In the user interface, click Print.

Adding Pages to your Document with the
SFM Insertion Module
The SFM Insertion Module is either a 2-Tray or 4-Tray Sheet Feed Module used as a
post-process inserter (pages do not go through the print engine). Use the SFM Insertion
Module to add covers, inserts, or slip sheets to your documents. The SFM Insertion Module
fits between the print engine (or, if applicable to your configuration, the Sheet
Enhancement Module) and the finishing device.

Note
To learn how to insert covers, preprinted tabs or colored paper into your job using the
Insertion Module on the Multifunction Finisher (MFF) Pro Plus, refer to Using the
Multifunction Finisher (MFF) Pro Plus.

The addition of the SFM Insertion Module does not affect production speeds since covers
and inserts are merged into the paper path after marking takes place, without requiring
a gap in the pitch. For more information, see a description of About Pitch.
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To Add Sheets with the SFM Insertion Module

Pick a stock that is loaded in the SFM Insertion Module, and program that on a blank
insert sheet or cover (through the Special Pages dialog).

The system should feed blank sheets from the SFM Insertion Module whenever possible.

Note
Page insertion with the SFM Insertion Module may not occur when there is a blank page
in the actual document. The system software does not detect blank pages embedded
in documents, and will not trigger page insertion.

Alternatively, both of the SFM Insertion Module feed bins can be loaded with the same
stock, allowing continuous uninterrupted production insertion of pre-printed stocks and
the addition of photographs and other sensitive documents that normally could be
damaged by heat from the fuser section of the printer.

Using Background Forms
A background form is a preprinted single page or multipage form or image you submit
to the FreeFlow Print Server from your client workstation on which the Nuvera print or
copy job is overlaid and can be used repeatedly in a regular sequence.

When to use a background form

If you are printing a database report, a mailing, or personalized copies and variable data
of single or multipage forms where a background image is required, this feature saves
processing time. The image or series of images are stored and RIPped at the printer.
When you submit the personalized information, you don't have to reprocess the images
for each copy of your document. You merge the specified background form with the
foreground job's variable data using job submission settings at the FreeFlow Print Server.

Note
Exception pages and cover pages that contain job data are merged and printed with
background forms. System generated pages including, banner pages, blank cover
pages/page inserts/exceptions pages and error pages, do not contain job data and are
not, therefore merged and printed with the background form.
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How to create a background form
You will create the background form in the following steps. Once created and saved on
a directory, CD or USB drive, you will create the variable data job that will be used and
merged with the background form. If the form file is not saved to a specified directory,
it will automatically be RIPped and saved to the system's default folder
(/opt/XRXnps/resources/bf).
1. Create or open the image or form in the appropriate software application on your

client workstation.
2. From the application's menu bar, select File to open a menu list.
3. From the menu list that displays, select Print.

The Print window displays.
4. Select the target printer to which the form job will be submitted.
5. Select the Properties button.

The Document Properties window displays.
6. From the Paper/Output tab, select Normal Print from the Job Type field and select

Create Background Form.
7. Select the Job Notes tab and type the name (up to 255 Roman characters) you want

for the background form file in the Job Name field.
This connects your variable data document to your background form without having
to go to your printer for the name assigned by the application and driver.

8. In the Document Properties window, click OK. You are returned to the Print window.
Click OK.

9. Select Saved Background Form to create a form on the Xerox system that will be
the preprinted form.

10. Make sure to also save the original background form document you created to an
archive outside of the printer system for future jobs should the printer system lose
the data.

Creating your variable data document
1. To create the variable data document, open the document's word processing or

database application to create and process the variable data (such as your mailing
list, serial numbers, etc.).

2. Place the pages of the background form as a background image to help you line up
the variable data fields you'll be printing.

3. Place your variable data fields where you want them and then delete the background
image.

Printing your variable data document with the background form

When you print a variable data job with the background form, the document and form
are merged and the resulting document appears as if it has been printed on top of a
preprinted form.
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Using your client application and workstation
To use your client application and workstation to program the final output document
settings and submit the job to the FreeFlow Print Server:
1. From the application toolbar, select the Merge to Printer icon.

The Merge Range window displays.
2. Select the range of records you want to print and click OK.

The Print Window displays.
3. Select your target printer and select the Properties button.

The Document Properties window displays.
4. Select the Layout/Watermark tab and under the Background Form heading select

the Setup button.
The Background Form Setup window displays.

5. Select the Use Background Form button.
6. In the Form Name field, type the name of the background form exactly as you entered

it when it was created.
7. Click OK to accept your background form link and close the setup window.
8. Click OK to accept the Xerox Job Ticket and close the properties window.
9. Click OK to submit your variable data job to the printer where it will be merged with

the background form and the resulting output document printed.

Using Copy to create the final output document
If you are using Copy to create the final output document, (the copying feature is not
available on the Xerox Nuvera 200/288 EA/MX Perfecting Production System):
1. Select Copy Manager.
2. Select the Advanced tab.
3. Enter a Job Name.
4. Under Destination select Save as Background Form.
5. Select a save location. The default directory for background forms is:

/opt/XRXnps/Resources/bf.

Using a background form from the FreeFlow Print Server
To print a job using a background form from the FreeFlow Print Server.
1. Select Job Manager and select a job in the Active or Inactive jobs list.
2. Double-click on the job to open the Job Properties window.
3. Select the Image Edit tab and select the Background Form button.
4. Select Use Background Form checkbox.
5. Select the background form you want to use from the Browse button.
6. To identify how the merged form will be applied to the job output, select from one

of the following Apply Form Pages:

• Throughout Job: the background form will be applied to the foreground form
until the foreground job printing is completed (cycles through job pages
repeatedly).
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• Once: the number of pages in the background form will be applied only once
(cycles through job pages once) to the foreground job. Any remaining pages in
the foreground job will be printed without the merged form.

• Once, Then Repeat: the specified number of pages in the background form will
be applied and then repeated until the foreground job printing is completed (cycles
through the job once and then cycles repeatedly only from the entered From Page
location onward).

7. Enter horizontal and vertical Displacement values.
Entered values shift the background form prior to merging with the document. Specify
the amount of shift (inches or mm) in the X or Y axis. A negative value shifts the
background form to the right or downward. A positive value shifts the form to the
left or upward. The alignment values are determined from the lower left hand corner
of the page, independent of the orientation of the page.

8. Click OK.

Note
An example is an image or form (single or multipage document) that will be merged in
the FreeFlow Print Server with such information as a name/address, specific personal
data, or serial number.

Note
If the background form image is larger than the output media, the system prints as
much of the image as can fit on the media.

Note
If the background form image resolution differs from the resolution of the job, the printer
scales the background form image data to match the resolution of the job prior to
merging.

Managing/Deleting background forms
It is recommended that you store background forms on networked storage devices and
not at the Nuvera printer. This allows for optimal processing time.
1. From the FreeFlow Print Server user interface, log on as System Administrator.
2. From the menu bar, select Administration  > Background Forms.

The Background Forms Manager displays.
3. Select the background form you want to delete, right-click, and select Delete. Click

OK to confirm.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

When using the Image Shift option with a job
that also uses a Background Form, both the
data portion and the background form will be
shifted by the Image Shift values.

Image Shift
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Hint/Tip DescriptionSubtopic

Background Forms can be saved to CD but a
Background Form cannot be used directly from
a CD. The background must be imported from
the CD into the Background Form Repository
using the Background Form Manager and then
it will be available for use.

Saving to and importing from CD

The only job programming settings that can be
applied to a background form are Imposition,
Annotation, and form programming. If you save
the form with other programming (such as im-
age shift and special pages), the Sample Back-
ground Form option will not produce output
that matches what you will see if you use the
form in an actual job.

Supported job programming

Do not mix copy background forms with print
variable data if the background form contains
imposition. Every other page will have the form
and the data 180 degrees off from each other.

Variable data

To learn more about the advanced tasks the Xerox Nuvera is capable of processing,
explore the links at the left.
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11
When to unload Stackers

Various stackers are available for use with the Xerox Nuvera. Depending upon the
situation, each of these devices may require that paper be unloaded from the stacking
tray. The table below shows each of these unload situations for the BFM, DS3500, and
the Xerox Production Stacker (XPS).

XPSDS3500BFMUnload situation

• First or single press
starts the unload
process (eject),
second press
pauses the
eject/raise/lower,
third press resumes
eject/raise/lower
lowering.

• After the unload is
complete the sys-
tem goes ready
(continue printing)

• First or single press
starts tray lower-
ing, second pres
stops lowering,
third press resumes
output tray lower-
ing, etc.Front door
must be
opened/closed to
raise tray & allow
system to go ready
(continue print-
ing)Sheets are not
required to be re-
moved to allow
system to go ready
(continue printing)
after door is
opened/closed.(Note:
Paper present
sensor is about 1/4"
in from the Lead
Edge.)

• Single press or mul-
tiple presses lowers
tray to unload posi-
tion. Tray lowers
only enough to en-
able BFM output
tray to slide out

Operator presses the
Unload button on the
finisher or selects Un-
load on the UI.
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XPSDS3500BFMUnload situation

• Opening is allowed.

• Sheets are not re-
quired to be re-
moved to allow
system to go ready
(continue printing)
after door is
opened/closed

• Opening is allowed.
• Sheets are not re-

quired to be re-
moved to allow
system to go ready
(continue printing)
after door is
opened/closed

• Can not open door
without pressing
unload button
(door is inter-
locked)

Operator opens the
front door while the
Xerox Nuvera is idle
and paper is present in
the stacker.

• Not applicable.

• Auto unload is sent.
Must unload (eject)
for system to go
ready (continue to
print).

• Must open/close
and remove all
sheets for system
to go ready

(continue to print)

• Auto unload is
sent.

• Must open/close
and remove all
sheets for system
to go ready (contin-
ue to print)

Job is interrupted due
to:

• Restart

• Sleep mode

• Printer off/on

• Power off/on

• If sheet clears last
sensor before flip-
ping wheel & flip-
ping wheel com-
pletes its profile
properly, system
does not consider
this a jamSome
transport jams
(Area 6) require
front door be
opened and they
do not require
sheets be removed
from internal stack-
er.

• Other transport
jams require sheet
clearance from top
cover and they do
not require sheets
be removed from
internal stacker.

• If sheet clears last
sensor before flip-
ping wheel & flip-
ping wheel com-
pletes its profile
properly, system
does not consider
this a jam

• Other transport
jams require sheet
clearance from top
cover and they do
not require sheets
be removed from
stacker.

• Some transport
jams (Area 5 & 6)
require front door
be opened and
they do not require
sheets be removed
from stacker.

• If set drop occurs
without a fault, the
system does not
consider this a
jamIf a 12-2505
set drop fault oc-
curs, an auto un-
load is sent. Must
open/close and re-
move all sheets for
system to go ready
(continue to
print)12-10xx
Transport jams to
compiler may re-
quire sheets to be
removed from
"complier tray"
through top cover,
but not "stacker
tray"

• 12-11xx bypass
jams to next mod-
ule may require
sheets to be re-
moved from "by-
pass transport"
through top cover,
but not "stacker
tray"

A paper jam occurs in-
side of the stacker.
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XPSDS3500BFMUnload situation

Stack unloading beha-
vior not effected.

Stack unloading beha-
vior not effected.

Stack unloading beha-
vior not effected.

A paper jam occurs
elsewhere in the Xerox
Nuvera configuration.

Auto unload is sent.
Must unload (eject) for
system to go ready
(continue to print).

Auto unload is sent.
Sheets are not re-
quired to be removed
to allow system to go
ready (continue print-
ing) after door is
opened/closed

Auto unload is sent.
Must open/close and
remove all sheets for
system to go ready
(continue to print)

Operator cancels,
holds, or deletes a job.

Low Power mode exit
does not force an un-
load.

Low Power mode exit
does not force an un-
load.

Auto unload is sent.
Must open/close and
remove all sheets for
system to go ready
(continue to print)

Xerox Nuvera exits low
power mode.

Auto unload is sent.
Must unload (eject) for
system to go ready
(continue to print).

Auto unload is sent.
Must open/close and
remove all sheets for
finisher to go ready
(continue to print)

Auto unload is sent.
Must open/close and
remove all sheets for
finisher to go ready
(continue to print)

The stacker fills to ca-
pacity or set paramet-
ers are met.

Does not send or cause
an unload

Does not send or cause
an unload

Does not send or cause
an unloadStapled set
remains in compiler,
unstapled set will drop.

The job is paused, the
Xerox Nuvera is out of
paper or a xerographic
adjustment is required.

Unload is sent / caused
if criteria is met for

• Limit

• Job

• Set/stack

• Partition (data
stream)

Must open/close and
remove all sheets for
finisher to go ready
(continue to print).

Unload is sent / caused
if criteria is met for

• Limit

• Job

• Set/stack

• Partition (data
stream)

Must open/close and
remove all sheets for
finisher to go ready
(continue to print).

Unload is sent / caused
if criteria is met for

• Limit

• Job

• Set/stack

• Partition (data
stream)

Must open/close and
remove all sheets for
finisher to go ready
(continue to print).

Job is complete.

Auto unload command
is sent to the device
when one of the follow-
ing criteria is met:
Auto unload is sent.
Must open/close and
remove all sheets for
system to go ready
(continue to print)

Does not send or cause
an unload

Auto unload command
is sent to the device
when one of the follow-
ing criteria is met:
Auto unload is sent.
Must open/close and
remove all sheets for
system to go ready
(continue to print)

When entering or exit-
ing diagnostics mode.
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12
How Do I...

Your Xerox Nuvera is a fast, high-volume, networked Production publishing and printing
system. It is comprised of multiple modules and configurations, and can accommodate
various finishing devices.

Depending on the Nuvera configuration available to you, you can become a one-person
publishing shop, creating booklets, scanning images and documents for Optical Character
Recognition (OCR), and storing documents on the system to be printed as needed.

Please take a few moments to learn what capabilities the Xerox Nuvera has to offer.

Contacting Xerox
Before contacting Xerox for a service problem, perform the following steps:

• For image quality problems, first attempt to resolve the problem using the image
quality troubleshooter.

• For worn out customer replaceable units, first attempt to replace the component
yourself.

Service Code / Serial Number Locations

If you have received a message directing you to call for service:

1. Write down the service code that appears in the user interface.
2. Write down the machine serial number. There are several serial numbers. Record

the one that corresponds with the area that needs service. Serial number locations
are:

• Paper Feeder Problems: The Serial Number is located behind the front access door
in the upper left corner, just below the Document Feeder. For details about this area
of the machine, see Feed Module.
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• General System Problems: The Serial Number is located behind the Image Output
Terminal (IOT) right front access door in the lower right corner. For details about this
area of the machine, see Print Engine Module.

• Finisher Problems: The Serial Number is located behind the Multifunction Finisher
(MFF) front access door in the lower right corner. For details about this area of the
machine, seeMultifunction Finisher (MFF) Module.

• The Serial Number is located behind the Basic Finishing Module front access door in
the center of the frame.

Xerox Remote Print Service Offerings

Xerox Remote Print Service Offerings provides an integrated approach to supporting
your machine. Through a secure, on-line connection with your machine we can better
understand your production needs and environment, which enables us to:

• Identify potential problems through on going data analysis
• Provide real-time recommendations to help optimize overall performance
• Use MeterAssistant to automatically generate accurate meter reads and submit them

to Xerox

To submit system data
1. At the Xerox Nuvera user interface, click System > Call for Assistance.

The Call for Assistance dialog window appears.
2. In the Call for Assistance dialog, click Options > Submit data. If your machine is not

network enabled, choose Save Data. This will prompt the system to direct the data
to the on-board CD drive, click Close.

Telephone numbers and World Wide Web address

Customer Technical Support Center: 1-800-821-2797

Supplies Hotline (United States): Xerox Parts: 1-800-828-5881

Xerox Supplies: 1-800-822-2200

Xerox CRUs: 1-800-822-2979

Supplies Hotline (Xerox Canada):

Xerox Canada Support Hotline : 1-800-939-3769

Xerox Canada Supplies: 1-800-668-0199

Internet: Xerox Parts Ordering

Contact your Xerox representative for Support and Supplies in all other countries.
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CRU/Maintenance/Consumables part names and numbers

Part NumberPart Name

6R1261 - North America
6R90357 - Europe

EA (Emulsion Aggregation) Dry Ink

93K14840Dry Ink Waste Bottle

93K08651Developer Waste Bottle

180K00171MFF 2/3 Hole Punch

180K00181MFF 2/4 Hole Punch

8R12912MFF Main Stapler Cartridge (100 sheet capacity)

8R12898MFF Main Stapler Cartridge Refill (100 sheet capacity)

8R12920MFF Main Stapler Cartridge (50 sheet capacity)

8R12919MFF Main Stapler Cartridge Refill (50 sheet capacity)

8R12897MFF Booklet Stapler Cartridge

8R13033BFM & BFM+ Stapler Cartridges (3 - 100 sheet staples)

8R13034BFM & BFM + Stapler Cartridges (3 - 30 sheet staples)

8R3669Xerox Glass, Lens and Mirror Cleaner

8R3669Xerox Lint-free Cleaning Cloths

Copying your Document
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

1. Place your document face up in the Document Feeder or face down on the Document
Glass.

2. Click the Copy Services button. Adjust the job settings under each tab.
3. Select the Start button.

The Xerox Nuvera also offers many powerful features for reproducing documents:

• Copying Document Sets with Mixed-Size Sheets
• Making a Booklet
• Adding Pages to a Document
• Using the Basic Finishing Module (BFM)
• Using the Multifunction Finisher (MFF)
• Using DFA Compliant Finishers through the DS3500/XPS
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• Reducing or Enlarging Images
• Adjusting Image Quality for various original types (photos, halftones, text)
• Build and Store jobs online for printing on demand (see Using Build Job and Saving

and Storing Jobs
• Printing an Image That Extends to the Edge of the Page (images that use the full

page)

Your Xerox Nuvera also functions as a network workgroup printer and a workgroup
scanner (see Printing a Job from your Networked PC and Scanning your Document.

Setting up a Copy Job

This topic explains how to copy documents. For more detailed information and specialized
procedures, explore the links in this topic and the column at the left.

Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

To set up a copy job
1. Place a document face up in the Document Feeder (place fragile or bound documents

face down on the Document Glass).
2. Click the Copy Services button.
3. Enter the desired quantity of copies.
4. Adjust the settings on the other tabs as necessary. For descriptions of the buttons

and their functions, refer to the online help at the machine.

• Edit the images
• Rotate the images
• Adjust image quality
• Setup slip sheets and special pages
• Create booklets
• Set finishing options

5. On the Basic tab, Choose paper to copy on. You have four options for paper selection:

• Auto Paper Select - the Nuvera system senses the size of the stock and make a
selection.

• Loaded Stock - you make a selection from the loaded stock list.

• Stock List - you make a selection from the stock list.

• Custom - you program a custom stock.

Note
Choosing paper is not done on a "by tray" basis. For trays 1 and 2, if the same paper
is loaded in both trays and tray 1 has a higher priority (a lower number), then it will
feed from the highest priority tray.
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Note
Additionally, if you loaded 8.5 x 11 inch paper in 2 trays (1 LEF and 1 SEF), you will
see one choice for this paper, and 2 orientations to choose from in the Loaded Paper
list.

6. Loading Paper with appropriate stock(s) and adjust tray programming (see Paper
Tray Programming) if necessary.

7. Click Start.

To Proof 1 Copy and Hold
1. Click the Copy Services button.
2. Select Job Type.
3. Select Proof 1 Copy and Hold. Once the proof copy is completed. A window displays

with three choices.

• Release to print job.
• Hold Job moves the job to the Job Manager inactive pane listed as successfully

Proofed.
• Cancel

For an overview of more sophisticated jobs and workflows, see Setting Up Complex Jobs.

For details about advanced features, see Advanced Publishing Features.

Copying 2-Sided Pages
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

The Xerox Nuvera makes it easy to copy 2-sided (duplex) originals, either from the
document glass or from the high-speed Document Feeder.

To copy 2-sided pages from the Document Feeder

The Xerox Nuvera is equipped with a high-speed Document Feeder. For details about
what kind of papers can be fed through the document feeder, see Document Feeder &
Scanner Specifications.

Tip
To save paper and job running time, whenever possible/practical, convert any multi-page
one-sided original documents into 2-sided output.

Basic copy workflow using "sides imaged" programming
1. Load originals face up into the Document Feeder.
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2. Decide what programming to apply to the original document(s).
For example: "I want to convert this 10 page single-sided document into a 2-sided
document set."

3. Click the Copy Services button.
4. On the Basic tab, select 1 to 2 Sided in the Sides Imaged field.
5. Make any other adjustments on the other tabbed fields.
6. Click Copy.

To copy 2-sided pages from the Document Glass (platen)

Some original document types will not feed properly through the Xerox Nuvera Document
Feeder. Examples of these document types are:

• Fragile, old, or torn documents
• Documents printed on heavy card stock
• Photographs

For these and any other document you feel should not be processed through the
document feeder, use the document glass.

Basic copy workflow using "sides imaged" programming
1. Place the 2-sided original document onto the Document Glass; aligning it in the upper

left-hand corner of the glass.
2. Click the Copy Services button.
3. On the Basic tab, select 2 to 2 Sided in the Sides Imaged field.
4. Make any other adjustments on the other tabbed fields. This could include stapling,

image quality adjustments, rotation, etc.
5. Click Copy.

The first side of the document will be copied and stored in the system's memory. In
the black system status area, the system prompts you Ready to Scan Side 2....

6. Raise the Document Glass cover and turn the document over for 2nd-side scanning.
Turn the document over and click Copy.

The system will begin processing and printing your copy job.

Adjusting Output Page Size

You can print your copy to a different sized paper stock. There are two ways to accomplish
this:

• Auto Paper Selection (APS)
• Manual stock size selection

1. With APS, you can program the job, load documents in the Document Feeder or on
the Document Glass, and the machine automatically selects the appropriate
paper/tray for the job. The system determines the original document size and uses
this in combination with other features such as Reduce / Enlarge and Rotation to
determine the output paper size and select the best matching paper tray to feed
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from. The system does all this without losing any part of the page image. It will
always choose a paper/tray that is white, buff or ivory in color; has a weight of
normal or medium (56 - 105 gsm); and has a type of either plain or recycled. If the
Reduce/Enlarge is equal to 100%, and the correct size paper or tray is not available
(either the paper tray is empty, raising, disabled or left open) a programming conflict
will appear stating that APS is selected and no tray is ready with the correct paper
stock. If the Reduce/Enlarge is not equal to 100%, it will choose a larger size
paper/tray if the correct size paper/tray is not available.

2. You can override the default APS feature by manually selecting an output stock
size. On the Home Screen, click the Paper Trays button, select a tray, and right-click
to enable one of the tray selections.

Note
The APS feature is active by default. APS applies to copy jobs only.

Note
See Supported Paper for details on paper sizes and types you can use with the Xerox
Nuvera.

Managing Copy Jobs: Editing Held Jobs
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

This feature provides the capability for the users to modify job programming from the
local UI after the job has been received by the system. This feature applies to copy, scan
and print jobs already in the queue (and in the case of copy jobs, programmed to be
held by the system. Not all job programming choices can be modified.

Sample workflow to edit a held Copy job
1. In the Xerox Nuvera user interface, click the Copy button.
2. Make sure Proof 1 Copy and Hold is selected for Job Type.
3. Make any job programming choices that are available. Click Start.

The job is processed and placed in the Current Jobs list.
4. Make note of the Job number in the dialog window that appears.
5. Click the Job Manager button.
6. Select the Current Jobs tab.
7. Scroll down through the Inactive Jobs list (if needed). Double-click the job, which is

identified by a job number (noted in step 3).
8. With the job window now launched, make any job programming changes.
9. When you are satisfied with your settings, click OK.

For more information on managing system jobs, see Managing Print Jobs.
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Note
If Retain PDL File is active, a completed copy job will be listed under the Job Manager >
Completed tab. This allows you to resubmit the job for printing, changing job properties
if needed.

Making a Stapled Copy Job
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Follow the guidelines below to generate a stapled copy using the Document Feeder.

For more information on the Document Feeder, see Using the Document Feeder.

To generate a stapled copy job
1. Orient your original documents according to the instructions shown on the Document

Feeder.
2. In the Xerox Nuvera user interface, select the appropriate paper/staple orientation

icon.
3. When satisfied with your settings, click Copy.

Related Topics

• Stapler Specifications
• Replacing Staples in the Finishers
• Clearing Stapler Jams

Using the Document Feeder
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

The Xerox Nuvera is equipped with a Document Feeder, allowing you to quickly scan
large document sets into the system for processing.

For more information on the capabilities of the Document Feeder, see Document Feeder
& Scanner Specifications.

To load the Document Feeder
Note
To ensure all image information from a 12 x 18 inch original is captured, use the
Document Glass.
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Note
Follow the steps below to avoid misfeeds and/or skewed output. The document feeder
side guides must be positioned correctly to avoid misaligned copies or scans.

1. Remove any staples, paper clips, etc. that may be binding the paper set.
2. Move the side guides outward as far as they will go.
3. Place the document set to be scanned or copied face up in the center of the document

feeder input tray. Make sure the document set is neatly stacked to avoid skewing.
For more information on paper loading (type and feed direction), see Document
Feeder & Scanner Specifications.

4. Move the side guides inward. Make sure the paper guides are touching both sides of
the paper stack. Failure to do so may result in sheets skewing and skewed images on
copies or scans.

5. Make any programming choices in the user interface.
6. Click Start.

If a jam occurs in the Document Feeder, see Clearing Paper Jams.

Using the Multifunction Finisher (MFF)
The Xerox Nuvera can include a Multifunction Finisher (MFF). There are two MFF models:
the Professional and the Pro Plus. Explore the links at the left to learn all of the ways to
utilize the MFF.

Using the MFF Professional allows you to finish your jobs with features such as:

• Staple
• Collate
• Letter Tri-Fold
• Booklet Fold

Using the MFF Pro Plus allows you to finish your jobs using the same features available
on the MFF Professional but also includes an insertion module that offers these additional
finishing features:

• An Insertion Tray for inserting preprinted tabs, covers and colored sheets into your
job

• A 2/3 or 2/4 Hole Punch capability

How to select the MFF finishing type as the output device
Perform the following steps to use the MFF and select the finishing output at the user
interface.
1. From the Copy Service, Print From File Service or Job Properties window of an inactive

job, select the Output tab.
2. Select the Stapling/Finishing FAB.
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3. From the Output Location, Output Order, and Output Delivery pull-down menus, make
sure System Specified is selected.
The system will automatically select the correct output destination tray and page
order for the job. System Specified is selected by default.

4. From the Stapling/Finishing pull-down menu, select the stapling option, folding option,
hole punching or multiple finishing option.

5. Select all other finishing attributes.
6. Click Apply or OK.

Related Hints and Tips

On systems with an MFF, tab jobs are delivered to the finisher face up in N to 1 order.
All sheets in tab jobs are inverted in the paper path prior to entering the finisher. As
such, the following must be noted:

• Tabs need to be loaded in the feeder tray in N to 1 order (commonly referred to as
reverse ordered tabs)

• If the job requires drilled paper, the drilled paper for the main body of the job must
be rotated in the tray so that the holes are on the leading edge of the paper (to the
left). This is the opposite of what the tray labels indicate.

• If pre-printed stock is included in a tab job, the pre-printed stock must be rotated
180 degrees in the feeder tray. This is the opposite of what the tray labels indicate.

Explore the links at the left to learn all of the ways to utilize the MFF.

For more information on the capabilities of the staplers, see Stapler Specifications.

For more information on the capabilities of the MFF Pro Plus Insertion Module, see
Multifunction Finisher (MFF) Specifications.

Using the Multifunction Finisher (MFF) Pro Plus

Using the MFF Pro Plus allows you to finish your jobs using the same features available
on the MFF Professional but also includes an insertion module that offers these additional
finishing features:

• An Insertion Tray for inserting preprinted tabs, covers and colored sheets into your
job

• A 2/3 or 2/4 Hole Punch capability

To Insert Preprinted Sheets on the MFF Pro Plus
To insert covers, preprinted tabs or colored paper into your job, follow these steps:
1. On the Home Screen, select Paper Trays.
2. Select the paper tray (for example, Tray 5 Insertion Tray or Finisher A, Tray 1) and

right-click on the tray.
3. Select Properties. To use a particular stock type for the tray or change other properties,

select those attributes to match what will be loaded in the Insertion Tray.
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4. Click OK.
5. At the MFF Insertion Tray, adjust the guides for the paper size and load paper in the

Insertion Tray with text face up and according to the label. Load tabbed stock with
tabs leading.

6. On the Home Screen, open your job.
7. Select Special Pages.
8. Select Inserts and define the insertion page range for the job.
9. Print the job.

To Hole Punch Jobs on the MFF Pro Plus

If the 2/3 Hole Paper Punch is installed on the Pro Plus, you can indicate that you want
to finish and punch your printed documents with 2 or 3 holes at the lead edge. If the
2/4 Hole Paper Punch is installed, you can identify your documents to be finished and
punched with 2 or 4 holes. The various punch finishing options, such as hole punching
Portrait Top or Landscape Right, are selectable from the Output tab, the Stapling/Finishing
area on the FreeFlow Print Server interface. Use this hole punching feature if you want
to easily place your finished document in a 2, 3 or 4 ring binder.

Do not use this feature on labels, transparencies, envelopes, or synthetic paper.

Paper Specifications for the Hole Punch Module

WeightSizeType

56-200 gsm171-321mm (6.74-12.63 in)
width
148-457mm (5.83-17.99 in)
length

2-punch

56-200 gsm232-321mm (9.14-12.63 in)
width
148-457mm (5.83-17.99 in)
length

3-punch

56-200 gsm255-321mm (10.04-12.63 in)
width
148-457mm (5.83-17.99 in)
length

4-punch

1. Select Job Manager or Copy and open the job.
2. Select the Output tab and the Stapling/ Finishing FAB.
3. From the Stapling/Finishing pull-down menu, select the type of hole punch finishing,

staple finishing, or both (multiple finishing) to apply.
4. Click OK
5. Print the job..

Hole punch finishing output is sent to the Top Tray or the Main Tray
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Note
If you have a MFF with hole punch and both the 2/3 and 2/4 hole punch dies, any job
programmed for 2 hole punch will punch with either die loaded. Be sure the appropriate
hole punch die is loaded before submitting the job. On a 2/4 hole punch, the two center
holes are 80 mm apart. On a 2/3 hole punch, the two center holes are 70 mm apart.

For more information on the capabilities of the staplers, see Stapler Specifications.

For more information on the capabilities of the MFF Pro Plus Insertion Module, see
Multifunction Finisher (MFF) Specifications

Delivering Document Sets to the Stacker

Printing out large volumes of documents is not a problem for the Xerox Nuvera . On the
other hand, sorting and delivering those documents to people is difficult and time
consuming if the output is not organized.

For more information about document set sorting at the Xerox Nuvera , see Using Offset
to Separate Documents in a Stack.

Multifunction Finisher (MFF)

The other use for the Bottom Tray on the MFF is for Making a Booklet, dual-stitched,
saddle-stitched, and folded documents.

Note
The MFF is the basic or standard finisher on Xerox Nuvera . It is not available with any
other finishers and the Sheet Enhancement Module is not part of the configuration.

Basic Finishing Module (BFM)

The BFM includes a top tray, which serves as a purge tray and as a destination for stocks
ineligible for delivery to the stacker (refer to the CED for stock compatible with the
system). It also includes a high-capacity stacker. The BFM Plus has a bypass paper path
in place of the top tray.

For details, see Basic Finishing Module (BFM/BFM Plus) Specifications. For information
on using the Variable Shaped Tray on the BFM, refer to Using the Basic Finishing Module
(BFM).

Note
For the BFM paper backed transparencies can go to the stacker. All other transparencies
types must go to the top tray.

To send document sets to the stacker
Documents submitted from a client application can be programmed to use the stacker.
See Printing a Job from your Networked PC.
1. At the Xerox Nuvera user interface, initiate a job and make job programming choices.
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2. On the Output tab, choose the Stapling/Finishing button.
3. Click on the Output Location pull-down menu, and choose Finisher.

Note
This set of steps applies to systems with either an MFF, BFM XPS or DS3500.

4. To aid in the sorting and distribution of your output, you may want to program offset
into the documents going to the stacker.
For details, see Using Offset to Separate Documents in a Stack.

Note
Jobs with different sized papers can be stacked in the main tray. Small papers should
be stacked on top of large papers to prevent the stack from falling over.

To unload the BFM stacker

When the job assigned to the BFM stacker prints, the BFM collects the sheets in the
stacker bin. Once the bin limit is reached, the BFM drops the sets onto the stack below.

After the print job finishes, the system will unload the stacker based on the stacker limit
setting. For information on how to select the stacker limit, refer to Using the Basic
Finishing Module (BFM).

Caution
Do NOT open the BFM front door and the stapler door at the same time.

1. Select the Unload button on the UI or press the Unload button on the front of the
BFM.

2. When the LED is blinking, open the tray access door.
3. Grasp the black handle and slide tray outward.
4. Remove stack from stacker tray.
5. Push tray back into the BFM.
6. Close the access door.

What the LED means
• LED is On = BFM is in use
• LED is Off = BFM is not in use or is initializing after an unload (Do not open BFM front

door)
• LED is Steady = Stacker tray is lowering (Do not open BFM front door)
• LED is Blinking Slow = Stacker tray is lowering for an unload and the request to open

the BFM front door is recognized
• LED is Blinking Fast = OK to open the BFM front door

Note
The Unload button will not cause an unload if the Feed Module runs out of paper in the
middle of a job. Fill the Feed Module tray and allow the set to finish. Canceling, holding,
or deleting a job will also allow unloading to occur.
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In case of a jam in the paper path or stapler:
If paper should become jammed in the paper path section or stapler, and a system event
does not appear, you can access these areas by unlocking the drawer/cover through the
system software.
1. In the system user interface, click Printer > Unlock Finisher.

The Unlock Basic Finisher window appears.
2. The Top Cover and Stapler Drawer unlock buttons are shown. Click the button of

the area you wish to unlock.
3. You should hear a series of clicks coming from the BFM.

The cover or drawer can now be accessed.

Caution
Do NOT attempt to unlock any BFM covers or drawers while there is still an "Adjusting
Finisher" status visible in the status area of the system user interface. Wait for this
message to clear before attempting to use the Unlock Basic Finisher controls.

For details on clearing papers jams in the BFM, see Clearing Paper Jams.

Making a Booklet

Those Xerox Nuvera systems with a Multifunction Finisher (MFF) offer booklet making
capabilities.

For details about the Multifunction Finisher, see Multifunction Finisher (MFF)
Specifications.

To make a booklet

Multiple-page documents can be arranged in a folded and bound output, most commonly
called a booklet. The Xerox Nuvera allows you to set up a booklet output job in a few
different ways.

Two conditions must be in place in order to process a booklet job:

1. A multi-page document: either a hard-copy original or an electronic file.
2. A properly configured Xerox Nuvera system. See Setup Paper Trays for details.

Sample Copy workflow
1. Place multi-page original in the Document Feeder.
2. On the Copy section (chosen by default), begin setting the Job Properties.
3. On the Basic tab of the Copy section, select Booklet Folded and Stapled from the

Stapling/Finishing pull-down menu.
4. Choose 2 to 2 sided from the Sides Imaged pull-down menu.
5. Choose Size / US ledger 17x11 (A3) from the Loaded Stock list.
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Make sure a tray has been loaded with this stock type. See Configuring Paper Trays
for details.

6. Click on the Output tab. Click the Layout button. Choose Booklet from the Layout
Style pull-down menu.

7. Choose Portrait for the Original Orientation.
8. Click Copy.

Sample workflow from client driver
Tip
Open the Xerox Nuvera Client Driver beside this window as you follow these steps.

1. Select [File  > Print] in your desktop application.
2. Select the Xerox Nuvera print driver.
3. Select Properties.
4. On the Paper/Output tab, select the paper size of the original job: Letter (8.5" x 11").
5. On the Paper/Output tab, select Finishing > Folding  > Bi-Fold and Staple.
6. On the Image Options tab, select Margins > None.
7. On the Layout/Watermark tab, select Page Layout > Booklet Layout.
8. Select Page Layout Options  > Fit to New Paper Size > Tabloid (11" x 17").
9. Select OK.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

You will not be able to use Booklet Layout with
an Encrypted or Password Protected PDF using
the print driver. To workaround this, send the
PDF directly to the FreeFlow Print Server using
one of the web print submission tools or LPR
and hold it. At the FreeFlow Print Server, pro-
gram the Booklet Layout option and release
the job. The job will print in booklet form.

Booklet Layout
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Hint/Tip DescriptionSubtopic

Follow the steps below to properly program
booklets created using Adobe Acrobat PDF files.
To create an 11x17 folded booklet out of
8.5x11 size originals from PDF files, program
the job for 8.5x11 paper, use Fit to new Paper
Size, and choose 11x17 as follows:
1. In the Nuvera Print Driver, select the

Paper/Output tab.
2. Set Paper Size to size of the job

(8.5x11).
3. Select booklet fold if it applies to your

job.
4. Select the Image Options tab.
5. Set the Margins to None.
6. Select the Layout/Watermark tab.
7. Set Page Layout to Booklet Layout.
8. Select Fit to New Paper Size and set

the output paper size to 11x17.

PDF Booklets

When printing a landscape document using the
PCL driver, select the opposite duplexing option
from the one you want. 2 Sided Print and 2
Sided Print, Flip on Short Edge are reversed.
This also breaks Booklet Layout for landscape
jobs. So to print a booklet using a landscape
job, send the job to the FreeFlow Print Server
and hold it. Program the Booklet Layout in the
job properties and release it.

Landscape duplex options reversed

For more information on printing from a client application, see Printing a Job from your
Networked PC.

For detailed information about the controls used in these workflows, see the Xerox
Nuvera online Help system.

Printing Pads

You have the ability to produce printed pads on all Xerox Nuvera systems. Pads are
typically single sheet forms, often with a card stock back cover and a glued binding on
the top edge. Each sheet can be torn off the pad as needed.

Keep the following points in mind when considering pad printing:

• A pad printing job can only have one page image if printed one-sided, or two page
images if printed duplex.

• If the finisher supports the required options, a pad printing job can be offset and
finished after each pad subset.
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• Pad printing jobs can be saved, reprinted, and forwarded.
• Note

Combining pad printing with Special Pages or Slip Sheets is not recommended since
it may produce unexpected results.

To print a pad
You can program pads in various ways including Copy, Print from File, Job Properties,
and Queue defaults. The following instructions pertain only to the local user interface.
1. Double-click the pad job.
2. Select the Output tab.
3. Select the Stapling/Finishing FAB.

Note
To apply finishing to the pads job, first select the finishing, then select Finishing
under Subset Output Options, and finally select Pads Printing. If you decide to change
the finishing after you have programmed the pads, simply select Finishing and Pad
Printing again. The Sheets Per Pad and Number of Pads values will return to the
values you selected prior to changing the finishing.

4. Select the Pad Printing checkbox.
5. Select the number of Sheets Per Pad and the Number of Pads to print.

Note
If you remove the mark from the Pad Printing checkbox during the programming of
the job, the Quantity and Collation values return to their default values and an
information message displays.

6. Optionally, select the Add Back Cover checkbox, and select the Paper Stock to use
for the back cover.

7. Click Print.

Booklet Size Limitations

To avoid sheet misfeeds or jams, you should understand how booklet sizes, stapled and
unstapled, are expected to be handled by the Xerox Nuvera .

Maximum Booklet Sizes (in sheets)

For stapled sets:

For best results, the maximum booklet size (number of sheets that make up the booklet)
is 15 sheets of 80gsm paper (or 14 sheets of 80gsm, and 1 sheet of 200gsm cover stock).

For unstapled sets:

For best results, the maximum booklet size (number of sheets that make up the booklet)
is 5 sheets of 80gsm paper.
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Why is there this limitation?

When a stack of paper gets folded in the MFF, there is some shifting of the individual
sheets of paper. Stapling occurs before folding in the MFF. By stapling the sheet stack,
this shifting is controlled, allowing you to run more sheets.

In contrast, if the sheet stack is not stapled, this shifting is not controlled, creating the
possibility of sheets becoming jammed in the MFF mechanism.

Using Offset to Separate Documents in a Stack

Printing large volumes of documents is not a problem for the Xerox Nuvera . However,
sorting and delivering those documents to people is difficult and time consuming if the
output is all in one stack. You can program your jobs to include offset for finishers that
have stacking capabilities. This is useful for organizing multiple document sets for easy
distribution. Settings may vary based upon the finisher installed.

Offset Choice Terminology

It is important to understand what Sets and Stacks are in the Offset pull-down menu.

• Set: all pages of a multi-page document. In other words, one complete copy of a
multi-page document. This can be stapled or unstapled.

• Stack: several copies of a set.

To use offset to separate documents
1. Submit the job to the Xerox Nuvera .
2. From the FreeFlow Print Server user interface, select the Job Manager and open the

job's properties window.
3. Select the Output tab and the Stapling/Finishing button.
4. From the Output Location pull-down menu, choose the Finisher.
5. From the Offset pull-down menu, select:

• None: Offset is not performed. This is the default selection.
• Each Collated Set: The offset occurs between each set printed.
• Each Uncollated Stack: The offset occurs between each stack printed.
• Each Set and Stack: The offset occurs between each set or stack printed, whichever

comes first.

6. If desired, mark the Subset Offset checkbox.
Subset Offset inserts an offset within a stack (uncollated set) after each specified
page number. You can type the page count or use the arrow control to set the pages
per subset value.

7. When satisfied with your settings, click Print.
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Note
Choose Offset when stapling for the best stacking performance.

Note
Subset offset and finishing can be programmed in the Job manager or on a Queue. This
works fine for simplex jobs. It will also work for duplex jobs, as long as the request is for
an even number of images. However, if the request is for a subset that requires a duplex
page to be split, the request will fail.

Creating Folded Documents

For those Xerox Nuvera systems that include a Multifunction Finisher (MFF), you will
have C and Z-Folding capabilities for 8.5 X11 inch and A4 stock. All that is required is
either an original document or print-ready file that is formatted for this type of output.

For details about the Multifunction Finisher, see Multifunction Finisher (MFF)
Specifications.

The Xerox Nuvera Production System and Xerox Nuvera 200/288 EA/MX Perfecting
Production System may offer in-line finishers with fold capabilities. Refer the in-line
finisher documentation.

To make a C-Folded document while copying
1. Place the original document in the Document Feeder, short edge feed, side one face

up with the top of sheet toward the back of the scanner.
2. Select Copy Services.
3. Select Clear All.
4. If needed, add 8.5x11 white stock to tray 3 or 4. Place stock to short edge feed. Verify

tray programming.
5. Program Job properties. For example:

a) In the user interface on the Basic tab, select Trifold C from the Finishing menu.
b) Make any other job programming choices.

6. When satisfied with your settings, click Copy.

To make a Z-Folded document while copying
1. Place the original document in the Document Feeder, short edge feed, side one face

up with the top of sheet toward the back of the scanner.
2. Select Copy Services.
3. Select Clear All.
4. If needed, add 8.5x11 white stock to tray 3 or 4. Place stock to short edge feed. Verify

tray programming.
5. Program Job properties. For example:

a) In the user interface on the Basic tab, select Trifold Z from the Finishing menu.
b) Make any other job programming choices.

6. When satisfied with your settings, click Copy.
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To make a Folded document while printing

The steps for printing a Folded document are essentially the same as they are for copying.
The only difference is that you will browse to find the print-ready file at the Xerox Nuvera
.

For details on printing from the CD ROM drive, see Printing from the Media Drive.

For details on printing from your PC, see Printing a Job from your Networked PC.

Using the Basic Finishing Module (BFM)
The Basic Finishing Module (BFM) is a high-capacity stacker designed to collate and
stack up to 3000 sheets (20 lb paper or equivalent) and staple up to 100 sheets of 20
lb (75 gsm).

Select the BFM or BFM Plus finisher as the output device
1. Select the Output tab from a Job or Queue Properties window.
2. Select the Stapling/Finishing FAB.
3. From the Output Location pull-down menu, select the output device as: -System

Specified -Auto Switch -Finisher A or B: Main Stacker -Top Tray
4. Select the single or dual stapling from the Stapling/Finishing pull-down menu.
5. Select OK.

Define stacker settings and other adjustments affecting the BFM

There are several factors that may impact stacking quality and overall productivity of
the BFM such as minimizing paper curl, setting stacking limits, improving jam rate, and
the use of the variable shaped tray for better registration. The following describes how
to ensure the quality of your output and improve overall productivity.

Enable/Disable Automatic Image Permanence for All Stock Weights

The Xerox Nuvera is designed to optimize fusing performance across the supported
range of paper types and weights. The BFM uses the paper weight programmed when
loading paper to optimize registration and compiling. Enable the AIP selection from
System  > User Diagnostics to achieve the best fuse temperature and minimize curl in
the stacked output.
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Set BFM Stacker Limits

While the BFM can stack up to 3,000 sheets, it is best to set a stacking limit that is a
more comfortable stack size and not so large and heavy to lift or transport. Setting a
manageable limit also helps to avoid paper curl that can occur in a large stack, which
then eliminates the need for operator intervention.

The BFM detects when the stacker is about to reach its limit and automatically schedules
an unload when the next set is completed. If you have two BFMs in the system and one
becomes full, the system automatically switches to the second BFM.

Follow the steps below to set unique stacker limits for each stacker on the system.
1. Select Print Manager  > Stacking tab.
2. Right-click on one of the finishing devices and select Stacker Limits.

The Stacker Limits window displays.
3. Set Stacking Limits for each stacker that is available on your system:

• Main Stacker: This field identifies the number of sheets not to exceed in
determining when to unload the BFM main stacker. Select from 200 - 3000 sheets.

• Bindexer Capacity: This field identifies the number of sheets that can be compiled
in the BFM main compiler for unfinished sets only. This feature allows you to
control the number of sheets to be compiled before they are placed onto the stack.
Select from 15 - 100 sheets (20 lb paper). If you leave this field blank, the
Automated Bindexer is in effect. The system automatically calculates the thickness
of the unfinished set in the compiler before the sets are placed onto the stack.
The system uses the lower of the manual or automatic setting. Bindexer is set to
100 at install.

4. Adjust the Bindexer setting to:

• Help reduce excessive curl on sheets (lower the setting)
• Manage special stocks such as coated stock - Improve stacking of some papers

(lower the setting)
• Improve jam rate of heavy papers
• Reduce the occurrence of BFM faults and the number of wasted sheets in the

compiler (lower the setting)
• Improve problem jobs by reducing to 35 (if setting is 35 and job is 37 sheets,

increase to 37 or more).

Note
When running smaller stapled sets (15 sheets or less), limit the quantity to 100 maximum.
Unload the stacker after each quantity is completed.
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Set BFM Registration Values
Paper registration at the BFM is impacted by curl. Follow the steps below to improve
paper registration quality at the BFM for each BFM on the system. However, it is
recommended that you first resolve curl issues with the IOT decurler or, if available, the
Sheet Enhancement Module setting (see Managing Paper Curl) before enabling this
feature.
1. Select Print Manager  > Stacking tab.
2. Right-click on one of the finishing devices and select Stacker Limits.

The Stacker Limits window displays.
3. If this is a dual BFM system, select the stacker you need (for example, Stacker B).
4. Select one of the following checkboxes in the Set Registration Quality area of the

window:

• Improve Set Registration: If sheets exiting the print engine have an excessive
amount of upcurl preventing the BFM from pushing sheets from the lead edge
into registration position, select this checkbox. This selection enables and lowers
the scuffer in the BFM, which applies pressure to the center of a dual staple job
set, minimizing the amount of pucker or buckle between the staples. It also helps
push the sheets to the registration gate. In addition to improving set registration,
this feature helps to reduce jams.

• Improve Initial Pages Registration Within Set:Select this checkbox when you
are using tab stock mixed with A4/letter size body pages. Also, if you are
experiencing jams and paper curl within sets. The system disables buffering
between sets. While registration of stock is improved, productivity will be impacted.
The system skips a number of pitches until the compiler is ready to accept new
sheets.

Note
To achieve full productivity on the BFM, buffering must be enabled. Buffering is
enabled by default.

Note
Registration is not optimized for tabs and oversized covers. This includes stapled and
unstapled sets. The first 200 - 500 sheets from a cold start may exhibit this problem.
Machines left in standby recover much more quickly.
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Using the Variable Shaped Tray

If you are still experiencing curl in the stacked output and want to further improve
stacking quality, you can install the Variable Shaped Tray on the stacker tray. The Variable
Shaped Tray is available through a customer kit for all BFMs and can be installed and
removed by the customer. It is designed to enhance the stacking of stock in the tray by
improving sheet flatness. If you are experiencing early unloads, jams, curling or poor
stacking, use this feature for paper <140 gsm, only after trying the standard decurl
adjustments. Keep in mind that some papers will run best without the tray installed,
especially if no curl exists. Do not use this feature for stock >140 gsm.

To install the Variable Shaped Tray
1. Slowly pull out the Elevator Tray on the BFM.
2. Place the Variable Shaped Tray on the BFM Elevator Tray.

It drops directly into the Elevator Tray when it is in the unload position.

3. Carefully push the Elevator Tray back into the BFM being careful not to damage the
actuator on the right side of the tray.

To remove the Variable Shaped Tray
1. Slowly pull out the Elevator Tray on the BFM.
2. Unload the stacker, if necessary.
3. Lift the Variable Shaped Tray off the Elevator Tray.
4. Push the Elevator Tray back into the BFM.

Unloading stock from the Variable Shaped Tray
1. Slowly pull out the Elevator Tray on the BFM being careful not to disturb the stack.
2. Only unload up to two (2) reams of stock at a time, being careful to maintain stack

integrity
3. For the the last two reams slide your fingers under the staple cutouts on the right of

the tray.
4. Slide your hands back to mid-stack, lift and remove the stock.
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5. Close the Elevator Tray.

Related Hints and Tips

Tab behaviors for non-MFF systems only

On non-MFF systems, tab jobs are delivered to the finisher face down in 1 to N order.
As such, the following must be noted:

• Tabs must be loaded in the feeder tray in 1 to N order (commonly referred to as
forward-ordered tabs)

• There are no special loading instructions required for drilled or pre-printed stock. Load
those stocks according to the labels on the feeder trays.

Note
If the labels indicate that drilled paper is to be loaded with the holes along the trailing
edge (to the right), then the incorrect labels are installed on the feeder module. Contact
service for a replacement.

Alternate Sets Between Stackers Feature

The Alternate Sets Between Stackers feature allows each set of a job to be output to
alternating stackers.

Note
This is a system setting that is applied to all jobs set to the System Specified output
location. A status message appears when this feature is active.

This feature is most useful when:

• Small sets of two or three pages are printed

• Order does not matter

• Productivity is important

Toggle the Alternate Sets Between Stackers feature by doing the following:

1. Logon to the FreeFlow Print Server as a System Administrator.

Note
Accessing the User Diagnostics mode pauses the printer.

2. Select System and User Diagnostics.

3. From the left navigation bar, select System Optimization Customer Setup.

4. Select an auto switching behavior option under Stacker Auto Switching Rules.

5. Select OK to apply the setting.

6. Select File and Close.

7. Resume the printer.
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Explore the links below to learn all of the ways to utilize the BFM

Delivering Document Sets to the Stacker

Using Offset to Separate Documents in a Stack

Replacing Staples in the BFM

Clearing Stapler Jams

Clearing Paper Jams

Using DFA Compliant Finishers through
the DS3500/XPS
If you have a 3rd party finisher attached to your system, you will also have a DS3500/XPS.
The DS3500/XPS is an interface between the main printing area of the Xerox Nuvera
EA Production System or Xerox Nuvera 200/288/314 EA/MX Perfecting Production
System and a DFA-compliant finishing device of some type, such as a stapler, binder,
booklet maker or folder.

External Finishers Available on the Xerox Nuvera System

There are a number of DFA-compliant inline finishers that can be installed on the system.
You must have a DS3500/XPS installed to add a 3rd party finisher. Here is a list of some
of the finishers available.

• GBC AdvancedPunch Pro
• C.P. Bourg BDFx Booklet Maker
• Xerox SQUAREFOLD Booklet Maker(SQFBM)
• GBC Fusion Punch 11 with Offset Stacker
• Xerox DB120-D Document Binder
• Xerox Manual and Book Factory
• Xerox Tape Binder

What is DFA?

Document Finishing Architecture (DFA) is a set of published specifications that allow
finisher vendors to develop in-line devices that are compatible with Xerox printing
equipment. The DS3500/XPS is a DFA-compliant device.
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DFA Configurations and Profiles

A set of default DFA profiles are preinstalled on the system for each DFA-compliant
finisher attached to the Xerox Nuvera System. Generally, the DFA profile is supplied by
the finisher vendor and installed at the time of the finisher installation.

Managing DFA Configurations and Profiles

To switch to a different DFA configuration on your system, refer to Changing DFA
Configurations for 3rd Party Finishers.

Refer to your System Administrator on how to create, edit, enable/disable, and delete
DFA Profiles and Configurations.

Select the 3rd Party External Finisher as the output device
After you have set up the basic print sections of your job and the System Administrator
has defined and enabled the finisher configuration and profile for your system, perform
the following steps to use the DS3500/XPS and select the finishing output at the user
interface.
1. From the Copy Service, Print From File Service or Job Properties window of an inactive

job, select the Output tab.
2. Select the Stapling/Finishing FAB.
3. When printing to a 3rd party finisher, make sure the Output Location pull-down menu

is set to System Specified.
4. From the Stapling/Finishing pull-down menu, select External. All available finishing

profiles display.
5. From the profile list that displays, select the profile. The profile name displays in the

Stapling/Finishing pull-down list. To enable or disable profiles, contact your system
administrator.

6. Select all other finishing attributes.
7. Click Apply or OK.

Changing DFA Configurations for 3rd Party Finishers

When your system is installed, a Xerox CSE uses the FreeFlow Print Server to create a
configuration and profile of the finishing devices on your system. A configuration
represents the finishing module or combination of finishing modules installed. Within
a configuration are profiles that represent specific destinations, device settings and
attributes for that configuration.

To enable a different profile than the one currently enabled for a
finishing configuration:
1. On the Printer menu, select Finishing.
2. From the Finishers drop-down menu, select External Finishers.
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The External Finisher window displays. One or more configurations will be listed
depending on the 3rd party finishers installed.

3. If the job you are running requires a different finishing location than what is currently
enabled for that configuration, select the configuration identified as online.

4. Select a different destination profile listed under the configuration, right-click, and
select Enable to enable a different profile.

To change from using currently installed finishers and enable a new
configuration:
This procedure is for instances when you need to physically change finishing devices
and replace existing finishers on the system with a different set of finishers. Refer to the
vendor's 3rd party finishing documentation to learn which finisher profiles will be changed
automatically or which ones will need to be manually updated.
1. On the Printer menu, select Finishing.
2. From the Finishers drop-down menu, select External Finishers.

The External Finishers window displays.
3. From the configuration list, select the configuration currently online.
4. To disable the profiles you do not want, right-click the profile(s), and select Disable.

Disable all profiles being used.
5. Remove existing finishing equipment and install the new equipment on the system

as needed. Refer to your 3rd party finishing documentation on how to manually
adjust settings on the module itself.

6. On the External Finishers window, select a profile within the new configuration that
you want to enable and right-click. Or, you can also select the Catalog button and
select predefined, Xerox supplied configurations.

7. Select Enable for all profiles.
Previously enabled profiles will be disabled and placed offline. The new configuration
is now online and the selected profiles enabled.

8. Select Close.

Related Hints and Tips

Pause behavior/ Banner sheet delivery

The Device Profile contains a Device Type field. The possible selections are Stacker and
Finisher. The following two problems only occur with DFA finishers:

• You may notice that the banner sheets are delivered to the Top Tray rather than to
the stacker with the job output. If you prefer that the banner sheets be delivered to
the main stacker, configure the DFA device to be a 'stacker' as noted below.

• You may notice long delays before the printer stops when Pause is selected, especially
when running a job that is one long stream as opposed to multiple sets. This is because
the system is attempting to get to a set boundary before stopping. If you prefer it
to stop sooner, configure the DFA device to be a 'stacker' as noted below.
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Note
The DFE is going to do a set terminate when the pause occurs. This may not be handled
correctly by finishing type DFA devices such as booklet makers.

The Device Type options are Stacker and Finisher with Finisher as the default value.
Each option configures different Pause behavior and Banner Sheet delivery.

If Device Type is set to Stacker, the resultant behavior is:

• Pause - immediate
• Banner sheet delivery - to the same destination as the job body

If Device Type is set to Finisher, the resultant behavior is:

• Pause - next set boundary
• Banner sheet delivery - to the DS3500/XPS top tray

DFA sheet rotation and letter-size banner sheets

If a Queue specifies DFA sheet rotation and letter size banner sheets, jobs sent to the
DFA Rotate Queue will fault with the FreeFlow Print Server Required Media Not Loaded
message when both Long Edge Fee (LEF) and Short Edge Feed (SEF) letter source media
are available for paper feeding.

When tested, the system attempted to select LEF letter media for the banner sheet;
when rotated, the cross-process dimension is 8.5 inches.

Note
Disabling the LEF letter paper tray allows the job to print, or disabling Banner Pages
allows the job to finish even if both trays are enabled.

Enable/Disable stacker capability from FreeFlow Print Server

This feature is for the BFM and DS3500/XPS finishers. This allows for a specific stacker
to be disabled if working poorly and in need of service.

Perform the following steps to enable/disable stacker capability from FreeFlow Print
Server:

1. Logon to the FreeFlow Print Server as a System Administrator.

2. Select Printer and Stacking.

3. Right-click on the desired finisher and select Enable or Disable.

4. Select Close.
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Related Hints and Tips

Tab behaviors for non-MFF systems only

On non-MFF systems, tab jobs are delivered to the finisher face down in 1 to N order.
As such, the following must be noted:

• Tabs must be loaded in the feeder tray in 1 to N order (commonly referred to as
forward-ordered tabs)

• There are no special loading instructions required for drilled or pre-printed stock. Load
those stocks according to the labels on the feeder trays.

Note
If the labels indicate that drilled paper is to be loaded with the holes along the trailing
edge (to the right), then the incorrect labels are installed on the feeder module. Contact
service for a replacement.

For more information

• For information about printing to the BFM, see Using the Basic Finishing Module
(BFM).

• For information and video demonstrations on clearing paper jams in the DS3500,
see Clearing Paper Jams.

• For information about DS3500 specifications, see DS3500 Specifications.
• For details on the specifications of the DFA-compliant 3rd Party Finishers, contact

your Xerox representative for the Solutions Planning Guide for that finisher.

Adjusting Image Quality
The Xerox Nuvera user interface contains a set of Image Quality adjustment tools for
Copy, Scan to File and Print jobs. Using these controls, you can make adjustments to
images containing text, photographic images, halftoned images, as well as documents
with mixed image types. This is useful if the original document is less than perfect; i.e.,
text/images are too light or too dark.

To learn more about these capabilities, explore the links at the left.

Note
The Copy and Scan functionality is only available if your system includes the integrated
Document Scanner module. If the Enhanced Line Screen license is enabled, the system
supports jobs with 85, 106, 125, 134 and 156 lpi halftone screens. If this license is not
enabled, only 125 lpi is supported.
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To adjust image quality on copy and scanned jobs
1. At the Xerox Nuvera user interface, click on Copy (or Scan to File), then click on the

Image Quality tab.
2. Choose the Original Type of the image to be copied. Click on the Original Type button,

then click on the Rendering Options Setup button. Choose any options according
to the condition and type of the original document.

3. Click on the Basic tab, then use the Darken/Lighten control to make small corrective
adjustments.

4. Click on the Image Quality tab, then click on the Image Adjustments button. Use
the Contrast, Sharpness and Background Suppression controls to make small
corrective adjustments.

5. Set Print Quality.
The Toner Saver selection uses less toner and is more economical than the full quality
setting of Optimal. It is useful for scatter removal without causing a light solid image
on the page. You may want to use the Optimal setting when printing proof documents.

Tip
If you copy /scan a great number of the same type of original documents, you can set
custom image quality defaults. For example, if the majority of your copying /scanning
is of dark photographic content, the system defaults can be set to accommodate this,
saving you job programming time. To set up your system defaults to match your original
input, contact your System Administrator.

To adjust image quality on print jobs
1. Select Print From File on the Service menu and use the Files tab to locate and select

the job.
2. Select the Image Quality tab.
3. From the Mode pull-down menu, select the printer emulation setting.

The DocuTech 135 setting prints output that is similar in appearance to that of the
DT135 printer.

4. Use the Print Darkness control to make small corrective adjustments in increasing
or decreasing darkness.
All pixels in the image are moved either towards black or white. The values closest
to 0 are intended for small adjustments to the darkness of text and pictures. The
darkness +/-3 settings will make a noticeable difference on text but not recommended
for most pictorials.

5. Select a Resolution.
Since resolutions vary from printer to printer, use this option to achieve better
performance for jobs that were saved at 300 dpi.

6. Set Print Quality. The Toner Saver selection uses less toner and is more economical
than the full quality setting of Normal. It is useful for scatter removal without causing
a light solid image on the page. You may want to use the Normal setting when
printing proof documents.

Xerox® Nuvera®12-30
User Guide and Training Aid (UGTA)

How Do I...



7. To select a halftone, open the job. From either the Print Properties window or the Job
Properties window, select a Halftone.
This allows you to adjust the pattern of dots or lines of varying sizes applied to an
image of varying tones, or same sized dots applied to a tint of color.

Note
If the Enhanced Line Screen license is not enabled, the Halftone selection is not available
since there is only one halftone (125 lpi) offered.

Stroke Thickening (increasing the weight or width of a character)
1. Open the Job Manager and select and open the job.
2. Select the Image Quality tab.
3. From the Job Properties window and the Stroke Thickening field, adjust this setting

to control the thickness of fine lines created by the PostScript stroke command.

About Toner Saver

The Toner Saver Print Quality selection is intended to save toner costs, similar to draft
mode.

Note
Toner Saver is designed to save toner, and can produce poor image quality and
undesirable, light, or washed-out prints.

About Image Quality for Copy and Scan to file
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs. Also, the halftones available to you depends on
whether the Enhanced Line Screen license is enabled or not.

The Xerox Nuvera is a digital imaging system. The scanner converts full color optical
(analog) images to a gray digital image (0-255 gray scales). The image processing
functions adjust the image according to the image quality features selected. The resulting
image is a binary image which records the 'appearance of gray' as a collection of dots
varying in spacing and diameter. These dots are made up of several pixels (picture
elements). In a binary image, each pixel element is either 1 or 0.

Image quality involves adjusting the tones(darkness and contrast), sharpness and
rendering textures of the scanned image to get a pleasing output image.

To get a optimal quality scan of an original requires the following types of image
processing:

• Detection and suppression of colored and shaded backgrounds
• Removal of halftone screens
• Sharpening of edges in the image
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• Lightening or darkening of highlights, midtones and shadows to get good contrast
and detail

• Application of new halftone screens to photos and halftones

The higher the quality of the original, the higher quality of the final copy. Image
processing adjustments can only enhance the information which is in the original or
suppress undesirable defects. It can not 'create information'.

The key to getting satisfactory scans or copies from your Xerox Nuvera is understanding
how to adjust the image quality processing controls and which controls to adjust. Digital
image quality processing can often create a copy with 'better' image quality than the
original. Light text can be enhanced, past-up lines suppressed and even 'coffee stains'
removed. For some applications, such as legal documents, it is desirable that all
information on the original be preserved to create a 'faithful' copy.

Follow the links at the left to learn more about image quality adjustments.

Begin by selecting Choosing the Best Original Type (when scanning or copying)

For help with solving specific image quality problems, see Solving Image Quality Problems.

Note
If you copy /scan a great number of the same type of original documents, you can set
custom image quality defaults. For example, if the majority of your copying /scanning
is of dark photographic content, the system defaults can be set to accommodate this,
saving you job programming time. To set up your system defaults to match your original
input, contact your System Administrator.

Tip
It is best to proof a job when you make image quality adjustments.

Choosing the Best Original Type (when scanning or copying)

Original Type is the most important image quality setting for copying images. When
selecting an original type use a default setting for sharpness, contrast, darkness and
background suppression.

To get the best results, it is important that you be able to assess your original document,
and make a determination as to what types of images comprise the document.

To select an Original Type
1. Select Copy (or Scan to File).
2. Select the Image Quality tab.
3. Select an Original Type.
4. Select a Rendering Option, if needed.
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Original Types

Mixed Text and Graphics: use for most jobs, business graphics, charts, logos and maps.
This setting preserves gray text and is recommended for text critical applications.

Text: use for enhancing text only. Using the text setting turns dark gray text to black.
For black and white transactional applications of text and numbers, or book copying
without pictures or graphics, use text mode.

Mixed Text and Halftones: use for printed photos and halftones. Recommended for
pictorial critical applications.

Photo: use for photographs and continuous tone images

For example, if the original is a paste-up, or has multiple areas of different types of
information, Mixed Text and Graphics mode is the best compromise.

A good approach to making the best Original Type selection is to identify the area in
the document of greatest importance. Perhaps, in a document composed of text and
images, making the text legible is more important than a high quality reproduction of
the pictures. If this is the case, use Text mode.

Photo mode is the only mode that applies a halftone; all of the others apply a form of
error diffusion to minimize moir. For jobs which contain various types of documents (e.g.
some pages of text, some pages of halftoned context), the mixed mode is the best
compromise. Alternatively, you're encouraged to use job programming to selectively
define a different original type for each page.

Rendering Options

The halftones available to you depends on whether the Enhanced Line Screen license
is enabled or not.

Mixed Original types

Diffusion Dither simulates gray values using collections of black and white pixels without
disturbing sharp edges.

Hybrid combines halftones and diffusion in a manner determined by the local pixel
classification.

Text

Diffusion Dither simulates gray values using collections of black and white pixels without
disturbing sharp edges.

Threshold/High Contrast produces a very high contrast reproduction of black and white
inputs.
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Photo

125 lpi for high image quality results - recommended setting

106 lpi for medium image quality results

85 for low image quality results

Background suppression should be ON if the photo does not extent to the lead edge of
the paper as it enters the scanner.

Tip
One of the advantages of build job is the ability to set Original Type for each section or
page of the build job.

For information on Build Job see Using Build Job.

Tip
It is best practices to proof a job when you make image quality adjustments.

About Contrast

The Contrast control enhances the tonal separation, especially in the midtones. Increasing
contrast moves midtones (gray) toward black or white. Decreasing contrast makes blacks
and whites appear gray.

Limits of Contrast controls

The Contrast control on the Xerox Nuvera applies to all of the pixels in an image at once.
In other words, changing the contrast in the midtones of your image will also affect
highlights and shadows.

If contrast is increased too much, midtone detail may be enhanced, but at the expense
of highlight and shadow content. Differences between adjacent pixels become greater,
causing shadow areas to turn completely black, while highlight areas turn completely
white (see Figure 1).

Figure 13. A high-contrast image. Gray levels are being spread out across the entire histogram.
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On the other hand, decreasing contrast too much causes a loss of highlights and shadows.
Instead of highlight content turning completely white and shadow content turning
completely black, highlights and shadows get "compressed" into the midtone region of
the histogram (see Figure 2).

Figure 14. A low-contrast image. Gray levels are compressed into midtones, and there is a loss of
highlight and shadow, as evidenced in the histogram.

For details on working with the contrast control, see Adjusting Contrast (when scanning
or copying).

Note
Often, increased contrast will tend to make pictorials appear sharper. It is recommended
that the sharpness control be used to adjust sharpness because it increases the sharpness
of edges without having the macro tonal changes of the contrast control.

Adjusting Contrast (when scanning or copying)

There are seven contrast levels which control the appearance of fine detail in the final
output image.

The solution to getting the image to look good, without creating image quality problems,
is to increase or decrease contrast in small increments. See About Contrast.

To adjust contrast
1. In the Xerox Nuvera user interface, click the Copy button.
2. Click the Image Quality tab.
3. Click the Image Adjustments button.
4. Move the slider right or left to increase or decrease (respectively) the amount of

contrast.

Tip
It is best to proof a job when you make image quality adjustments.

Tip
Depending on your system configuration and licenses, system defaults and queue settings
may be used to set contrast. See Working with Queues.
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About Lightness/Darkness

The Lighten/Darken control makes all tones lighter or darker. Increasing
Lightness/Darkness moves all tones in the image toward white. Decreasing
Lightness/Darkness moves all tones toward black.

Note
When the Text Original Type with Threshold Rendering Option is selected, the
Lightness/Darkness control adjusts the threshold value. Pixels lighter than the threshold
value become white, and pixels darker than the threshold value become black. This often
creates the appearance of a contrast change.

Lightness/Darkness controls

Lightness/Darkness controls, when set to extremes, may cause loss of detail in shadows
(darker areas) or highlights (lighter areas). For example, Figure 1, to get more shadow
detail in the phone handset, move the Lightness/Darkness slider control to the right,
making the image brighter.

Figure 15. A dark original image. Notice how shadow detail goes to black areas. Histogram data is
justified to the left.

However, as you can see in Figure 2, while shadow detail is gained in the telephone
handset, much of the midtone detail in the woman's face has turned completely white.
While desirable tonal correction enhances details at one end, the saturated tones at the
opposite end loose detail.

Figure 16. Too much Lightness applied. Notice how some of the highlight detail has gone to completely
white. Histogram data is justified to the right.
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For details on working with the lightness/darkness control, see Adjusting
Lightness/Darkness.

Adjusting Lightness/Darkness

Making adjustments to any of the image quality controls should be done in small
increments. Making large adjustments can create image quality problems.

Adjust Lightness/Darkness for Copying
1. In the Xerox Nuvera user interface, click the Copy button.
2. Select the Basic tab.
3. Move the slider right or left to increase or decrease (respectively) the amount of

lightness/darkness.

Tip
It is best to proof a job when you make image quality adjustments.

Adjust Lightness/Darkness for Printing
1. In the Xerox Nuvera user interface, select Image Quality on the Printer menu.
2. To select a printer darkness value, select the Setup button and choose one of the

following Print Quality modes:

• Best mode -the default and recommended for most jobs, especially those on
uncoated stocks. It adds or subtracts sub pixels on the edge of the image element,
text, lines, dots, solids, etc. It introduces no artifacts to lines. However, at extreme
ends of the range, contours may occur in halftones.

• Normal mode - the line width adjustment is identical to the Best mode and the
defects are similar. In addition, it applies a slight correction to reduce line edge
scatter. The correction can be helpful for coated stocks or very smooth stocks.
Typically the adjustment is so slight it is not helpful for any black dots scattered
on Mylar tabs. The amount of anti-scatter adjustment is fixed for all darkness
levels.

Note
If you notice black dots scattered at the edges of lines or text, use the Toner Saver
selection with a -3 or -2 setting to remove the dot scattering effect.

3. From the Darkness slider, increase or decrease the amount of black or white applied
to all pixels in the image.
The values closest to 0 are intended for small adjustments to the darkness of text
and pictures. The darkness +/-3 settings will make a noticeable difference on text but
not recommended for most pictorials.

4. From the Mode pull-down menu, select the printer emulation setting.
The DocuTech 135 setting prints output that is similar in appearance to that of the
DT135 printer.
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Note
If you forward a job from one machine to another, the forwarded job will lose its Printer
Darkness setting as well as imposition and annotation attributes.

About Sharpness

A sharp image has clean, crisp edges. Sharpness effects local areas which transition
quickly from light to dark tones such as the edge of a building against the sky or the
edge of a line against a white background. When these transitions occur over a few
pixels (1-2), the image appears sharp. When the transition occurs over several pixels
(3-10 or more), the image appears fuzzy or blurred.

Sharpness control

Sharpening re-establishes clear difference between adjacent pixels (see right half of
figure).

The sharpness control is particularly useful in enhancing pencil lines or supporting
suppressing paste up lines. Generally, text looks better with more enhancement, while
pictorials only require moderate enhancement.

However, (the right half of the figure 1), while the right half is not as blurry as the left
half, too much sharpening has made the image look grainy, and has caused the girl's
complexion to become uneven, or mottled.

For details on working with the sharpness control, see Adjusting Sharpness (when scanning
or copying).

Tip
Extremely high levels of sharpness tend to cause 'ringing' on edges which gives the
image an artificial appearance. Depending on the application, some designers use this
method to create a 'better than original, very sharp focal point in the document.
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Tip
Extremely high levels of sharpness may amplify moire. see Suggestions for removing
moiré patterns:.

Adjusting Sharpness (when scanning or copying)

There are seven sharpness levels which control the appearance of fine detail in scanned
images and copy jobs.

The solution to getting the image to look good, without creating image quality problems,
is to increase or decrease sharpness in small increments.

To adjust sharpness
1. In the Xerox Nuvera user interface, click the Copy button.
2. Click the Image Quality tab.
3. Click the Image Adjustments button.
4. Move the Sharpness slider right or left to increase or decrease (respectively) the

amount of sharpness.

Tip
To see the impact of the Sharpness control, try scanning a photo from your wallet and/or
copying a light pencil line drawing in photo mode. Scan and proof them with different
sharpness settings.

Tip
It is best practices to proof a job when you make image quality adjustments.

Choosing the Best Halftone Setting

If the Enhanced Line Screen license is enabled on your system, the Xerox Nuvera supports
a variety of halftones when printing. If this license is not installed and enabled, the
system offers a 125 lpi line screen. Also, the available selections depend on the Page
Description Language (PDL) being submitted.

To select a Halftone
1. Open a job properties window.
2. Select the Image Quality tab.
3. Select the Halftone button and the screen value from the Halftone pull-down menu.

Note
Systems without the Enhanced Line Screen license offer only the 125 lpi 53 degree
halftone screen.

Note
For systems with the Enhanced Line Screen license enabled, the system offers 85, 106,
125, 134 and 156 lpi halftone screens. The default 125 lpi 53 degree halftone screen
represents 256 levels of gray.
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The default halftone screen can be selected for each print queue. The default will be
used if a PostScript, PDF, or TIFF job does not contain a halftone command. This will be
the common case because the print drivers and job submission tool do not send a halftone
command by default.

Note
When reprinting a saved job, the system does NOT permit the Halftone Screen value to
be changed, since saved jobs will already have had a halftone applied.

Often the selection of a different frequency will change the resulting Moir texture to
one which is more acceptable, but can not totally eliminate Moir. For more information,
see Suggestions for removing moiré patterns:.

Systems with the Enhanced Line Screen License

The rich variety of screen frequencies for these systems include 85, 106, 125, 134 and
156 lpi and provide the flexibility required for a wide variety of applications.

The demo files are located in the Sample Jobs directory on the system. As system
administrator, open and print the .tiff or .xpf file in the appropriate stock size. The job
ticket contains all the necessary job settings. The job prints on letter stock.

The file names are:

• screenfreqdemo_ltr.tif
• screenfreqdemo_ltr.xpf

Editing Images
There may be instances where you may want to alter placement of the image on your
output. The Copy Service, Scan to File Service and Print from File Service Image Edit tab
on the Xerox Nuvera user interface offers controls to change image placement,
orientation, etc.

Note
The Copy Service and Scan to File Service are only available if your system includes the
integrated Document Scanner module for copying and scanning jobs.

To edit copy or scanned images
1. Place the original on the Document Glass or Document Feeder.
2. Click the Image Edit tab.
3. Click the Original Size button. Select Manual Document Glass or Mixed Size Originals

to input the size of the original document(s).
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4. If your output paper size is bigger than the original image, you may want to use the
Edge Erase controls. Utilizing these, you can eliminate the border caused by the copier
detecting and imaging the edge of the original document. Or, you can eliminate
information around the edges of your original document, by placing a mask using
the Edge Erase function.

5. Click the Image Shift button.
Using this control, the image being copied can be placed anywhere on the output
page.

6. Click the Image Rotation button.
Using this control, the output image can be rotated 180 degrees. See Rotating the
Image.

7. Click the Negative/Mirror Image button.
Using this control, the output can be printed as a negative, where the black pixels
print white and the white pixels print black and/or the output can be printed as a
mirror image on the lead edge.

8. When satisfied with the adjustments, click Copy or Scan.

To edit print images
1. Open the Print Properties window of a print job.
2. Click the Image Edit tab.
3. Click the Image Shift button.

Using this control, the image being printed can be placed anywhere on the output
page.

4. Click the Rotation button.
Using this control, the image being printed can be rotated 180 degrees.

5. Click the Background Form button.
Using this control, a Background Form can be added to the printed job.

6. When satisfied with the adjustments, click Print.

Note
Jobs can be saved as Background Forms. A listing of the available Background Forms is
located in the FreeFlow Print Server menu bar under Administration  > Background
Forms. For more information, refer to the FreeFlow Print Server online Help.

Erasing Unwanted Marks On Originals

Sometimes the original document you are copying or scanning contains markings near
the edges that you wish to remove. Examples of unwanted edge markings could be:

• Wrinkled, torn, or other damage near the original document's edges
• Hole punches
• Handwriting or other errant marks near the document's edges
• The edge of the paper causing a shadow
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Erase Options

There are two methods for deleting unwanted edge markings:

• Edge Erase: This method allows you to set different deletion widths to every edge
of the page in the original document. This method is useful for damaged documents
or documents that have errant markings on some but not all edges.

• Border Erase: Using this setting, one deletion width is set and applied to all edges
of the document. This method is useful for originals on colored paper, or documents
that have the same unwanted edge content on every page.

To erase an edge
1. On the Home Screen, initiate a copy or print job.
2. On the Image Edit tab, click the Edge Erase button.
3. On the Edge Erase drop-down menu, select either Border Erase or Standard Edge

Erase.
4. Use the spinner boxes to set the area (or areas if you selected Edge Erase) you want

Edge Erase to cover.

Other ways to work with edge-to-edge imaging

See Printing an Image That Extends to the Edge of the Page for information on more
ways to utilize edge-to-edge imaging.

Reducing or Enlarging Images

When in Copy mode, use the Reduce/Enlarge controls located on the Basic tab. Using
these controls, you could for example, copy an original image on an 11 by 17 inch sheet,
and shrink it to fit on a standard 8.5 by 11 inch sheet. Controlling output size is useful
if you need to archive hardcopy in a certain stock size, but original documents vary in
size.

To reduce or enlarge the image
1. Determine what size your output image will be copied to. Make the appropriate choice

in the Reduce/Enlarge pull-down menu, located on the Copy Basic tab.
2. Press Copy.

Note
It is also possible to enter custom size values in the Reduce/Enlarge dialog. Click on the
User Specified or Independent X-Y menu choices.

Entering a custom reduction/enlargement value
If none of the preset reduction/enlargement values are acceptable, enter your own value.
1. Select User Specified or Independent X-Y from the Reduce/Enlarge pull-down menu.

Xerox® Nuvera®12-42
User Guide and Training Aid (UGTA)

How Do I...



2. Enter the value of reduction or enlargement. Entering 100% will yield no change to
the image size. Entering a value over 100% will enlarge the image. Entering a value
under 100% will reduce the image.

Shifting the Image

Sometimes the information on the output page needs to be moved to accommodate
different types of binding. This prevents information falling into areas that may
eventually be hole-punched, stapled, or perfect-bound.

Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

To shift the image for a copy job
1. Determine the amount of space needed to shift the content away from the binding

edge.
2. Place the original document on the Document Glass.
3. In the Xerox Nuvera user interface, click the Copy button.
4. Click the Image Edit tab.
5. Click the Image Shift button.

Image Shift controls appear. In the Shift Options drop-down menu, Manual is the
default.

6. Enter the amount of margin shift determined in step 1.
7. Make any other adjustments to the copy job.
8. Click <Copy>.

To shift the image for a print job
1. From the user interface, select Job Manager and open the job properties window of

the job.
2. Select the Image Edit tab.
3. Select the Image Shift button.
4. Set the horizontal and vertical shift values.
5. Make any other adjustments to the print job.
6. Click Print.

Rotating the Image

You may be faced with situations where you need to rotate the original image before
it is printed on the output page.

To manually rotate the image

You can rotate an image from the Image Edit tab of the Job Manager. Select the
Rotation button and the rotation value.
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You might want to manually rotate the image when:

• copying a document that has damaged lead edges that experiences difficulty feeding
properly through the document feeder

• using some 3rd party finishing so that the finishing is applied correctly to the job
• using special stocks that can be loaded only in a certain way in the paper trays (for

example, tab stock can only be loaded with tabs trailing)

Automatic Image Rotation

The Xerox Nuvera automatically rotates the full page image, if necessary, to match the
orientation of the paper loaded in the paper trays. Thus, you do not have to manually
rotate originals or paper stock to get the correct orientation.

Printing your Document
You can print with the Xerox Nuvera in several ways:

• If you have a network you can submit a job to the Xerox Nuvera printer directly from
your desktop through your Internet browser.

• You can download drivers and print directly from your desktop applications.
• You can also print from a data CD using the media drive on the Xerox Nuvera .

Depending on your system configuration, the Xerox Nuvera can offer many powerful
features for reproducing documents:

• Making a Booklet
• Adding Pages to a Document
• Using the Basic Finishing Module (BFM)
• Using the Multifunction Finisher (MFF)
• Using DFA Compliant Finishers through the DS3500/XPS
• Adjusting Image Quality for various original types (photos, halftones, text)
• Build and store online for printing on demand
• Printing an Image That Extends to the Edge of the Page

Your Xerox Nuvera functions as a network workgroup printer and, depending on the
system you have, a workgroup scanner.

Supported File Types

The following file types can be submitted to the printer from your PC or printed from
the media drive:

• PDF
• TIFF
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• ASCII
• PostScript
• PCL

Related Hints and Tips

Hint/Tip DescriptionSubtopic

If a job faults after moving it from one queue
to another, and the fault indicates something
to the effect that queue attributes are corrup-
ted, and that a restart is required, yet a restart
does not solve the problem, the cause is likely
that the job's paper size is in conflict with the
programming attributes of the queue. For ex-
ample, the job may contain paper sizes that
are not supported by the output destination
programmed in the queue.

Job fault after switching queues

FreeFlow Print Server will display the "queue
default paper size" for the paper size of jobs
sent from the PCL driver. The same will happen
for PS jobs sent using a custom paper size. The
job will print on the correct size paper in both
cases. This is just a display issue.

PCL driver and paper size

For very long jobs, the percent complete indic-
ator may not be correct. Use the Pages Printed
indicator to monitor job progress against the
known size of the job.

Percent complete indicator

If you want to Print To File a PS or PDF job with
DocuTech Emulation enabled, select a save type
of PDF. You will then be able to reprint the job
with DocuTech Emulation enabled and the job
will print as expected.

Print to File with DocuTech emulation

If you want to staple print a job that requires
two sizes of SEF stocks, and one of them is also
loaded LEF, program both the stocks that you
want to use with the same custom Type. When
sending the job, select the custom Type and
the job will use the correct paper and staple. If
you do not do this, the job will fault because it
will attempt to use LEF paper and won't be able
to staple.

Staple print with two stock sizes

When submitting a landscape job that contains
tabs running across the top, enable the 180
rotate option to get the proper orientation of
the image on the tabs.

Tab job landscape with tabs at top
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Hint/Tip DescriptionSubtopic

For MFF configurations only: When running a
tab job with pre-drilled paper for the main body
pages, the pre-drilled paper must be loaded
with the holes leading, which is opposite of
what the label on the tray indicates.

Tab job with drilled paper (MFF configs. only)

When printing a job, if it runs out of paper, do
not restart/shutdown the machine. If you do,
the job may resume on the wrong orientation
paper. Example: If your job was printing on
Letter LEF and ran out, the system was restar-
ted, the job may resume printing on Letter SEF.
As a work around, disable any trays of the
wrong orientation before the restart/shutdown
or fill the correct tray before the restart/power
up completes.

When paper runs out, do not restart or shut
down

If you want to print a job from the Print From
File Service and use the Sample Print feature,
submit the job to the Hold queue, open the job,
and select Sample Print from the Job Properties
window. You could also add Sample Print to a
queue as an override. Sample Print is not avail-
able for selection from the Print From File
screens.

Sample Print

Printing from the Media Drive

One way to submit a print job is to load the file into the system from a data CD or DVD.
Once the file to be printed is loaded in the Xerox Nuvera , it can be programmed for
output and printed immediately, or it can be saved for printing at a later time.

Use only high quality CD/DVD-R media to store jobs and make configuration back-ups.
"Bargain" CD/DVD-R media can be problematic and adversely affect the ability to store
and retrieve information. This also applies to CD/DVD-RW media.

To print from the media drive
1. Open the media drive door, located in the bottom center of the main tower.

For details about the media drive, see Media Drive Specifications.

2. Insert the data CD or DVD into the media drive on the Xerox Nuvera .
3. At the Xerox Nuvera user interface, click the Print From File button.
4. Select the Files tab and click Browse.

This launches the Browse window.
5. Choose [CD-RW0] from the Look In drop-down menu.
6. Double-click the file you want to print from the Name list and click [OK].
7. The print file is now available for programming throughout the user interface.
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Extra pages can be inserted, and/or finishing options can be programmed. See Adding
Pages to a Document.

8. Select System > Eject CD.

Note
Do not eject the CD before printing is complete.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

Use of CD-RW media can cause read problems
when written on one drive and read from anoth-
er.

CD-RW media

Description: The DVD/CD RW drive is fully
functional. However, FreeFlow Print Server only
writes to the CD for CFA logs and backup/re-
store.
Workaround: FreeFlow Print Server allows users
to back up and restore in a DVD format.

DVD/CD media selection

Setting up a Print Job

The Xerox Nuvera offers a wide array of features to support your workflow needs. You
can make a print using the default settings in either a client-based printer driver, or on
the tabbed user interface. Or, you can use either of those methods to make changes to
your document.

Explore the links at the left to learn more about ways to submit print jobs.

To set up a basic print job
1. Submit a print job to the system using one of the methods (see the "Print My

Document" links at left).

• To input hard copy originals, use Copy Services.
• To print jobs located on media or a local or network drive, select Print from File

Service and select the job from the Files tab.
• To print jobs from the Job Manager queue, select Job Manager.

2. Adjust the job properties under each tab.

• Editing Images
• Resize the images
• Adjust image quality
• Setup slip sheets and special pages
• Create booklets
• Print Pads
• Set MFF finishing options
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• Set BFM finishing options
• Set 3rd Party finishing options

3. From the Paper Stock pull-down menu on the Basic tab, choose paper to print on.

• Auto Paper Select- system selects the paper stock to use
• Loaded Stock - you make a selection from the loaded stock list
• Stock List - you make a selection from the stock list
• Custom - you program a custom stock

Note
If your job is in Job Manager, select the stock from Loaded Stock or Stock List under
the Stock tab in the Job Properties window.

Note
Choosing paper is not done on a "by tray" basis. For trays 1 and 2, if the same paper
is loaded in both trays and tray 1 has a higher priority (a lower number), then it will
feed from the highest priority tray.
Additionally, if you loaded 8.5 x 11 inch paper in 2 trays (1 LEF and 1 SEF), you will
see one choice for this paper, and 2 orientations to choose from in the Loaded Stock
user interface.

4. From the Basic tab you can also reduce or enlarge the size of the image to print,
lighten or darken the copy or print, specify the output quantity, collate the pages,
and specify finishing options.
Refer to the FreeFlow Print Server online Help for a detailed description of these
selections.

5. To save a copy job, use the Advanced tab and identify the save location and file
format of the copy job for printing later.

6. Select the Output tab to identify the finishing options, output location and output
order of the job. Use the Stapling/Finishing pull-down menu to select the finisher
available on the system. The finishing options available depend on the configuration
of your system.

Note
Conflicts for envelope jobs with finishing selected are not defined or implemented.
Applying finishing options such as stapling and folding to envelopes is not
recommended. The system, however, does not prevent programming finishing to
envelopes.

• If no finishing devices are installed, the default setting is none.
• If your system is installed with a BFM, you can select single or dual stapling.
• If your system is installed with a MFF, you can select stapling, hole punching,

folding or multiple finishing.
• If your system is installed with a 3rd party finisher, first make sure System

Specified is selected from the Output Location pull-down menu. Select External
from the Stapling/Finishing pull-down menu. A list of DFA-compliant profiles
display that represent the production finishers available. Move the cursor on top
of the icon to select the profile enabled with your system.
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Note
All DFA finishing profiles available on the system will display. If you send the job to
a finisher that is not enabled, the job faults to the inactive job queue in Job Manager.
Contact your System Administrator to enable or disable DFA finishing profiles.

Note
When printing to a DFA-compliant 3rd party finisher, do not select Bypass Transport
as the output location.

7. To improve the image quality of a document, select the Image Quality tab.
Refer to Adjusting Image Quality for more information.

8. To rotate, edge erase, resize the output image, select the Image Edit tab.
Refer to Editing Images for more information.

9. To insert covers and other pages, select the Special Pages tab.
Refer to special pages for more information.

10. Load paper trays with appropriate stock(s) and adjust tray programming if necessary.
11. If in Copy Services, click Copy. If in Print from File Services, click Print.

Batch Printing

You can print files in batches by choosing a folder on the hard drive, on a CD/DVD, or
from the network (by selecting Windows Network (SMB)), and print all the documents
in the folder and subfolders. All the documents can be printed in one batch. The folder
may contain FreeFlow Print Server saved jobs or other documents in print-ready formats
(single-page TIFF, multi-page TIFF, and PDF).

To print multiple files or all the files in a subdirectory, all the jobs must have the same
stock programming. All the jobs will also print through the same queue, so all the job
parameters will be the same. To facilitate batch printing, organize jobs with the same
job programming within folders.
1. In the Print from File window, select Browse.
2. In the Browse window, select one of the following icons to open the Batch Print

window:

• Batch Files
• Batch Files including Subdirectories

3. In the Batch Print window, print all the files contained in the file or in the file including
its subfolders. You can order or delete files, and select single or multiple files to print.
The files will print in the order listed.

12-49Xerox® Nuvera®

User Guide and Training Aid (UGTA)

How Do I...



Using Preview to proof a print job

Preview provides a low resolution (75 dpi) preview so that you can review the job prior
to printing. An entire job or a select range of pages can be previewed. Preview allows
you to view the job, including composition and layout, and make changes before the
job is submitted for final print. The following job types can be viewed:

• PostScript
• PDF
• VIPP
• PCL
• ASCII
• TIFF

Note
The Preview feature is accessed through the Job Manager. For more information on
using Preview, see the online Help.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

The default decals for the Sheet Feeder Module
(SFM) are for machines with the MFF installed.
New feeders come with extra decals that are
to be used on machines with a BFM and/or
DS3500 installed. These decals describe the
proper orientation on how to load the different
types of media. Make sure the correct decals
are attached to the feeders. Referring to these
decals will also help you to correctly load the
lead edge of the stock in the SFM so it prints
correctly to the BFM. The decals for the MFF
configuration are different so make sure to use
the correct decals for your system.

Feeder decals
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Hint/Tip DescriptionSubtopic

The LED behavior on the Front door: The intent
is to provide to the customer feedback as to
which stacker is being used when 2 BFMs are
attached. The states are: Steady On: Stacker is
In Use Blink: Ready to Unload Steady Off: Not
in use LED State Change: By selecting the Un-
load button, the LED will change state. If it is
off, it will turn on for the duration that the
button is depressed. If it is on, it will turn off for
the duration that the button is depressed. This
request can occur when an unload is needed
prior to the BFM finishing a set or the machine
is cycled down due to being out of paper and
needs to finish the set before the unload re-
quest is honored.

Front door LED behavior

You do not need to press the Finisher Unload
Button to remove output from the finisher.
When you press the Finisher Unload Button,
the finisher cycles down. Press the Finisher Un-
load Button again to re-enable marking.
If landscape C-fold or Z-fold jobs printed from
print clients, or the SDDF LEF scan, are rotated
180 degrees, select 180 degree rotation from
the Advanced tab in Print Drivers at the PC ap-
plication or from the Image Edit tab, Image
Rotation, at the Copier/Printer user interface.
The PostScript Jog command, when used within
a job, does not perform as described in the
Adobe PostScript specifications. Changes to the
Jog value create subsets to which the job or
queue level finishing selections are applied. For
example, if a job specifies<</Jog 3>> set-
pagedevice on page 1 and <</Jog 0>>set-
pagedevice on page 5, then pages 1 through 4
will be finished as a unit and pages 5 through
the end of the job will be finished as a separate
unit. This is the same behavior as other Xerox
production printers, such as the DocuTech 6180.
On a MFF system, if you are Dual stapling
mixed sizes (that are a mix of LEF and SEF)
from the Copy pathway, they will print and
staple correctly. However, if you also save the
job and reprint it later, the job will Fault. The
Print pathway currently can not handle Dual
stapling with mixed sizes.

MFF Pro and Pro Plus
Finisher Unload Button
C or Z fold jobs rotated 180 degrees
PostScript Jog command
Dual Stapling with Mixed Sizes

See also

For an overview of more sophisticated jobs and workflows, see Setting Up Complex Jobs.
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For details about advanced features, see Advanced Publishing Features.

Printing 2-Sided Pages

When submitting a print job from a client driver or the web-based interface, single or
two-sided printing can be specified at that time. However, there may be instances when
you'll need to override that programming from the actual Xerox Nuvera user interface.

For more information about submitting jobs from the desktop, see Printing a Job from
your Networked PC.

Basic workflow to change "Sides Imaged" programming at the user
interface
1. Submit a job to the Xerox Nuvera that includes "Sides Imaged" programming.
2. At the Xerox Nuvera user interface, locate the job by using the Job Manager service.
3. In the Job Manager, double-click a job to launch the Job Properties window.
4. Click the Output tab, then click on the Basic Settings button. Change Sides Imaged

programming, then make any other job programming changes, if any.
5. Click Print.

Printing a Job from your Networked PC

You can submit the following file types directly from your network-enabled desktop
computer, with either your Supported Browsers, or nearly any desktop application:

• PDF
• TIFF
• ASCII
• PostScript
• PCL

To submit a print job from your PC using a web browser
1. Determine the IP address of the Xerox Nuvera .

Consult your System Administrator.

2. Launch your web browser. Type the IP address in the browser's address bar.
3. After a few moments, the web-based user interface appears. Select Job Submission

to submit a print ready job from the browser.

To submit a print job directly from a networked PC application

This requires that you download and install the appropriate print drivers on your desktop
system. Ask your System Administrator to install the drivers from the CD that came with
the Xerox Nuvera . For more details on available drivers, see Print Drivers and Client
Support.
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Or

Download the appropriate driver from the Xerox website. Once you have downloaded
the driver, follow the screen instructions to install it, adding the Xerox Nuvera to your
list of available printers.

With the driver installed and the printer added to your list of available printers, you can
print directly from any desktop application.
1. Make any selections to configure your document for output.

The Print window appears
2. When you are satisfied with your settings, click <OK>.

Your document is sent to the Xerox Nuvera and printed.

To manage print jobs submitted from a networked PC

With the Xerox Nuvera in Pause mode, you can submit print jobs from a client workstation,
then retrieve them at the Xerox Nuvera , apply further job programming, and release
for final printing. Also, you can send jobs with the Hold option and the job will be held
in Job Manager, with no need to pause the printer. For details, see Managing Print Jobs.

Using Hot Folders from the Queue Manager

The Hot Folders feature on the FreeFlow Print Server user interface allows you to drag
and drop your print-ready jobs from your networked PC into a Hot Folder. The Hot Folder
places the job in a queue on the Xerox Nuvera System. Once the job is submitted to the
queue, it will automatically print at a specified time and then be deleted from the Hot
Folder.

Hot Folders are activated in Queue Manager. For more information on Queue Manager
and how to use the Hot Folders feature, see Working with Queues.

More information about printing from the desktop

Refer to the CentreWare Printer Driver Guide on the CentreWare Printer Driver CD in the
Customer Materials kit.

Print Drivers and Client Support

The Xerox Nuvera can accept jobs from a variety of print drivers and print clients over
a network.

Print Driver Support

The print drivers are available on the CentreWare Print Drivers CD located in the User
Guide and Documentation Kit shipped with each Xerox Nuvera System. The print drivers
can also be found on Xerox.com under the Support and Drivers section.

Xerox Custom Drivers

Xerox Custom Drivers provide full Xerox job programming including Special Pages.
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There are PostScript drivers available for both Windows and Mac OS x.

Additionally, there are PCL5e and PCL6 drivers available for the Windows platform only
(Not Mac).

Generic PPDs

The generic PPDs are supplied for use with third party print drivers and applications. The
programming ability via the PPDs is limited. They do not support job programming via
a Xerox job ticket like the custom drivers.

Print Client Support

The Xerox Nuvera is accessible over the network by entering the IP address of the Xerox
Nuvera System in the address line on a web browser. On the Xerox Nuvera's homepage,
there are two selections available. There is the lightweight Job Submission selection and
the fully featured Job Submissions Applet selection.

Job Submission

Selecting Job Submission displays the Xerox Web User Interface.

This light-weight job submission tool is used to submit print-ready files directly from a
web browser to the Xerox Nuvera system. It supports most of the job programming with
the exception of Special Pages.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

• To use Booklet Layout successfully, set the
body Paper Size to the size of the image.
Then turn Margins off in the Image Layout
Tab to prevent 98% scaling. Now go to the
Layout/Watermark tab and select Booklet
Layout. This will automatically select the 2-
sided printing for the job. Finally select the
paper size you would like the output printed
on in the Fit to New Paper Size list and then
print the job.

• You will not be able to use Booklet Layout
with an Encrypted or Password Protected
PDF using the print driver. To workaround
this, send the PDF directly to the FreeFlow
Print Server using one of the web print sub-
mission tools or LPR and hold it. At the
FreeFlow Print Server, program the Booklet
Layout option and release the job. The job
will print in booklet form.

Booklet Layout
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Hint/Tip DescriptionSubtopic

Follow the steps below to properly program
booklets created using Adobe Acrobat PDF files.
To create an 11x17 folded booklet out of
8.5x11 size originals from PDF files, program
the job for 8.5x11 paper, use Fit to new Paper
Size, and choose 11x17 as follows:
1. In the Nuvera Print Driver, select the

Paper/Output tab.
2. Set Paper Size to size of the job

(8.5x11).
3. Select booklet fold if it applies to your

job.
4. Select the Image Options tab.
5. Set the Margins to None.
6. Select the Layout/Watermark tab.
7. Set Page Layout to Booklet Layout.
8. Select Fit to New Paper Size and set

the output paper size to 11x17.

PDF Booklets

The only job programming settings that can be
applied to a background form are Imposition,
Annotation, and form programming. If you save
the form with other programming (such as im-
age shift and special pages), the Sample Back-
ground Form option will not produce output
that matches what you will see if you use the
form in an actual job.

Supported job programming

When printing a landscape document using the
PCL driver, select the opposite duplexing option
from the one you want. 2 Sided Print and 2
Sided Print, Flip on Short Edge are reversed.
This also breaks Booklet Layout for landscape
jobs. So to print a booklet using a landscape
job, send the job to the FreeFlow Print Server
and hold it. Program the Booklet Layout in the
job properties and release it.

Landscape duplex options reversed

The default behavior in the print drivers is to
impose a 4mm margin on all four edges and
some applications scale the output to fit within
that margin. This prevents image loss due to
edge cropping in the Print Engine. In some
cases, this may not be the desired behavior (for
example, when printing scanned images, or
when output scale is critical). If the default
margins are not desired, they can be suppressed
by choosing a Margins setting of "None" in the
Image Options tab in the print driver.

Suppressing default margins
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Hint/Tip DescriptionSubtopic

Nuvera drivers do not have the XCAP import
capability. The drivers must be manually con-
figured using the driver properties.

Nuvera drivers and XCAP import

Printer Default values for Plex and Collation do
not work correctly. When printing to a Produc-
tion system, set an override on the queue for
Plex and Collation, if you want these options
to be set to something other than 1 Sided and
Collated.

Printer Default values for Plex and Collation

A PCL job may be classified as ineligible if Re-
source-Based Scheduling is enabled, the job
requests a non-default paper size (e.g. legal),
and the printer default media (e.g. letter) is not
loaded. This is due to the fact that the sched-
uler cannot determine the paper sizes in the
driver's Page Description Language (PDL) so it
applies the queue default when scheduling the
job. Several possible workarounds include
manually releasing the job; turning off RBS
(select FIFO instead); printing using a PostScript
driver; or loading the default media in the
printer.
Similarly, a PCL job may be classified as in-
eligible if Resource-Based Scheduling is enabled,
the job requests a non-default paper size (e.g.
legal), and color (e.g., blue). This is again due
to the fact that the scheduler cannot determine
the paper sizes in the PDL so it applies the
queue default when scheduling the job. In this
case, the scheduler would be looking for blue
letter paper, instead of blue legal paper. Work-
arounds include manually releasing the job,
turning off RBS, or printing using a PostScript
driver.

PCL job classified as ineligible

When printing landscape images onto short
edge feed paper and, using the following stap-
ling or hole punch positions with the associated
driver, you will need to use the Rotate 180 op-
tion to get the staple/hole punches in the expec-
ted location.
PS Driver - Top Left
PCL Driver - Top Right, Bottom Right, Bottom
Left, 2 Staples Right, 2 Staples Left, Hole Punch
Right, and Hole Punch Left

Print drivers and stapling positions
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Hint/Tip DescriptionSubtopic

When printing a 2-sided, odd number of pages
job from CorelDRAW using the PCL driver, there
may be an extra blank image (page) added to
the end. This blank image will "print" on the
backside of the last page unless there is special
pages programming. If the job requires special
pages programming, use the Pages to Print
option and select 1 - Number of Pages for the
range to print the job without the extra blank
page at the end.

Printing from CorelDRAW with PCL driver

Printing a PDF from Adobe Reader using the
Windows 2000 PS drivers may take a while to
send. If the time it takes to submit the job is
too long, submit the PDF directly using the
WebUI or FreeFlow Print Manager.

Time to print a PDF

Managing Print Jobs

The Xerox Nuvera can be operated so that incoming jobs are held until an operator
retrieves them at the system and applies job programming before actually being sent
to print.

In a Xerox Nuvera system this workflow is usually handled by a queue, or a location on
the machine where jobs line up and wait for further processing by an operator. Systems
with the Productivity Pack license enabled, have more than one queue to set for different
job statuses. For those Xerox Nuvera systems that do not have the Productivity Pack
license enabled, there is only one queue and all jobs coming in simply pass through and
are processed and completed. However, you can manage print jobs in a manner
resembling a traditional hold queue by using the Do Not Release feature. Right-click on
the queue and select Do Not Release Jobs to prevent jobs from processing or to hold
jobs until each one is released to print.

This is a useful workflow to follow, as the browser and client driver offer only a subset
of the capabilities available at the actual system. Additionally, there may be occasions
when you'll want to hold jobs until a certain point in the workday; such as large jobs
that require more processing time and paper resources.

Note
Jobs that were sent to a Do Not Release queue and are pending job processing are
displayed in the Job Manager's Inactive job list with a Held By Queue job status. The
Inactive job list identifies jobs as either Ineligible, Held By User, Held By Operator, Held
By Queue and Faulted. Jobs in the Inactive job list can be sorted by Status for easier
identification and access of the Held jobs.

To manage multiple jobs submitted from a client
1. Place the Xerox Nuvera in Do Not Release Job status or create a Hold queue.
2. Any print jobs submitted to it will go into the Active Jobs list.
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3. From a client application, submit jobs to the Xerox Nuvera or submit jobs to a Hold
queue.

4. In Job Manager locate the job you just submitted to the system.
5. Right-click on each job and select Properties. Make any job programming choices.
6. When satisfied with your settings, select Print and if needed, select Release Jobs.

Basic job management controls

Following are basic descriptions of what you should expect when you apply a job
management control to a job. For more details on each system control, see the online
Help system at the Xerox Nuvera .

When / Why should I use this
control?

Effect on jobControl Name

You need to make many copies
of a job, but are unsure about
the job attributes you've selec-
ted. Once job is proofed, you
can release it to print from the
Inactive Jobs list.

Enables you to verify job pro-
gramming selections are cor-
rect by running one copy.

Proof

Use this control when a print
job has high priority.

Moves the job in front of all
other jobs in the print queue.

Print Now

To prevent unwanted jobs from
processing and to reclaim sys-
tem resources for other job
processing.

Halts active processing of the
job, prevents any new pro-
cessing of that job, and re-
claims any system resources
held by the job. Job is not ad-
ded to Completed Jobs list.

Note
When deleting a job, the sys-
tem completely removes the
chosen job from the system. As
a result, you will no longer have
access to the components of
the job, including job attrib-
utes, images, and other re-
sources. If you think you may
want to run the job at a later
time, choose Cancel instead.

Delete

To reclaim system resources
that had been processing the
job, allowing the next sched-
uled job to proceed.

Prevents any further processing
of that job until it is released
from a held state.

Note
When a job is released from
Hold, it will continue pro-
cessing, but do so starting at
the beginning of the job.

Hold
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All jobs that you needed to run
after holding the job have fin-
ished processing.

Reactivates held jobs, faulted
jobs, and pending jobs.

Note
When a job is released from
Hold, it will continue pro-
cessing, but do so starting at
the beginning of the job.

Release

To prevent unwanted jobs from
processing and to reclaim sys-
tem resources for other job
processing.

Halts active processing of the
job, prevents any new pro-
cessing of that job, and re-
claims any system resources
held by the job.

Cancel

There is more than one
pending job in the active jobs
list, and you need to begin
processing a job immediately.

Enables you to elevate the pos-
ition of a pending job or set of
jobs in the active jobs list.

Promote

When you need the flexibility
to move jobs between queues.

Enables you to move the job to
another queue.

Move

When you need to copy a job
while retaining the original job
and programming.

Enables you to copy a Saved
job to a CD or to copy Saved
jobs (set to retain PDL) listed
in the Completed tab to a
queue.

Copy

When you have sent jobs to the
system, not knowing it is down,
or the job queue is too long, or
any time you wish to divert
your job to another system.

Allows you to send jobs to a
different printer.

Forward

When you have sent jobs to the
system, and wish to verify
visually that a given job has
been correctly configured, is
centered on the page, has cor-
rect image quality adjustments
applied, etc. Refer to the online
Help system for details about
this user interface control.

Allows you to see a preview
image of the print job before
actual printing.

Preview and Preview Range

Printing with the Parallel RIP feature

The Xerox Nuvera 200/288 EA/MX Perfecting Production System includes page
independent Parallel RIP (PPR) as a standard feature used to improve image processing
performance and print speed, especially for complex documents.
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How the Parallel RIP process works

Parallel RIP works with page independent jobs that are compliant with Adobe Document
Structuring Conventions (DSC) 3.0, such as compliant PS, VIPP, and PDF.

When Parallel RIP is enabled from the Queue Manager, FreeFlow Print Server first
determines if the current job is eligible for Parallel RIP. If it is not eligible, the job is
processed on a single RIP, which may leave one or more of the remaining RIPs available
to process the next waiting job. If it is, FreeFlow Print Server splits jobs, or pages of a
single job, and distributes them to the separate RIP processes running on the two separate
CPUs. The maximum number of RIPs available depends on the number of processors
and the amount of memory on the FreeFlow Print Server. For instance, approximately
2 to 3 RIPs will run on one dual core CPU. If an optional upgrade performance kit is
installed with an additional dual core CPU, the system would then have four CPUs RIPping
data (5 RIPs will run on two dual core CPUs), increasing processing time and producing
faster RIP speeds.

Tip
To see the number of parallel RIPs configured on the system, select Setup  > System
Preferences > Job Processing tab.

Which Jobs work best

Parallel RIP is ideal for long jobs with many nonrepeating scanned images or digital
photographs such as text books, magazines, yearbooks and product manuals.

Parallel RIP supports data streams PS, PDF, and VIPP Database Mode. To take full
advantage of Parallel RIP performance for PostScript or PDF jobs, always enable Parallel
RIP at the printer queue and use DCS/Page Independence settings with Optimize for
Portability. For these types of PS and PDF jobs, you will see a 50% or more increase in
performance when compared to a printer queue without PPR set.

Note
You can use the PostScript print driver to create page independent PS jobs. In the
PostScript printer, select driver option Page Independence or Optimize for Portability
to produce page independent output. Do not set the driver option to Optimize for Speed,
which generally produces output that is not page independent and not suitable for
Parallel RIPping.

Jobs that are PCL, TIFF, ASCII, LCDS and IPDS will not benefit from Parallel RIP since
they are not page independent or DSC compliant data streams. Disable the PPR option
for this type of job. It is best that a suite of this type go to a standard queue.
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How to create a queue with Parallel RIP enabled
Note
It is recommended that you enable Parallel RIP at all times unless printing a VI job or
a job with multiple repeated objects. Before enabling Parallel RIP, turn off the
Administrative Pages option (banner, error and property pages) as this selection requires
special processing.

1. From Queue Manager, select New from the Queue pull-down menu.
2. Enter "Parallel" in the Queue Name text box.
3. On the Settings tab, select Raster Image Processor.
4. Select Enable as the Parallel RIP setting.
5. Select Add Queue and Close.
6. Select Setup > System Preferences and the Job Processing tab.

The Allocated spin box shows the number of RIPs that will be used for queues with
Parallel RIP enabled. You can set the number of active RIPs, however, FreeFlow Print
Server software automatically determines the optimal use of available processors
depending upon the platform resources and the job flow. The best overall productivity
is gained when the Allocated RIPs number is left at the recommended default setting.

7. Using the Parallel queue, print the job.

Note
: The number of Allocated RIPs should match the Recommended number of RIPs,
unless directed otherwise by a Xerox Support representative.

For an overview of more sophisticated jobs and work flows, see Setup Complex Jobs.

Reprinting a Saved Job

A job submitted to a save queue is transformed to a PDF, Single-Page TIFF or a Multi-Page
Tiff.

To reprint a saved job
Note
If Retain PDL File is active, a completed copy job will be listed under the Job Manager:
Completed tab. This allows you to resubmit the job for printing, changing job properties
if needed.

1. Select Job manager and the Saved tab or select [Print from File].
2. Select Browse to locate the job on the Save directory on your system, a CD or

networked server save directory.
3. Select the folder that contains the saved job.
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Note
Verify the correct Save Location by checking with the System Administrator or by
viewing the Save Location in the Save Preferences. In some cases, additional Save
directories are created to save specific jobs by user, by department, or by another
categorization.

4. In the Browse window, or under the Saved Jobs tab, is a listing of saved jobs. You can
filter the list of jobs by selecting a specific file type in the File Filter pull-down menu.
The available choices may include:

• Job Ticket
• PostScript
• PCL
• TIFF
• ASCII
• PDF
• IPDS
• PPML
• All

Note
The default viewing is by Job Ticket because this is the file that retains all previous
job selections. Selecting other file types does not give you the entire job. For example,
if you select a TIFF file type, the system prints out only the TIFF image.

5. To change the job properties double-click on a job to open the job properties window.
6. Set job properties.
7. Select Print.

Printing Directly From a Mainframe Computer with LCDS

Line Conditioned Data Stream (LCDS) is a mainframe to printer, Page Description
Language (PDL) which uses referenced (stored on the system) and datastream-embedded
commands to control the processing of print jobs submitted from mainframe computers.

The Xerox LCDS approach to printing dramatically reduces bandwidth requirements by
locating the final assembly of document elements on the printer where resources are
stored. This eliminates the need for repeatedly sending complex elements like forms
from the host as part of a fully formed data stream. It reduces the need for sending
these high bandwidth items for each job by permanently placing them on the printer
so they do not need to be sent for each job.

The system only needs to send the truly variable data to the printer. Even values that
can be derived like the sum of a column of numbers can be computed on the printer so
that data transfer is minimized. This capability is unique in the industry and shows one
reason why the LCDS data stream is selected by customers that need to minimize data
bandwidth requirements in complex distributed systems.
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LCDS printers offer the ability to control the format of the final product, the printed
page, from outside the application generating the variable data. This separation of
function between the data generating application and the printer has always been a
common practice in the high performance range of computer printers. The data may
be in its proper position but post processing steps between the application and the
printer produces the final page appearance. The simplest way to visualize this type of
printing is to think of preprinted forms where the printer prints variable information into
blank areas of the form.

LCDS resources can be loaded via tape, CD, USB, or over the network. A floppy drive is
not avaiable.

Note
When using the LCDS application, the Xerox Nuvera System will not retrieve paper from
the Insertion Module.

Note
Edge marking is not supported.

Enabling LCDS Printing: Overview

To use LCDS printing, the Operator or System Administrator needs to make sure that
the following conditions are met:

• the Productivity Pack license must be installed and enabled.
• the LCDS license must be installed and enabled.
• files containing the appropriate processing commands (see the "forms" analogy

above) have been loaded on the system
• supporting resources (such as forms and fonts) are installed on the system
• the correct license is installed on the system
• one specific queue has been created and dedicated on the system to process LCDS

(streaming) jobs

The selection and setting of additional queue parameters, available under the various
tabs of the Queue Properties... dialog, in association with the resources installed on the
system under LCDS Resources, determines how LCDS jobs are processed at the printer.

For more information about queues, see Working with Queues.

Verifying the presence of the LCDS and the Productivity Pack Licenses

To print LCDS jobs, you must verify that the LCDS license is installed and enabled on
the system. You must also have the Productivity Pack license enabled for the stock library
to be available as well as all valid halftone screens.
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Viewing LCDS Resources
To support LCDS, files containing the appropriate processing commands and supporting
resources (such as forms and fonts) must be installed on the system under LCDS
Resources. To view the currently-installed LCDS resources, perform the following steps:
1. Log on to the system by selecting Logon from the Logon menu.
2. Select Operator (or System Administrator) as the user from the User pull-down

menu.
3. Enter the Operator (or System Administrator) password and click <OK>.
4. Select Administration  > LCDS Resources.
5. When the LCDS Resources window opens, if not already selected, select System from

the Source pull-down menu.
6. A list of installed LCDS Resources will be displayed. Note the resource types displayed

under the Type category. FNT, for example, represents Font. FRM represents Form.
JDL represents Job Descriptor Library (a source file of compiled PDL commands).

7. To select the specific types of resources displayed in the LCDS Resources window,
click the Types... button which opens the System Resource Types dialog. After selecting
the desired resource types (by marking the checkboxes), click OK.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

Offset Recovery is not supported when a DFA
device is attached. There will be no offset on
the output to indicate where the fault had oc-
curred. It will only work when there is a BFM or
MFF attached.

Offset recovery

Only offset by job boundary or set boundary is
supported with the third party inline DFA finish-
ing devices. DFA devices do not support single
page offsetting specified within the LCDS job
or report. A single page job or report will be
offset.

Offset with DFA

Related Information

For further information about LCDS printing with the system, and for queue setup
information, refer to the LCDS Print documentation that is provided along with the LCDS
license software CD. See your System Administrator or Xerox Customer Representative
to obtain this documentation.

Using VIPP

The FreeFlow VI Interpreter (FF VII) is an optional software license installed on the
FreeFlow Print Server that you can enable to interpret the VIPP language (Variable-data
Intelligent PostScript Printware).
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Many Service Bureaus and Data Centers continue to print files written in Xerox's LCDS
(Line Conditioned Data Stream) language; a legacy from the days of mainframes and
pin-fed impact printers.

Many people are conducting their businesses and document production operations in
networked, PostScript-based environments. Given these divergent realities, this may be
the right time to convert LCDS-based documents to PostScript.

What is VIPP?

Xerox Variable Data Intelligent PostScript Printware (VIPP) is a powerful system of fully
compliant PostScript technologies for the production of personalized documents. The
FreeFlow VI Interpreter refers to the software used to interpret the VIPP commands.
VIPP is used to discuss anything related to the VIPP commands or VIPP based
applications.VIPP consists of a set of macros that reside on the PostScript interpreter,
eliminating many of the time-consuming steps associated with traditional variable
information workflows by enabling Dynamic Document Construction (DDC) at the printer.
By dynamically creating the document at the printer, VIPP dramatically decreases the
amount of time that it takes to compose and print documents.

Xerox VIPP is an open programming language that exploits the flexibility of PostScript
in constructing dynamic documents. Because VIPP has a powerful merge engine for
creating personalized business documents, it allows variable documents to be composed
at the printer in real time. It also facilitates the migration of LCDS-based files to a
networked, PostScript environment, resulting in documents that are easy to manipulate
and modernize, and that can be printed to a networked Xerox PostScript print device.

How it Works

VIPP uses the same "Dynamic Document Construction" concepts as the Xerox LCDS
printers. Fonts, forms, and images reside on the printer, and formatting is controlled by
a template (JDT) called by the job. The bit-heavy resources stored at the printer are
merged with the variable data at run-time. The result is an efficient printing model that
saves valuable network bandwidth. With VIPP-based documents, only the variable data
is sent over the network.

The VIPP Thin Printer (VTP) allows the generation of Adobe PDF documents from VIPP
based variable data applications. Capabilities include the ability to split PDF files into
individual PDF sets and add interactive features such as PDF Bookmarks, PDF Notes or
URLs. The VTP supports personalized printing and 1-to-1 marketing by extending output
printing capabilities to support production PDF creation that enables viewing, archiving
and Web presentations of variable-information documents.
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Programming options

A VIPP programmer can take advantage of control features that enable the creation of
VIPP jobs that emulate or enhance the original LCDS application without requiring
changes to the original data set. There are many features that can be added to modernize
the document without changing the source program or data file. These features include:

• rounded corners
• data-driven graphics
• reusable data elements
• multiple form layouts

Configuring the system to run a VIPP job

To support running VIPP jobs, refer to your System Administrator and the System
Administrator Guide. Also, for complete information about the FreeFlow VI Interpreter
and the VIPP language, consult the FreeFlow VIPP Language Reference Manual on the
FreeFlow VI Suite Documentation CD delivered in the VIPP ship kit.

Working With IPDS

IPDS is a printer device data stream (specific to IBM) that contains the information
necessary to identify, monitor, and control the functions of the printer. This information
includes the characteristics of the printer, its resolution, what resources it has, whether
it has sufficient memory, and whether it receives and prints a job.

IPDS enables a two-way dialog between the printer and the printer driver to create a
cooperative print management system. IPDS is device dependent and is unique for each
printer.

Verifying the presence of the IPDS and the Productivity Pack Licenses

To print IPDS jobs, you must verify that the IPDS license is installed and enabled on the
system. You must also have the Productivity Pack license enabled for the stock library
to be available as well as all valid halfone screens.

Printing IPDS jobs
This is the general procedure for setting up the printer for printing an IPDS job. The
procedure assumes that the correct IPDS options have been entered using Set Option,
and that a virtual printer with appropriate attributes for the job, including a media list,
has been created. It also assumes that printing and queuing are started.
1. Enter Show IPDS Status so that you know the current system state and virtual printer

state.
2. Enter Set Channel Online, if needed.
3. Enter Set IPDS Virtual Printer, if needed.
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4. Load the required paper stock in the printer.
5. Set up the paper trays using Set Tray or Set Tray fromVirtual Printer Media.
6. Enter Start IPDS Printing, if needed.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

The following FreeFlow Print Server features
should not be applied to IPDS jobs: Job Forward-
ing, Save Jobs, Proof, Promote, Preview, Excep-
tion Pages, Covers, and Inserts.

FreeFlow Print Server features not supported

The Currently supported environments are Z/OS
(MVS) with PSF, OS400 with PSF, AIX with In-
foPrint Manager and Windows with InfoPrint
Manager. In addition, the Emtex VIP Front End
Processor (FEP) is supported, but only for
monochrome or highlight color data, at this
time. Some other environments or FEPs may
work successfully, but interoperability cannot
be guaranteed.

Environments supported

Image shift affects banners as well as applica-
tion. IPDS host banners are not distinguished
from other application pages.
Avoidance: Although they do not affect Free-
Flow Print Server banners, queue and job based
Image Shift and Alignment values apply to host
banners, just as they do to other application
pages. If host banners are shifted to an inap-
propriate position, but other application data
is printing correctly, revise the host application
so that both application data and banners can
be positioned correctly on FreeFlow Print Server
without an added image shift or alignment
value.

Image shift affects banners

DocuPrint IPS 7.x Input Groups and 8.x Virtual
Printer Media Lists cannot be imported into
FreeFlow Print Server IPDS. FreeFlow Print
Server IPDS Job Setups must be recreated.

Importing

IOCA Tile objects which don’t contain an IOCA
image do not work reliably.
User Action: Avoid using above feature.

IOCA Tile objects
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Hint/Tip DescriptionSubtopic

Printer Tray values IPS Manager Printer Tray
values are not intended for editing.
Avoidance: Do not attempt to edit values in the
'Printer Trays' column of the IPS Manager,
'Tray/Bin Mappings' tab. Characters input into
this column, though allowed by the GUI, have
no effect on system operation, and will NOT be
registered by the IPS Manager. This field is in-
tended for read-only use.

IPS Manager

N-1 job hangs if greater than IPDS throttling
160-page limit.
User Action: Restart IPDS Gateway from the
IPS Manager GUI.
Avoidance: Select Print Job Unfinished (vs. Fault
Job) for Overlimit Finishing or print 1-N when
feasible. If N-1 printing and faulting over limit
jobs is required, set the maximum set size for
the finishing device to at least the size of the
largest jobs or sets that will be handled. Doing
so forces the throttling limit to twice the max-
imum set size and ensures that throttling will
not cause a deadlock.

N-1 job hangs

Only Offset at job or set boundary is supported
with the third party inline DFA finishing devices.
DFA devices do not support single page offset-
ting specified within the IPDS job or set. Single
page job or set will be offset.

Offset and DFA

IPDS jobs cannot be processed 1-N with N-1
finishing in Nuvera.
User Action: Resubmit the job after setting the
finishing equipment for 1-N, if possible.
Avoidance: Set both queue and finishing for
the same output order. If it is necessary to use
N-1 for the finisher, send individual sets as
separate jobs, to ensure that the source job will
not exceed the length of the IPDS throttling
limit.

Output order
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Hint/Tip DescriptionSubtopic

Output Reposition is not supported for IPDS
jobs. As with Sample current job, this feature
would also cause incorrect page counts to be
reported to the host. However, host operator
commands can be used for forward and back-
ward space within a job.
In the IPDS environment, the host operator is
expected to effect repositioning commands
from the host platform (for example, JES2 $f
and $b commands for forward and backward
spacing respectively). The FreeFlow Print Server
IPDS implementation manages this reposition-
ing on the basis of the current set of IPDS
counters returned by the printer. Do not use the
FreeFlow Print Server Reposition Output dialog
with IPDS jobs.

Output Reposition not supported

The pause feature should not be used with IPDS
as a way to continue RIPping while deferring
printing. It is not feasible to RIP a large print
run ahead of printing for IPDS, since throttling
will limit the number of committed sheets in
excess of the number of stacked sheets.

Pause feature

Specific printer status problems are not de-
scribed with Intervention Required messages.
Only a generic message is sent.
User Action: Operator should ensure that their
management process for this system does not
depend on the printer providing a specific de-
scription of what is wrong (e.g. Check the
printer for the specific problem vs. relying on
the host message.)

Printer status messages

The IPS Manager is not automatically informed
when physical tray contents are changed at the
FreeFlow Print Server. Instead, you must use
the Refresh mechanism provided by the IPDS
Tray/Bin Mappings dialog to display the latest
mapping information.

Refresh to update mappings

FreeFlow Print Server Remote Workflow (DRW)
does not support the IPS Manager.

Remote Workflow

12-69Xerox® Nuvera®

User Guide and Training Aid (UGTA)

How Do I...



Hint/Tip DescriptionSubtopic

Sample current job is not supported for IPDS
jobs. The IPDS host presumes full control over
the jobs output, and this feature would cause
incorrect page counts to be reported to the
host. The FreeFlow Print Server GUI currently
only supports this capability at the Printer
Manager level, and is not able to set this capab-
ility for individual jobs or queues. Therefore, the
FreeFlow Print Server GUI does not prevent se-
lecting Sample Current Job. However, the re-
quest will not be honored for an IPDS job, and
no warning message will be provided.

Sample Current Job not supported

Performance may be slow for jobs requiring
large amounts of image data, especially when
printing at 600 dpi.
User Action: Schedule extra print time for jobs
that require many large images, or reduce the
size and number of images required for an ap-
plication.

Slow performance

Spooling mode is not supported for IPDS jobs.
Ensure IPDS queues are set up for Streaming
input.

Spooling mode not supported

Working with Queues
A printer queue is a list of print jobs that await an available printer, need further
programming, or are being held by an operator for some reason.

Note
Xerox Nuvera systems that do not have the Productivity Pack license enabled have one
queue only. Once you set the properties for this queue using the Printer Defaults selection
from the System menu, all jobs coming in simply pass through and are processed and
completed. If your system has the Productivity Pack license installed and enabled, the
system offers multiple queues.

Three queues are pre-installed on Xerox Nuvera systems with the Productivity Pack
license enabled:

• HostName_Print - Jobs submitted to this queue are automatically printed
• HostName_Save - Jobs submitted to this queue are saved in the Save directory
• HostName_Hold - default setting release=No. Jobs submitted to this queue are held

until manually set to release.

In the Xerox Nuvera user interface, Queue Manager is used to create numerous internal
printer queues that can be used to control the flow or handling of documents in different
ways.
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For example, you can configure one queue as a hold queue, where incoming jobs are
saved to a locally designated directory. This is useful when submitting jobs remotely,
where the client submission tool may not include all programming options, or the
submitter may not know exactly which types of paper stocks are available at the system.
Jobs submitted to the Hold queue can be programmed directly at the Xerox Nuvera user
interface for final output. Queues can also be set up to allow print jobs to print
immediately.

For example, your work environment has 3 types of print jobs:

• Jobs submitted remotely. Set up a print queue to save received jobs to a specific
location, to be retrieved and programmed further at a later time

• Jobs with little or no job programming required. Set up another print queue to print
jobs immediately

• Jobs that need a large amount of special programming, including insertion of special
pages, covers, etc. You could send them to the same queue used for jobs submitted
remotely, or you could set up a discrete queue for jobs that require special stock
programming. This way, you can do all jobs that require paper tray loading all at
once

To add a new queue on systems with the Productivity Pack license
enabled
1. In the Xerox Nuvera user interface, select the Queue Manager button.
2. Select the Queue pull-down list.
3. Select New. The New Queue dialog displays,
4. In the Queue Name field, enter a name of up to 25 characters. The name can consist

of letters, numbers, and underscores.
5. Select a quantity between 1 and 65,500 to indicate the default number of job sets

to be printed for all jobs sent to this queue, unless otherwise specified in the job itself.
6. Set a priority between 1 (highest priority) and 100 (lowest priority) for the queue.
7. Select the input format to indicate the manner in which jobs will be submitted to the

queue.
8. Select a destination of either Print, Save, or Print and Save.

Print releases the document immediately for printing. Save saves the document to
the location designated in Save Location.

9. If desired, add a banner page message or job comments.
10. Make extended option selections from the Stock, Output, Image Quality, Image Edit,

and PDL Settings tabs.
11. Select decomposer (RIP) options on either the PostScript/PDF, Advanced PostScript,

TIFF, PCL, ASCII, or LCDS buttons.
12. Select Add Queue to complete the new queue.
13. Select Close to exit the New Queue dialog.
14. In the Queue list, right-click the new queue and choose Accept Jobs to enable the

queue.
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To view or modify queue properties with the Productivity Pack
license enabled
1. In the Xerox Nuvera user interface, click the Queue Manager button.
2. Select a queue and double-click to open Queue Properties.
3. Modify queue settings as desired, then click OK to have your changes enabled by the

system.

To view or modify queue properties of a single queue (Productivity
Pack license not enabled)
1. In the Xerox Nuvera user interface, select the System menu.
2. Select Printer  > Defaults to open Queue Properties.
3. Modify queue settings as desired, then click OK to have your changes enabled by the

system.

To copy a queue with the Productivity Pack license enabled
1. In the Xerox Nuvera user interface, click the Queue Manager button.
2. Right-click on a queue.
3. Select Copy. Rename the queue and set new queue properties.
4. Select Copy Queue.
5. Select Close.

The new queue is created.

Note
Override Feature. Many options in the Queue Manager dialogs contain an override
setting. Select Override only if you want the queue settings to take precedence over any
attributes programmed with individual jobs. This setting may be useful for jobs being
submitted by remote users who may not be familiar with the system configuration.

Using Parallel RIP (on the Xerox Nuvera 200/288 EA/MX Perfecting
Production System)

The FreeFlow Print Server Parallel RIP feature, previously available only on color products,
is provided on the Xerox Nuvera 200/288 EA/MX Perfecting Production System. Access
this feature from the Queue Manager to improve print speeds especially on complex
jobs. For more information on Parallel RIP, refer to Printing with the Parallel RIP feature

Locking/Unlocking a queue

A System Administrator can lock queues so that the queue properties can not be changed
until the queue is unlocked by a System Administrator. Right-click on a queue and select
Lock or Unlock.
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When and how to use Hot Folders

Hot Folders is a job flow productivity option that is mounted, enabled and disabled on
your networked PC by the System Administrator. Use this feature to help organize your
print jobs and better manage the flow of these jobs from your PC to the printer. You
can create a Hot Folder for specific types of jobs or for selected users.

When the Hot Folders feature is enabled, the Xerox Nuvera automatically performs all
network configurations and exports the Hot Folder to the network so it is visible to all
users. You can then quickly and easily submit print-ready jobs by dragging and dropping
them from your networked PC into the Hot Folder on the network server. The jobs are
submitted to a specific queue in FreeFlow Print Server.

Once the job is submitted to the queue, it is printed at a specified polling time and then
automatically deleted from the Hot Folder.

To activate and create Hot Folders for a given queue:
1. Log on as a System Administrator.
2. If your system has the Productivity Pack license enabled, select Queue Manager and

create a specific queue if needed.
3. Right-click on the queue in which you want to activate a Hot Folder and select Hot

Folder  > Enable Hot Folder.
4. If your system does not have the Productivity Pack license enabled, select the System

menu and Enable Hot Folder.
The Hot Folder associated with this queue is created on the network. A Hot Folder
icon appears next to the queue name.

5. In the client's browser, enter \\ IP Address of the FreeFlow Print Server.
A window opens showing all available Hot Folders on the FreeFlow Print Server.

6. Drag and drop the print ready files from your desktop into the Hot Folder.
The files print automatically in FIFO order.

7. To disable the Hot Folders feature, right-click on the queue and select Hot Folder  >
Disable Hot Folder. Or select Disable Hot Folder from the System menu.
FreeFlow Print Server removes the Hot Folder from the network.

To set or change the Hot Folder polling time:
The Hot Folder feature is set to look for jobs on the network and submit them to the
FreeFlow Print Server at a specified time. This time interval can be changed or set from
a minimum of 5 seconds up to a maximum of 10,000 seconds. If you are submitting
large jobs, or if the network is slow, set the time to check for new jobs at a longer time
interval.
1. Select Setup  > System Preferences.
2. Select the Job Processing tab.
3. In the Hot Folders area, in the Polling Time box, enter, in seconds, the time interval

desired before checking for new jobs.
4. Restart the FreeFlow Print Server to have this change to the Hot Folder take effect.

12-73Xerox® Nuvera®

User Guide and Training Aid (UGTA)

How Do I...



Job Definition Format Print Submission via Hot Folders

Job Definition Format (JDF) is a job ticket and workflow specification language used by
production printers. JDF tickets with PDF data files add flexibility for job submissions
when you need specific settings for jobs instead of default queue settings. When a job
is added to a Hot Folder, the FreeFlow Print Server determines if the file has a JDF job
ticket. If it does have a JDF job ticket, the job is processed according to the ticket. It
then reports the job status information and the process times, which can be used by an
MIS system for job costing and system utilization tracking.

Scanning your Document
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Scan To File allows you to turn your original documents into:

• Single Page TIFFs
• Multi-Page Tiffs
• PDF

to be stored on removable media, the local drive, or network destination. Scan To File
allows users to create digital images with input programming for distribution, archival
or modification (image save). This differs from the copy save service, which allows users
to create digital copies of jobs with output settings for reprint at a later time.

Once your original paper document has been converted to an electronic document you
can change, manage, share and distribute the document using a wide variety of software
applications.

To learn more about these capabilities, explore the links at left.

Setting up a Scan Job
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Setting up a Scan job is essentially the same as Copying your Document. The difference
being that you can save a Scan job as a digital file, rather than just getting a hardcopy
output.
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To setup a scan job
1. Place the original document on theDocuemtn Glass or Document Feeder (see Using

the Document Feeder).
2. In the Xerox Nuvera user interface, select the Scan To File button.
3. In the Job Name entry box, type in a name for the scan job.
4. In the Save Location entry box, type in the location (if known) in which to save the

scanned file, or click the Save Location... button and use the directory window to
browse to a desired destination.

Note
If your system is connected to a network, and a directory has been created on the
network, that network directory will be available for use in the Save Location menu.
See your System Administrator to set up a network directory for scanned images.

5. Make programming selections on any or all of the tabs:

• Basic
• Image Quality
• Image Edit

6. Choose how you want your scanned image to be handled by the system--either as a
PDF, TIFF, or proprietary format which retains all of your job settings.
For details on file formats, see Choosing a Scan File Format.

7. When satisfied with your settings, click Scan.

Note
If your original document is part of a larger set of documents, you can use the Build Job
functionality to scan the entire set. For more information, see Using Build Job.

Scan to File to a USB thumb drive
1. One-time setup: Go to System Preferences, Save tab and set the default Save Location

to the root directory.
2. Insert the thumb drive into an available USB port.
3. Under Scan to File, select the Save Location button.
4. Select Unix File System from the drop down list.
5. Navigate to the directory then to the subdirectory named for the USB device.
6. Click OK and then scan the job.

Choosing a Scan File Format
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.
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The file formats (Printer Description Languages, or PDLs) available to save in--PDF
(Portable Document Format) and TIFF (Tagged Image File Format) -- give you the ability
to optimize your files for print or for online viewing.

Reasons for saving your scanned document as TIFF:

Save your document as TIFF if it is to become part of a print document. Additionally, if
saved as a TIFF, it is immediately available for printing through the Xerox Nuvera .

• Ability to convert to a different format (in an external application, i.e., PhotoShop)
later

• Ability to further manipulate the image in virtually any bitmap editor (i.e., PhotoShop),
such as scale, resize, etc... without any detriment to image quality

Reasons for saving your scanned document as PDF:

Save your document as PDF if it will be distributed through the internet; either by email
or through a web server. Choose PDF if you are certain there will be no further need to
adjust the image. If saved as a PDF, it is immediately available for printing through the
Xerox Nuvera .

• PDF--a bitmapped format--is essentially a "snapshot" of your document. Size of the
document, formatting, etc... are all certain to be retained in this format

• PDF can be launched with the free Reader application from Adobe, the ability to
share your documents across the Internet, on disparate platforms, is possible

Note
If your original document is part of a larger set of documents, you can use the Build Job
functionality to scan the entire set. For more information, see Using Build Job.

Setting Scan to File Image Resolution
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Image resolution deals with the amount of data, or pixels used when scanning an image.
The higher the image resolution, the better the image looks. However, depending on
where the image will ultimately be used, you may not need a high resolution image. For
example, if an image will only be viewed on the web, you won't need an image that's
1200 x 1200 pixels. The following will provide guidelines on image resolutions appropriate
for various delivery styles.

To set image resolution
1. In the Xerox Nuvera user interface, click Scan To File.
2. Select the Basic tab (default tab chosen after clicking Scan To File).
3. Click the Resolution pull-down menu.
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4. Determine final output of image. See example guidelines below:

• Choose 1200 dpi, if image is composed mostly of text and/or line art, and final
output is print.

• Choose 600 dpi, if image is composed mostly of photographic or halftoned
pictures, and final output is print.

• Choose 400 dpi, if image is composed mostly of text and/or line art, and final
output is the web or internet.

• Choose 300 dpi, if image is composed mostly of photographic or halftoned
pictures, and final output is the web or internet.

Note
These are only suggested settings.

5. Make any other programming choices.
6. When you are satisfied with your settings, click Scan.

Scan to File Resolution

Remote copy is the use of Scan to File for the purpose of reprinting on another Xerox
Nuvera system.

A local copy is created using the Copy function on the Xerox Nuvera. The local copy is
equivalent to 1200 x 600 dpi scan (chosen for very high productivity with competitive
image quality). Because 1200 x 600 dpi is an asymmetric image which is not conducive
to integration into make ready applications, the 1200 x 600 option is not provided for
Scan to File. For particularly stressful documents, local copy will generally be better than
the remote copy.

The Scan to File selection between 600 x 600 dpi and 1200 x1200 dpi is a document
dependent one. It is dependent on productivity, archival file size and image quality
requirements. Because the coarseness of the error diffusion (diffusion dither) varies
between the two resolutions, the user is encouraged to try both and evaluate pictorial
and business graphic areas for digital grain and text for sharpness. Chose the resolution
best suited for your application. Generally 600 x 600 dpi image quality is preferred for
pictorials and 1200 x 1200 dpi for text. The preference will also vary depending upon
which mode (text, mixed text and graphics, mixed text and photos) is used.

Remember, documents scanned with higher contrast and lighter (more background
washout), will compress better, improving productivity and storage.

For information on saving your scan jobs, see Saving and Storing Jobs.

Scanning a 2-sided Document
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

12-77Xerox® Nuvera®

User Guide and Training Aid (UGTA)

How Do I...



Some Xerox Nuvera systems include a document scanner with a full-featured document
handling system. This allows the user to rapidly scan large documents and two-sided
documents without requiring the user to re-load the original document tray.

To scan a 2-sided document
1. Place original document face-up in the Document Feeder.
2. In the Xerox Nuvera user interface, click the Scan to File button.
3. On the Basic tab, click the Sides Imaged drop-down menu.
4. Choose the two-sided icon.

5. Click Scan.

The scanner Document Feeder runs both sides of the original document over the
Document Glass, then returns the original document to the output tray.

Advanced Publishing Features
You can print with the Xerox Nuvera in several ways:

• With a networked-configured system, you can submit a job to the Xerox Nuvera
printer directly from your desktop through the internet browser.

• You can download drivers and print directly from your desktop applications.
• You can also print from a data cd using the media drive on the Xerox Nuvera .

The Xerox Nuvera gives you many publishing options for enhancing your document. To
learn more about these capabilities, explore the links at the left.

Using Build Job
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Build Job is used to combine multiple scans, each with different job programming, into
a single, compiled output. Specifically, Build Job allows you to scan many different types
of documents (either from the Document Feeder or the Document Glass) in separate
jobs, then combine those separate scan jobs into one cohesive output.

Build Job is used to
• Scan originals of different sizes that cannot be fed and scanned together
• Scan a collection of originals that require a mix of Document Feeder and Document

Glass scanning
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• Scan more originals than the Document Feeder can hold at one time (see Document
Feeder & Scanner Specifications)

• Apply different image quality or image modification features to different scan
segments

Note
Build job applies to any type of scan job and does NOT apply to print jobs.

Before using Build Job, there are two concepts to understand. See Understanding Job
and Segment Level Programming.

To use Build Job
1. In the Xerox Nuvera user interface, click Copy, then click the Build Job button at the

bottom left corner of the user interface.
The system is now in Build Job mode.

2. Place the first part of the document set (Job Segment 1) to be scanned in the
Document Feeder or on the Document Glass (see Using the Document Feeder.

Note
At this point, perform any Job Level programming, since Job Level programming
choices will be unavailable when scanning the remaining Job Segments.

3. Once Job Level programming is complete for Job Segment 1, press Continue. The
remainder of the tabs become enabled. Perform any Segment Level programming.

4. When satisfied with your settings, click Start.
Job Segment 1 begins scanning.

5. When Job Segment 1 finishes, load the second part of the document set (Job Segment
2) to be scanned in the Document Feeder or Document Glass.

6. Make any Segment Level programming.
Remember, Job Level programming is already set, so all Job Level controls will be
disabled.

7. When satisfied with your settings, click Start.
Job Segment 2 begins scanning.

8. Load the next Job Segment, and perform steps 6, 7, and 8 for the remaining segments.
9. To exit Build Job mode, click End Build Job.

The job prints according to all of the Segment and Job Level programming.

Understanding Job and Segment Level Programming
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

Job and Segment Level programming are used in conjunction with Build Job. This allows
you to control settings across an entire multi-segment scan job, as well as settings within
small segments of a multi-segment scan job.
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Job-Level Programming

Job level programming applies to the entire job. Job level settings are programmed
during the first segment to be scanned or copied, and are not available for programming
during the rest of the build job process. Examples of Job level settings are:

• Page Numbering
• Front Covers
• Annotation
• Stapling/Finishing
• Quantity
• Collation
• Back Covers

Note
Quantity is a job-level setting that can be changed during any subsequent segment-level
scans.

Segment-Level Programming

Segment level features apply to the specific original or segment of originals about to
be scanned. Examples of Segment level settings are:

• Paper Attributes
• Sides Imaged
• Image Quality
• Image Source, either Document Glass or Document Feeder
• Negative Image
• Mirror Image
• Image Shift

Now that you are familiar with Job Segment programming, you can continue to Using
Build Job.

Working with Job Tickets

Job tickets are groups of saved job settings. Saving job settings from previous jobs allows
the same user or a different user to quickly set up the machine to perform the same
actions. This is a tremendous time-saver when you have many original documents
requiring the same settings. Rather than trying to re-create your programming, or have
another user attempt to, rely on Job Tickets.

These settings could include:

• Number of pages
• Special Pages, such as covers, tabs, etc.
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• Image Quality settings
• Image Adjustments (re-sizing, centering, reduction/enlargement, etc.)
• Finishing options

Job Tickets can be submitted to the system from a remote client computer using the
FreeFlow Print Manager application. See the applicable documentation for generating
job tickets with FreeFlow.

Open a job ticket
Once a job has been submitted to the Xerox Nuvera and saved, it can be retrieved and
opened at a later time.
1. Select the Job Manager button, then choose Saved tab.

See Finding a Saved Job To Print.

2. Use the file type filter to find the job ticket.
3. Double-click or right-click the job ticket file you want to open and make any additional

programming choices.
4. When satisfied with your settings, click the Print button at the bottom of the window.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

Selecting Cancel from FreeFlow Print Manager,
while a job is being submitted to the system,
does not completely cancel the job. The work-
around is Delete the canceled job at the printer,
which appears in the Completed Jobs list as
completed with errors.

FreeFlow Print Manager and canceling job
submission

Hint to avoid confusion when using the Free-
Flow Print Manager application to specify job
ticket attributes for custom stock. The work-
around is from FreeFlow Print Manager, when
you are adding a custom stock, you should
connect to the target printer and in Job Setup,
use the Stock pull down menu (rather than the
"Stocks..." button) and select "New." The win-
dow will limit the selection of the stock attrib-
utes to those that are settable for the connec-
ted printer. You should be cautious when using
the "Stocks..." button to add new stock. When
using the "Stocks..." button, changes made to
non-applicable attributes will be ignored. This
printer only allows the following media attrib-
utes to be specified: Size, Type, Color, Weight.

FreeFlow Print Manager and job ticket attrib-
utes for custom stock
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Hint/Tip DescriptionSubtopic

When using FreeFlow Print Manager to program
a job with a media size for either of the size
names: Spanish (XE) or Foolscap (XE), the pull-
down menu for "Main Paper Stock" in Job Setup
will not contain these size names.
Workaround: When specifying Paper Type in
Job Setup of FreeFlow Print Manager or Inter-
net Services, the following media sizes do not
appear unless the paper is currently loaded in
one of the trays at the printer:

• Spanish (XE)
• Foolscap (XE)

To program one of these sizes, perform the
following:
1. Load the paper in one of the trays.
2. From the Main Paper Stock pull-down

menu, choose the Tray with the desired
paper stock, or from the Main Paper
Stock pull-down menu, select New.

3. If you select New, select a size of Cus-
tom (.in) from the New Stock menu.

4. Enter the appropriate dimensions for
width and height:

• Spanish (XE) - 8.46 x 12.4 in.
• Foolscap (XE) - 8.5 x 13.0 inches.

FreeFlow Print Manager and media size names

When programming custom stock size, if the
stock size programmed is out of range, the
warning message does not indicate the valid
stock size range. Workaround if possible, pro-
gram custom stock size at the Nuvera printer.

Programming custom stock size

Copying Document Sets with Mixed-Size Sheets
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

There may be instances where the document set you want to copy is made up of several
document sizes. The Document Feeder on the Xerox Nuvera can be programmed to
process document sets comprised of mixed-size originals.

For example, a user wants to compile different documents into one cohesive collection.
The set has 8.5 x 11 inch and 11 x 17 inch originals. The user can load those originals
into the Document Feeder with the 11 inch edge going into the Document Feeder first.
With Mixed Size Originals (MSO) selected, the system will process the document set.
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There are certain constraints when using this feature. See the sections below for details.

Note
The default setting for MSO is off. The MSO default can not be changed.

If Mixed Size Originals has NOT been selected:
• Some jobs and features may not work without selecting the Mixed Size Originals

feature.
• All output will be printed on the media the size of the largest original document.
• Images from the smaller originals will be placed in the upper left corner of the output

paper.

Note
If MSO is enabled, and you load a set of same size documents, the job will still process
with no errors or warnings.

When the Mixed Size Originals (MSO) feature IS selected:
• MSO and 1 to 2 Sides Imaged cannot be selected together.
• Reduce/Enlarge (R/E) must be set to 100%.
• Special Pages (Covers, Exception Programming, Inserts) can not be used.
• Signatures/Booklets can not be used.
• N-up can not be used.

To copy documents with mixed-size originals
1. Place the document set in the Document Feeder. The set must be arranged so that

the leading edges of all sheets are the same width.
2. In the Xerox Nuvera User Interface, click Copy, then click the Image Edit tab.
3. On the Image Edit tab, click the Original Size button.
4. Choose the Mixed Size Originals radio button.

Take note of the constraint on this control, regarding the original paper sizes it will
accept.

5. Click Close.

Saving and Storing Jobs

Jobs (copy, scan, and print) can be submitted and programmed to be placed in a Saved
Jobs directory on the Xerox Nuvera user interface (FreeFlow Print Server). Once saved,
they can be reprinted at any time.
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Note
If you are copying / moving a job ticket file and its associated file (.pdf, .tif, .ps) from
Saved Jobs to a UNIX File System directory, you may receive a message "Cannot move
saved job." However, if you click OK, you will see that the files are successfully moved.
To prevent this message from appearing, select only the job ticket file. The associated
file will automatically be copied / moved with it.

Note
The scanning and copying of jobs is only available if your system includes the integrated
Document Scanner module.

Copy Jobs
1. In the Xerox Nuvera user interface, click the Copy button.
2. Select the Advanced tab.
3. Enter a job name by typing it into the Job Name text box.
4. Select the destination (Print, Print and Save, Save, Save as Background Form) for

your job. If saving the job, click the Save Location button to specify the location.
5. If saving, choose the format to be saved.
6. Set the job properties.
7. When you are satisfied with your settings, click Copy.

For more information, see Setting up a Copy Job.

Scan to File Jobs
1. In the Xerox Nuvera user interface, click the Scan To File button.
2. Select the Basic tab (selected by default).
3. Enter a job name by typing it into the Job Name text box.
4. Use the Save Location button to specify the location.
5. Choose the format to be saved as.

For more information, see Choosing a Scan File Format.

6. Set the job properties.
7. When you are satisfied with your settings, click Scan.

For more information, see Setting up a Copy Job.

Print from File Jobs
1. In the Xerox Nuvera user interface, click the Print From File button.
2. Select the Files tab (selected by default).
3. Click Browse to locate and select a job.
4. Select the directory location of the job from the Look In pull-down menu.
5. Select the destination (Print, Print and Save, Save, Save as Background Form) for

your job. If saving the job, use the Save Location button to specify the location.
6. If saving, choose the format to be saved as.

For more information, see Choosing a Scan File Format.
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7. Set the job properties.
8. When you are satisfied with your settings, click Print.

Note
The system is case sensitive when using file type filters in Print from File. For example,
the PostScript filter will only display files with a .ps extension and not those with a .PS
extension.

Note
The Job Manager Saved tab displays a list of all jobs in the user-defined Save location
as specified in System Preferences.

Related Hints and Tips

Hint/Tip DescriptionSubtopic

With Productivity Pack only: While copy jobs
can be sent to any queue, sending a copy job
to a queue that does not have Auto Proof selec-
ted will produce unexpected results. Scan To
File jobs can only be directed to the default
queue. Do not select Auto Proof on the default
queue or your output will not be as expected.

Auto Proof Productivity Pack only

To change the default save directory in Free-
Flow Print Server: 1. Open System Preferences.
2. Select the Save tab. 3. Enter a parent direct-
ory (either the actual directory you want, or one
that you can browse from). Note: While it is
possible to save jobs to the root directory
and/opt directory, you will not be able to reprint
from there with operator privileges. It is strongly
recommended that a new directory be created
that can be accessed by the operator in which
jobs can be saved for reprint.
4. Select the save directory from the tree view
(needs to be highlighted and this will change
the unlabeled path at the bottom of the win-
dow which happens to be the saved directory).
5. Click OK. Even though the top text box is
labeled Parent Directory, people may not read
that correctly, and just enter the value they
want for the saved directory and press Enter.
This will just change the root of the tree view
below it. The user still has to click on the direct-
ory that they want.

Change the default Save directory
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Hint/Tip DescriptionSubtopic

To scan a job to USB: 1. One-time setup: Go to
System Preferences, Save tab and set the de-
fault Save Location to the root directory ). 2.
Insert the thumb drive into an available USB
port. 3. Under Scan to File, select the Save
Location button. 4. Select Unix File System
from the drop down list. 5. Navigate to the dir-
ectory then to the subdirectory named for the
USB device. 6. Click OK and then scan the job.

Scan to File to a USB thumb drive

When performing a Copy Save the text will be
overwritten by the text. So if you are saving a
copy job and need the please put it in the Field.

Copy Save / Account ID Overwritten

Currently, when using Copy Save, if a user saves
a job that has Auto Center on, the job will not
be centered when reprinted. The current work-
around is to set System Preferences > Job
Processing  > TIFF Image Position from
'Normal' to 'Centered on Page'.

Copy Save and Auto Center

System faults when processing a Booklet job
with Covers. System Error occurred while at-
tempting to process this job. After this error,
some jobs may fault to the same error. A Re-
start is required. Workaround: For a Copy Save
job with Booklet Imposition do not program
with Covers. If this is done, the system may
have generated a processing error and will need
to be restarted.

Booklet job with covers

Browsing for files to a Solaris FTP server doesn't
list the directory links and you don't see /bin or
/lib because they are links to /usr/bin and
/usr/lib.

Browsing to a Solaris FTP server

When using Copy Save with the Landscape Left
staple option, the saved ticket has the finishing
as Portrait Right. If you scanned your originals
in Long Edge Feed (LEF) and are printing LEF,
change the finishing to the Landscape Left
staple option. If you scanned your originals in
LEF and are printing SEF, program a 180-image
rotation from the Image Edit tab. If you
scanned in SEF, you can reprint with the ticket
as it is.

Copy Save and Landscape Left staple option

If using Copy Save with any Landscape Staple
option, when reprinting the saved job ticket the
images may be upside down. To be sure it is OK
proof the job. If it is upside down, program with
180-image rotation from the Image Edit tab.

Copy Save and Landscape staple options
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Hint/Tip DescriptionSubtopic

Files saved as Multi-page TIFF are limited to
2GB in size. This limit may be reached after a
few hundred images if the scanned originals
contain a lot of halftone content and are
scanned at 1200x1200 resolution. When a job
reaches this size, a message may be displayed
indicating that the disk is full. To save large
jobs, use the save format of Single Page TIFF.

Multi-page TIFF file size limit

Scan jobs can only be directed to the default
queue. Do not set the disposition to "Print" with
"override" also set. This will disable Image Save
since those jobs will always print instead. This
also causes Mixed Size Original (MSO) jobs not
to run because a fault will always appear re-
questing the stock to be loaded even if it is
properly loaded.

Scan jobs do not set Print with override

When setting up and saving a copy job with
stapling, the resulting stapling choice for the
saved job may not match what was originally
programmed. The UI may display an equivalent
stapling selection but the job will apply the
proper stapling location. This applies to the
following: "1 Staple Landscape Right" displays
as "1 Staple Portrait Left". Setting a job with 2
staples portrait right results in the job being
saved with 2 staples landscape bottom, and
similarly: 2 staples portrait left results in 2
staples landscape top. 2 staples landscape left
results in 2 staples portrait top. 2 staples land-
scape right results in 2 staples portrait bottom.

Stapling option displayed on UI

If a large scan to network job faults, when the
fault is cleared it may appear that the job is
stuck in a "Scheduling" state. In fact the job is
active, but it takes a long time to reach the
"Being Saved" state (approximately 40-60
seconds per each 100Mb).

Scan to Network Job Fault

If you are using imposition on a Copy job, the
R/E setting on the Basic Tab will be ignored by
the system. This is because the imposition fea-
ture you select will determine the actual R/E to
use. Note: If you use Custom Multiple-Up, you
will be able to choose the R/E value yourself.

Imposition and a Copy job

When using Build Job and trying to staple Letter
and Legal, disable any Letter Long Edge Feed
trays to prevent a programming conflict.

Build Job and stapling
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Hint/Tip DescriptionSubtopic

When using Build Job with Imposition (ex.
booklet), with all Landscape images, and scan-
ning from the platen, rotate the paper 180 de-
grees on the platen to get the proper output.

Build Job with image orientation

When making copies, ensure the documents
are in the document handler for at least 1
second before pressing the start button.

Copies in document handler

If a copy job with Imposition is held, modified
to not have imposition, then released, the out-
put will not be scaled properly. If a copy job
with Imposition is saved, the saved ticket will
not reflect the correct imposition attribute (in-
stead it will show 'None') however the job will
reprint with the correct imposition. If a copy
job with Annotation is saved, the saved ticket
will not reflect the correct annotation attribute
(instead it will show 'None') however the job
will reprint with the correct annotation.

Copy job with imposition / annotation

If an image size is less than the output paper
size, and the image is duplex copied, the images
will not align from front to back. Perform an
image shift on one of the sides, or use Auto
Center to get them to align.

Duplex front to back alignment

If you hold or proof a copy job and modify an
attribute that will cause it to fault (ex. request
an unsupported staple) the job will go aborted
and you will need to rescan the job. As a work
around, save the job and then when you print
it, if it faults, you can change the offending at-
tribute, and then release it.

Fault caused by modified attribute

Do not use imposition functions on Copy Mixed
Size Original (MSO) or Build Jobs that contain
multiple sizes, or the output will be unpredict-
able. This includes any jobs that were held or
saved and have more than 1 paper size. If you
use Build Job with Signatures (Booklets), all of
the segments must be the same size and orient-
ation. If you scan in long edge feed on the
SDDF, you must also scan in long edge feed on
the platen. You must also have the same output
stock selected for each segment.

Imposition functions with Copy MSO / Build
Job

When sending a booklet layout copy job, the
Percent complete increments half as fast as the
job completes.

Percent complete
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Hint/Tip DescriptionSubtopic

If you are using Scan to File and you are using
the system supplied Reduce/Enlarge rates, the
saved job ticket will have a custom stock size.
For example, a Scan to File job with a RE value
of 64% (Ledger  > Letter) will save a job with
a custom size rather than Letter. If you try to
reprint it, you will need to choose Letter stock.
If you would like the saved job to come out to
exactly the correct size for reprinting, use Copy
Save instead of Scan to File.

R/E with Scan to File

Saved PDF files contain thumbnail images that
can be displayed by Acrobat Reader. When
viewing a PDF file saved from Scan to File, those
images are rotated 90 degrees clockwise from
the orientation of the full-size page images.

PDF with Rotated Thumbnails

For more information, see Setting up a Copy Job.

Finding a Saved Job to Print

Finding jobs (copy, print, or scanned) saved on the Xerox Nuvera user interface can be
done in two ways:

• Through the user interface under the Job Manager Services
• Through the user interface under the Print From File Services

To find a saved job in Job Manager

The Job Manager button allows you to perform a number of tasks at the job level, such
as:

• Preview
• Hold
• Promote
• Move
• Copy
• Forward

Additionally, you can retrieve and print jobs that have been saved to the system.
1. From the Xerox Nuvera user interface, select the Job Manager button.
2. Select the Saved tab to display the list of saved jobs.
3. From the list that displays, double-click on the saved job you want to print.

The print properties window displays.
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Note
The Job Ticket format is chosen by default because this is the file type that is used
to print the entire job. Selecting other file types will not give you the entire job. For
example, if you select TIFF, the system only prints the TIFF image. The job is printed
without the original job programming choices.

4. Select or change any programming settings.
5. When satisfied with your settings, click Print.

To find a saved job using Print From File
1. From the Xerox Nuvera user interface, select the Print From File button.
2. Select the Files tab.
3. Select Browse to locate the file you want to print.
4. From the files listed in the Browse window, double-click the job.

The print properties window displays.
5. Select or change any programming settings.
6. When satisfied with your settings, click Print.

Note
Browsing for files to a Solaris FTP server doesn't list the directory links. For example, you
don't see /bin or /lib because they are links to /usr/bin and /usr/lib.

Customizing System Default Options

If your workflow requires you to use machine settings that differ from the system defaults,
or you consistently print to a paper stock that is not the default, navigating all of the
user interface screens to program your jobs can be time consuming.

The default settings of the Xerox Nuvera are fully customizable by a System
Administrator, making job programming much quicker and easier. Some of the system
defaults that can be customized for your particular workflow include:

• Sides imaged
• Finishing options
• Image editing
• PDL (Page Description Language. TIFF, PostScript, etc.) resolution settings

To view current printer default options for systems with one queue
If your system does not have the Productivity Pack license enabled:
1. In the Xerox Nuvera user interface, click Printer > Defaults.

The Printer Defaults window displays.
2. In the tabbed interface, select each tab, viewing current settings.
3. To customize settings, contact your System Administrator.
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To view current printer default options for systems with multiple queues
If your system has the Productivity Pack license enabled:
1. In the Xerox Nuvera user interface, click the Queue Manager button.

The Queue window displays.
2. Right-click on the queue and select [Properties].

The Properties window displays.
3. In the tabbed interface, select each tab, viewing current settings.
4. To customize settings, contact your System Administrator.

To customize general system settings

The following system default settings can be changed at any time by a System
Administrator using the Setup > System Preferences menu.

• Jobs Policy: For example, System action when out of paper
• Default font sets used/Substitute fonts: Enabled/Disabled
• Allow stock substitutions
• Save job locations
• Default launch screen (Copy, Print, Job Manager, Print From File)
• Tray Confirmation
• Job Processing defaults
• International settings
• Scheduling Mode

Note
Contact your System Administrator to configure custom System Preferences.

Note
Refer to the Xerox Nuvera online help for details about System Preferences settings.

Using Xerox FreeFlow Remote Print Server Software

FreeFlow Remote Print Server software allows access to the Xerox Nuvera user interface
from a remote client (i.e., the computer at your own desk). Remote print server software
provides the functionality of the Xerox Nuvera at a remote desktop, enabling the user,
from anywhere on the network, to use the full range of Xerox Nuvera functions.

Note
New major releases of FreeFlow Print Server require updated versions of FreeFlow Remote
Print Server software. Verify that you have the correct Remote Print Server version to
match your version of FreeFlow Print Server software. Contact your System Administrator
to have FreeFlow Remote Print Server software installed and configured on your computer.

Note
FreeFlow Remote Print Server software does not support the IPS Manager.
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Adding Annotations to your Jobs
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

The following information applies to both Print and Copy jobs.

There may be times when you need to add extra content to your job. The Annotation
feature allows you to add these special marks:

• Page Numbers--can be configured to appear anywhere on each page
• Watermarks--Indicates to the reader that the document they have is Confidential,

Draft, etc. The watermark appears as shaded text behind the actual page content
• Date Stamps

Annotation can be a queue setting. Any job being sent to that queue will be annotated.

The Xerox Nuvera systems that have the Productivity Pack license allowing for multiple
queues have a Queue manager to create new queues.

The Xerox Nuvera systems without the Productivity Pack license set up the system
preferences. By default, all annotations are set to off.

Print jobs refer to jobs being reprinted on the device. Any jobs being submitted through
a driver use the watermark available on the driver. If a queue is set up for annotations
and a print job comes into that queue, then it will be annotated on the queue properties.

Note
If you forward a job from one machine to another, the forwarded job will lose its
annotation attributes as well as Printer Darkness settings and imposition attributes.

To Annotate Print or Copy Jobs
1. From either the Print or Copy service, click on the Output tab.
2. Click the Annotations button.

Note
Take notice of the text on the Annotations button. It will show which annotation
types (if any) are currently enabled.

3. The Annotations window appears. Place a checkmark in any or all of the
Annotation-type checkboxes. Clear any Annotation-type checkboxes you do not wish
to use.

4. When satisfied with your settings, click Copy or Print.

Configuring Annotations
1. To configure how each Annotation type appears, click the Copy Service button.
2. Click the Output tab.
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3. Click Annotations.
4. Click Setup.
5. Click on one of the Annotation-type tabs.

The Annotation window appears.
6. Make your selections. When satisfied with your settings, click OK, then click Copy.

For details about working with the Annotation controls, refer to the system online Help.

Generating a Sample Print

Use the Sample Current Job feature when releasing a job to print or while the job is
printing to see if the job will print as expected. A single, sample page of the job prints
so you can verify the job settings.

This feature enables you to periodically check image quality and job programming
selections used on the job as it is printing. Since jobs sent to certain finishers (such as,
the Xerox Basic Finisher Module) cannot be accessed while the main stacker tray is in
use, the Sample Current Job feature allows sample prints to be sent to the stacker top
tray.

The Sample Current Job feature is different from proofing a job. When proofing a job,
the entire job prints and it only allows you to make adjustments to the job before
submitting it for printing. The Sample Current Job option prints only a single page for
sampling and allows you to make adjustments while the job is printing.

Note
This feature is not available for remote clients and is not available when the system is
in Secure Mode. You can, however, print sample variable data jobs

To produce a sample print of a page while the job is printing
1. Submit a job to the Hold queue of the printer.
2. Right-click on the job and select Release Job.
3. While the job is printing, select Printer  > Sample Current Job.

A single copy of the next image prints to the top tray (as a sample print) while the
entire job continues to print to the stacker. Job integrity is not disrupted as the job
continues to print.

4. If you want to change job properties, right-click on the job and select Hold.
The job is placed in the Inactive Jobs list.

5. Right-click the job, select Properties and make changes.
6. Select Release to place the job back in the Active Jobs list.

Sample Print From a Client Computer

A sample print can not be programmed at the Client's workstation during job submission.
However, the Client sample print workflow could be sent and the job can be held in a
hold queue. Then you can program the sample printing attributes for that job at the
system user interface. For details, see Working with Queues.
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About Pitch

The Xerox Nuvera is equipped with a variable pitch Xerographic belt. Pitch refers to the
number of page images that can be placed on the belt, which are then transferred to
the paper. During printing, the system senses paper sizes requested, and optimizes the
use of the belt and the paper path to ensure maximum productivity.

Paper Size/Pitch Relationships

The charts below illustrate the expected system throughput, given a certain page/ image
size.

Note
If you enable the Wide Stock feature from the FreeFlow Print Server Printer menu (Media
Optimization), the system will run stocks greater than 9.0 inches up to 9.5 inches wide
in 5 pitch mode instead of 4 pitch mode. This increases the print speed of these width
sizes to match that of 9.0 inch stock.

Table 4. Xerox Nuvera 100 EA/MX Production System

Maximum Throughput (Pages
Per Minute/PPM)

Pitch (Images per PR belt
revolution)

Paper/Image Size (Feed Direc-
tion) Min-Max

10055.5 in (140mm) - 9.0 in (229mm)

80/10059.0 in (229mm) - 9.5 in (241mm)

8049.5 in (241mm) - 11.7 in
(297mm)

60311.7 in (297mm) - 17 in (432mm)

40217.0 in (432mm) - 18.5 in
(470mm)

Table 5. Xerox Nuvera 120 EA/MX Production System

Maximum Throughput (Pages
Per Minute/PPM)

Pitch (Images per PR belt
revolution)

Paper/Image Size (Feed Direc-
tion) Min-Max

12055.5 in (140mm) - 9.0 in (229mm)

96/12059.0 in (229mm) - 9.5 in (241mm)

9649.5 in (241mm) - 11.7 in
(297mm)

72311.7 in (297mm) - 17.0 in
(432mm)

48217.0 in (432mm) - 18.5 in
(470mm)
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Table 6. Xerox Nuvera 144 EA/MX Production System

Maximum Throughput
(Pages Per Minute/PPM)

Pitch (Images per PR belt
revolution)

Paper/Image Size (Feed Direc-
tion) Min-Max

14465.5 in (140mm) - 8.5 in (216mm)

12058.5 in ( 216mm)- 9.0 in (229mm)

96/12059.0 in (229mm) - 9.5 in (241mm)

9649.5 in (241mm) - 11.7 in
(297mm)

72311.7 in (297mm) - 17.0 in
(432mm)

48217.0 in (432mm) - 18.5 in
(470mm)

Table 7. Xerox Nuvera 157 EA Production System

Maximum Throughput (Im-
pressions Per Minute/IPM)
Duplex

Pitch (Images per PR belt
revolution)

Paper/Image Size (Feed Direc-
tion) Min-Max

15765.5 in (140mm) - 8.5 in (216mm)

13058.5 in (216mm) - 9.0 in (229mm)

105/13059.0 in (229mm) - 9.5 in (241 mm)

10549.5 in (241mm) - 11.7 in
(297mm)

78311.7 in (297mm) - 17 in (432mm)

52217 in (432mm) - 18.5 in (491mm)

Table 8. Xerox Nuvera 314 EA Production System

Maximum Throughput (Im-
pressions Per Minute/IPM)
Duplex

Pitch (Images per PR belt re-
volution)

Paper/Image Size (Feed Direc-
tion) Min-Max

31465.7 in (140mm) - 8.5 in (216mm)

26158.5 in (216mm) - 9.0 in (229mm)

209/26159.0 in (229mm) - 9.5 in (241mm)

20949.5 in (241mm) - 11.7 in
(297mm)

157311.7 in (297mm) - 17 in
(432mm)

104217 in (432mm) - 19.33 in
(491mm)
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Table 9. Xerox Nuvera 200/288 EA/MX Perfecting Production System

Maximum Through-
put (Impressions Per
Minute/IPM) Duplex
Xerox Nuvera 288

Maximum Through-
put (Impressions Per
Minute/IPM) Duplex
Xerox Nuvera 200

Pitch (Im-
ages per PR
belt revolu-
tion)

Paper/Image Size (Feed Direc-
tion) Min-Max

28820065.7 in (140mm) - 8.5 in (216mm)

24020058.5 in (216mm) - 9.0 in (229mm)

192/240160/20059.0 in (229mm) - 9.5 in (241mm)

19216049.5 in (241mm) - 11.7 in
(297mm)

144120311.7 in (297mm) - 17 in
(432mm)

9680217 in (432mm) - 19.33 in
(491mm)

Using the Xerox Nuvera with FreeFlow Makeready
Note
The following information is subject to change as new versions of the Makeready
application are developed.

If you have a Xerox FreeFlow solution, you can incorporate the FreeFlow Makeready
application with the Xerox Nuvera . For best results, follow these guidelines:

To print to the Xerox Nuvera from FreeFlow Makeready
1. Make sure the target print driver is loaded on your PC.
2. From the FreeFlow application, select the file you want to print.
3. From the Print dialog, select the appropriate target printer type:

• Xerox Nuvera 100/120/144/157 EA Production System
• Xerox Nuvera 200/288/314 EA Perfecting Production System

Tip
Jobs sent from FreeFlow Makeready should be programmed to hold at the Xerox Nuvera
then re-programmed through the printer's user interface to ensure correct job attributes.
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13
Replacing Consumables

This section covers procedures for maintaining your Xerox Nuvera.

Consumables can be defined as any parts or supplies that need replacing periodically
in order for the machine to perform all of its functions.

Click the links at the left to learn how to change or replace consumables.

For Customer Support telephone numbers and the reorder part numbers of supplies, go
to Telephone numbers and World Wide Web address.

Replacing the Developer Waste Container
The Developer Waste Container gets replaced after every 800,000 images. When the
machine has reached the limit set for the Developer Waste Container, an alert will appear
in the system messages portion of the user interface.

To replace the Developer Waste container

Double-click the system alert to see details about the action needed, instructions on how
and where to return the used container, as well as the location of the container.

See Contacting Xerox to get the correct part number for this container.

Make sure there are no jobs running.
1. Open the front access covers and identify the correct container.
2. Prepare the new container for installation.
3. Remove the used container.
4. Insert the new container, making sure it is completely seated.
5. Package the used container for return. Use the box and prepaid return label to return

the old unit to Xerox.
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Dry Ink (Toner)
The Xerox Nuvera System uses EA dry ink only. The EA (Emulsion Aggregation) dry ink
is a latex-based material that flows easier than conventional dry ink, resulting in less
toner being used to provide the same density print. It offers a smoother, flatter laydown
of dry ink surface that also creates a very high quality print.

Replacing the Dry Ink Container

When the machine has reached the limit set for the dry ink container, an alert will appear
in the system messages portion of the user interface. Double-clicking the alert will launch
a new window, giving details about the action needed.

The Xerox Nuvera EA Production System includes 1 dry ink container. The Xerox Nuvera
200/288 EA Perfecting Production System has 2 dry ink containers, one per print engine.
Each container lasts up to approximately 200,000 images. You can replace the empty
container while the system is running since approximately 10 minutes worth of dry ink
is available for continued printing.

An optional Dry Ink Equipment kit can be ordered that allows two dry ink containers to
be installed.

Caution
Make sure you install a valid dry ink container. The EA dry ink container has a Green cap
and label.

The label on the inside of the left print engine door indicates the toner type to be used
based upon the cap and label color. It also shows how to remove and replace a dry ink
cartridge.
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To replace a Dry Ink Container

Double-click the system alert to see the location of the Dry Ink Container, details on the
action needed, and instructions on how and where to return the used Dry Ink Container.

See Contacting Xerox to get the correct part number for this Dry Ink Container.

Note
If you install an invalid dry ink cartridge, a fault code will ask you to "remove the invalid
toner container".

1. Open the front access covers and identify the correct container.
2. Move the Dry Ink Container latch to the left.
3. Remove the used container by pulling the container outward. Keep the output hole

of the old container pointing up to avoid spilling any residual dry ink.
4. Prepare the new container for installation. Before removing the orange seal, shake

the container end to end five times. This mixes up any dry ink that may have settled.
5. Remove the orange seal.
6. Insert the new container. Make sure:

• the intake core punctures the container's inner seal
• the container is completely seated
• the arrow on the container lines up with the arrow on the printer housing

7. Package the used container for return. Use the box and prepaid return label to return
the old unit to Xerox.

Replacing the Dry Ink Waste Container
The Dry Ink Waste container gets replaced every 750,000 (750K) images. When the
limit is reached, an alert will appear in the system messages portion of the control screen.

Note
The alert appears before the waste container is completely full. This gives you the
opportunity to finish any jobs in progress. As soon as the job is printed, replace the waste
container.

To replace the Dry Ink Waste Container

See Contacting Xerox to get the correct part number for this container.

Make sure there are no jobs running.
1. Open the front access covers and locate the correct container.
2. Prepare the new container for installation.
3. Remove the used container.
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4. Insert the new container, making sure it is completely seated.
5. Package the used container for return. Use the box and prepaid return label to return

the used unit to Xerox.

Replacing the Hole Punch Waste
Container
When the Hole Punch Waste container in the Interface Module of the Multifunction
Finisher Pro Plus reaches its limit, an alert will appear in the system messages portion
of the user interface screen.

Note
A 90% full warning appears before the waste container is completely full. This gives you
the opportunity to finish any jobs in progress. As soon as the job is printed, replace the
waste container. If a full warning appears, the system will no longer punch jobs in progress
until the waste container is emptied and replaced.

To replace the Hole Punch Waste Container
Make sure there are no jobs running.
1. Open the front access cover of the MFF Insertion Module and locate the black waste

container.
2. Remove the waste container by grasping the black handle and sliding it straight out.
3. Empty the waste container.
4. Insert the empty waste container. Align the small black knobs on either side of the

container on top of the metal brackets.
5. Push the container in all the way until it stops, making sure it is completely seated.
6. Close the access cover of the MFF.

Replacing the Hole Paper Punch
There are two types of Hole Punch modules that can be used with the Multifunction
Finisher Pro Plus:

• 2 and 3 Hole Paper Punch, or
• 2 and 4 Hole Paper Punch
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If the 2/3 Hole Paper Punch is installed, you can indicate that you want to finish and
punch your printed documents with 2 or 3 holes at the lead edge. If the 2/4 Hole Paper
Punch is installed, you can identify your documents to be finished and punched with 2
or 4 holes. The various punch finishing options, such as hole punching Portrait Top or
Landscape Right, are selectable from the Output tab, the Stapling/Finishing area on the
FreeFlow Print Server interface. Use this hole punching feature if you want to easily
place your finished document in a 2, 3 or 4 ring binder.

The Hole Punch module is first installed and set up on the system by a Xerox CSE. If you
would like to switch to using the other type of hole punch at any time, you must contact
your Xerox representative who can order the 2/3 or 2/4 Hole Punch module. Once ordered
and the CSE has completed running the NVM setup routine for the new hole punch
module, you can then install and replace your current hole punch (for instance, 2/3) with
the other hole punch (2/4).

To Replace the Hole Paper Punch

See Contacting Xerox to get the correct part order number for this unit.

Make sure there are no jobs running. Also, you can refer to the label on the inside of the
MFF Insertion Module cover door for removal instructions.
1. Open the front access cover of the MFF Insertion Module and locate the hole punch

module.
2. Locate the black handle with the orange strip.
3. Remove the hole punch module by lifting the handle upwards and pulling straight

out until you hear a click.
4. At the top of the hole punch module, grasp the long upper orange handle and, holding

firmly, use the handle to slide and lift the module out.
5. Replace the new hole punch module. With the orange strip facing you and long orange

handle on top, align the sides of the hole punch module against the MFF channel
and slide it straight into the channel.

6. Completely insert the hole punch module until you hear a click.
7. Close the access cover of the MFF.

Hole Punch Module

2/3 Hole Paper Punch or a 2/4 Hole Paper Punch

13-5Xerox® Nuvera®

User Guide and Training Aid (UGTA)

Replacing Consumables



Replacing Staples in the Finishers
Depending on your system's finisher configuration, refer to the appropriate sections.

Systems with Basic Finishing Modules (BFM)

See Replacing Staples in the BFM for information on staple replacement.

Systems with Multifunction Finisher (MFF)

There are two stapler mechanisms in the Multifunction Finisher (MFF):

• Main Tray Stapler
• Booklet Tray Stapler

When the Xerox Nuvera has used all of the staples in either of the staplers, an alert will
appear in the system messages portion of the UI.

Note
The Main Stapler cartridge must be completely empty before you can remove the old
container.

To replace staples

Double-click the system alert to see details on the action needed, as well as the location
of the stapler needing attention.

See Contacting Xerox to get the correct part number for this CRU.

Main Tray Stapler
1. Once you have identified the location of the stapler, open the access panel and locate

the stapler housing. It is identified with a pictorial representation of a staple.
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2. Grasp the stapler housing drawer handle and pull out towards you.
3. Grasp the stapler cartridge handle. To remove, move it upwards, then pull out the

entire cartridge.
4. Turn over the completely empty stapler cartridge. With a slight pinching motion,

release the cartridge cover. It will swing away, exposing the empty staple stack
container.

5. Take note of the way the container is housed in the cartridge. Grasp the white handle
of the container, and pull it out of the housing. Discard this cardboard container.

6. Slide the new staple stack into the cartridge. Remove the white retainer strip.
7. Swing the cartridge cover back up into place.
8. Slide the stapler cartridge back into the drawer.

Figure 17. Full cartridge

Figure 18. Ready to load position - note position of new staple cartridge.

Booklet Tray Stapler
1. Rotate the handle (Area 2) to the up position.
2. Access the Booklet Stapler by pulling out the Booklet folding drawer (Area 4) in the

MFF.
3. In the lower right area of the drawer, swing out the mechanism by grasping the green

handle. You should now see the twin stapler heads.
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4. Grasp one of the staple head assemblies, and with a slight pinching action, pull out
the empty staple cartridge.

5. Replace with a new cartridge. Contacting Xerox to order this consumable part.

Note
Before inserting new cartridge, remove the small orange clip. It is there to ensure the
staples remain in the housing during shipment/handling.

6. Repeat #4 and 5 for the second stapler cartridge.
7. Close the Booklet folding drawer (Area 4) in the MFF.
8. Rotate the handle (Area 2) to the down position.

Replacing the Fuser Web Cassette
The Fuser Web Cassette is not a customer replaceable unit monitored by the machine
software. When the web material is near end, a fault code will display.

1. When the faults 10-2180 Qeb Stall and 10-9105 Web EOL displays three or four
times before changing the Fuser Web Cassette.

2. Rrplacement instructions are on the Web Cassette package.

Replacing Staples in the BFM
There are two stapler cartridge sizes available for the Basic Finishing Module (BFM), a
30 or 100 page staple cartridge.

Note
The stapler cartridge in the BFM Plus can be replaced if the BFM Plus is running in bypass
mode.

Caution
Do not open the BFM front door and the stapler door at the same time.

To Replace BFM Stapler Cartridges
1. In the user interface, select Printer, then select Unlock Finisher.

The Unlock Basic Finisher window appears.
2. In the Stapler Drawer field, click Unlock .

You should hear the drawer mechanism click.
3. At the BFM, pull out the stapler drawer.
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4. Remove the cartridge to be replaced by grasping the colored handle and pulling away
from the stapler mechanism.
Refer to the label on the stapler drawer for detailed removal instructions.

5. Replace new cartridge.
6. At the BFM, push in to close the stapler drawer.
7. In the Unlock Basic Finisher window, the Stapler Drawer field should now display

Locked.
8. In the Unlock Basic Finisher window, click Close.

Note
The current machine software does not distinguish between the 30 Sheet Stapler
Cartridge and the 100 Sheet Stapler Cartridge. If the 30 Sheet Stapler Cartridge is loaded
in the machine, and a job with more than 30 sheets is submitted for stapling, a mis-staple
or stapler jam will probably occur. If the 30 Sheet Stapler Cartridge is used, it is the
responsibility of the operator to ensure that jobs exceeding 30 sheets are not submitted
for stapling.

Figure 19. BFM Stapler Cartridge.
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Figure 20. 30 Sheet Stapler Cartridge.
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14
Maintaining Your Xerox
Nuvera

The Xerox Nuvera is designed to maximize machine uptime. The machine is equipped
with a short paper path in order to minimize jams, and Replaceable Units in order to
avoid extended periods of downtime.

Click any of the links on the left to learn about all aspects of maintaining your Xerox
Nuvera .

Power Procedures
In order to ensure correct operation of the system, it is imperative that the system be
powered on and off in the way that it was designed to do so. Deviating from the
procedures can result in poor performance, loss of data and loss of productivity.

Click on the links to the left to learn about powering on, powering off, and restarting the
system.

Powering On the Xerox Nuvera

Follow these procedures to correctly power up the entire Xerox Nuvera system and avoid
damage to the machine and/or loss of data.

Any finishing modules that have separate power on/off switches will be powered on at
the time of install.
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To power on the Xerox Nuvera

The power switch is the white switch located on the right side of the machine. Press the
(|) symbol embossed into the button toward the back of the machine to turn the power
on. (For the Xerox Nuvera 157/200/288/314 EA/MX Perfecting Production System
Perfecting System, the Power On switch is located on Print Engine A1).

The Xerox Nuvera system begins its power-up/boot sequence and automatically launches
the FreeFlow Print Server operating system.

Note
Do not click anywhere in the user interface before the machine is through booting.

When the FreeFlow Print Server screen appears, you can begin printing jobs.

The entire power on process takes approximately 5 minutes.

Powering Off the System

Follow these procedures to correctly power down the machine. While turning the machine
on and off may seem self-explanatory, there are a few conventions to adhere to, in order
to avoid damage to the machine and/or loss of data.

To power off the system

There are two non-emergency methods used to power off.

Preferred power off method
1. In the user interface, click System > Shutdown.
2. Click Yes to shut down the system in an orderly fashion, after all scheduled jobs are

processed.
3. Click Interrupt to shut down the system without completing the processing of current

jobs.
4. Click No to return to the user interface.

In a few moments, the system will begin an orderly shutdown.

If the preferred power off method is not successful
1. Press the (O) symbol embossed into the button toward the back of the machine to

turn the power off. For the Xerox Nuvera 157/200/288/314 EA/MX Perfecting
Production System, access the power switch on Print Engine A1.

2. Click Yes to shut down the system in an orderly fashion, after all scheduled jobs are
processed.

3. Click Interrupt to shut down the system without completing the processing of current
jobs.

4. Click No to return to the user interface.
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Note
Users should not use Printer Off, since Printer On is only available to System
Administrators. If a user does select it and needs to exit, select Restart and the system
will come up to ready.

Energy Star

Refer to the Xerox Nuvera Safety and Certifications Guide for information on this topic.

Power Saver Mode

The capability to enter and exit Power Saver Modes is required to control power
consumption during long periods of system inactivity and to comply with EPA's ENERGY
STAR regulations for energy savings.

The system has three Power Saver modes:

• Low Power Mode (LPM)
• Monitor Off Mode (MOM)
• Sleep Mode (SM)

The monitor will shut off (black screen) when the machine goes into any of the Power
Saver modes.

Power Saver modes and paper loading

When you are in Low Power Mode (LPM) or Sleep Mode (SM), the paper trays will not
respond when you open/close/load them with paper. LPM or SM must be exited first, in
order for the system to detect paper. However, you may load paper while you are in a
Power Saver mode, and the paper will be detected after exiting Power Saver mode.

Ways to exit Low Power Mode
• Place document(s) in the Document Feeder
• Send a job from a client
• Requesting an exit from the UI. Choose Printer  > Exit Power Saver.

Ways to exit Sleep Mode
• Send a job from a client
• Requesting an exit from the UI. Choose Printer  > Exit Power Saver.

Note
It is NOT possible to exit LPM or SM by simply moving the mouse or with keyboard
strokes. However, moving the mouse will cause the system to exit MOM.

Note
You cannot set the total of LPM and SM timers to more than 240 minutes.

14-3Xerox® Nuvera®

User Guide and Training Aid (UGTA)

Maintaining Your Xerox Nuvera



Restarting the System

If your machine performance becomes degraded, or it ceases to function correctly for
any reason, executing a Restart will usually restore correct function. If the problem
continues, contact your Xerox representative.

Note
If the system is restarted during the printing of a very long job, the system may take a
long time to recover the job - approximately 1 minute for each 10,000 pages in the job.

To restart the system

There are two ways to restart the Xerox Nuvera :

• Method A Restart: a shutdown and restart of the FreeFlow Print Server software.
• Method B Shutdown : a machine shutdown.

Tip
If system performance becomes degraded, try Method A first. If this solves performance
problems, don't perform Method B. If system performance is still poor, perform Method
B.

For details on powering on the system, see Powering On the Xerox Nuvera

Method A: Restart the system
1. In the user interface, click System > Restart.
2. In a few moments, the system will begin an orderly shutdown of services.

The system will then begin an orderly startup. Wait several minutes for the system to
load all services before clicking anywhere in the user interface.

Method B: Shut down the system
1. In the user interface, click System > Shutdown.
2. Click Yes to shut down the system in an orderly fashion, after all scheduled jobs are

processed.
3. Click Interrupt to shut down the system without completing the processing of current

jobs.
4. Click No to return to the user interface.
5. In a few moments, the system will begin an orderly shutdown.
6. Once the system has completely shutdown, wait 30 seconds and power on the system

by pressing (I) on the power switch located on the lower right corner of the control
console.
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Using the Pass Through Mode Feature
The Pass Through Mode (PTM) is only available on the Xerox Nuvera 200/288/314
EA/MX Perfecting Production System, which is uniquely configured with two print engines
instead of one.

The PTM feature is used to maximize print productivity in the event that only one of the
print engines is up and running. If a print engine is shut down due to a fault, image
quality mismatching, or pending maintenance, the PTM feature allows you to identify
the print engine to use for continued printing of simplex or duplex jobs. The other print
engine will only be used to pass paper through the system.

Note
When printing with one print engine, the productivity rate changes from 200/288/314
ipm to 100/144/157 ipm. To always make full use of the system's productivity, make
sure to disable this feature once the idle print engine is serviced and available for use.

When to enable Pass Through Mode

The following are the circumstances under which you would enable this feature and
print with only one print engine:

• One of the print engines is out of toner
• Required maintenance on one of the print engines is awaiting service (for example,

the photo receptor belt needs to be replaced)
• Certain print engine faults or system faults
• The image quality between the two print engines does not match and you want to

use the print engine that produces consistent image quality

If you encounter the following circumstances, contact Service. Do not use or enable this
feature if the system is experiencing:

• Reoccurring jams
• Critical print engine problems
• Certain print engine faults
• Registration faults

Note
If PTM is enabled but a critical print engine problem or fault exists, the available print
engine will not print. Since the same paper path is used whether PTM is enabled or
disabled, the system is preventing any damage to the down print engine.
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To enable and use the Pass Through Mode
1. On the System menu, select User Diagnostics > System Optimization Customer

Setup.
The System Customer Setup dialog displays.

2. From the Pass Through Mode drop-down menu, select Print with Engine A1 Only to
select only print engine A1 for printing or Print with Engine A2 Only to identify print
engine A2 to use for printing.

3. Close the dialog.

The Pass Through Mode is in effect.

To disable the Pass Through Mode
Once the idle print engine is serviced, access and disable the PTM feature:
1. On the System menu, select User Diagnostics > System Optimization Customer

Setup.
The System Customer Setup dialog displays.

2. From the Pass Through Mode drop-down menu, select Off to instruct the system to
use both print engines for printing.

3. Close the dialog.

The Pass Through Mode is disabled.

Running User Diagnostics
You may be prompted by the Xerox Nuvera , or by a Customer Support representative
to access and run diagnostic routines. The diagnostic routines are useful for getting the
system back into proper calibration or adjustment, and/or as a part of general system
maintenance.

Caution
Selecting and running any of the User Diagnostic routines modifies the system settings
and may change the performance of your Nuvera. Use the User Diagnostic routines and
settings only with the direction of an authorized Xerox representative.

To access User Diagnostics
1. In the Xerox Nuvera user interface, select System > User Diagnostics.

The User Diagnostics window appears. Depending on your system configuration,
available diagnostic routines are listed.

2. After checking with your authorized Xerox representative, select one of the routines
to begin a diagnostic routine or to enable/disable a routine or algorithm.
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3. Follow the on-screen instructions for information on how to run and perform the
diagnostic routine. If you need further information on how to achieve certain results,
contact Call for Assistance.

Document Scanner

Document Glass Scanner Setup - for systems with an integrated scanner, use to establish
the position of the Document Glass top and left registration edges, and set the scan
speed of the Document Scanner.

Print Engine

For the Xerox Nuvera EA Production System, perform the following routines as needed.

• dC0604 PE Registration Setup - use to align and register the image on side 1 with
the image on side 2.

• dC0943 Corotron Cleaning Routine - use weekly to remove dust and dirt that has
built up on the corotron.

• Image Quality Setup - use if experiencing image quality problems after running the
Corotron Cleaning routine.

Print Engine A1

For the Xerox Nuvera 157/200/288/314 EA/MX Perfecting Production System, select
one of the following routines when running Print Engine A1 only. Note that Print Engine
A1 is the print engine on the left, directly following the feeder modules.

• dC0604 PE Registration Setup - use to align and register the image on side 1 with
the image on side 2.

• dC0943 Corotron Cleaning Routine - use weekly to remove dust and dirt that has
built up on the corotron.

• Image Quality Setup - use if experiencing image quality problems after running the
Corotron Cleaning routine.

Print Engine A2

For the Xerox Nuvera 157/200/288/314 EA/MX Perfecting Production System, select
one of the following routines when running Print Engine A2 only. Note that Print Engine
A2 is the print engine on the right, between Print Engine A1 and the Sheet Enhancement
Module.

• dC0604 PE Registration Setup - use to align and register the image on side 2 with
the image on side 1.

• dC0943 Corotron Cleaning Routine - use weekly to remove dust and dirt that has
built up on the corotron.

• Image Quality Setup - use if experiencing image quality problems after running the
Corotron Cleaning routine.
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System

For the Xerox Nuvera 157/200/288/314 EA/MX Perfecting Production System, perform
the following routines as needed.

• dC0604 PE Registration Setup - use to align and register the image on side 1 with
the image on side 2.

• dC0965 System Image Quality Xerographic Balance - use to adjust the lightness
and darkness values between the two print engines. If you notice the images output
from one print engine appear lighter than the other print engine, run this image
quality matching diagnostic routine before contacting Service. The system performs
an automatic check and prints 10 pages (side 1 printed from print engine A1 and
side 2 printed from print engine A2). Visually inspect and compare the image quality
and select whether side 1 or side 2 is lighter, or no difference between the sides. The
routine will increase the toner mass on the photoreceptor belt if the user indicates
that one side is lighter than another.

System Optimization Customer Setup

From the User Diagnostics window, System: System Optimization Customer Setup screen,
enable or disable the following optimization switches as needed for the job.

• Enable Registration Skew Data Logging for CFA - This setting should only be enabled
when instructed by a Xerox Service representative. It allows additional Registration
data to be logged in the Remote Data pushes when servicing a Registration Skew
problem.

• Enable Area 5B Purge - Selected by default, this feature allows unused media to
purge to area 5B of the printer as well as to the Top Tray of the finisher after a jam
occurs. Purging media to these two areas simplifies jam clearance. If this feature is
not selected, you may have to clear the entire paper path after a jam.

• Light-Weight Stock Jobs - Optimize Image Quality - Use to improve image quality
problems on lightweight stock resulting from deletions on large format media with
low area coverage. These deletions are typically only seen on side 2 of 2-sided jobs.
Do not use with heavyweight stock and use only when directed to do so by a Xerox
representative. Do not select this feature and EIP mode at the same time.

• Light-Weight Stock Jobs - Optimize Job Quality - This setting is not available to the
customer operator.

• Heavy-Weight Stock Jobs - Enhance Image Permanence (EIP) - Select if printing
media with challenging fix characteristics, such as heavy rough stock and some coated
stock. When EIP is enabled, an EIP icon displays in the status/mode indicator area
of the FreeFlow Print Server user interface indicating that this mode is in effect. Place
the mouse over the icon to display the tool tip for how and when to exit this mode.
Selecting EIP runs the fuser at a constant, higher temperature and increases image
permanence on heavyweight paper. Since this higher temperature may cause waves
and curl in lightweight stocks, and degrade output stack quality, deselect this feature
and use AIP mode when not printing on heavyweight stock.

Xerox® Nuvera®14-8
User Guide and Training Aid (UGTA)

Maintaining Your Xerox Nuvera



• Automatic Image Permanence for All Stock Weights (AIP) - AIP is the preferred
mode. Use this routine to adjust the fuser temperature ac cordingly based on the
programmed job information .

Note
Automatic Image Permanence (AIP) is dependent on how the user programs media
characteristics into the stock library or into each feed tray. Spending a few moments
to correctly program the media is important to getting the optimal performance
from your Xerox Nuvera system. The Xerox Nuvera runs in Nominal Mode if neither
EIP or AIP is selected. Nominal Mode runs at a mid-level fusing temperature that is
satisfactory for most media.

• Reduce Up-Curl for 2-Sided Jobs - For the EA Production System, enable when there
is excessive upcurl in the output stacks. The system prints side 2 first and then side
1 to avoid the sheet being inverted after the second image. This causes the output
to have down curl instead of up curl. Note that this selection does not apply to jobs
programmed with ordered stock and 3-hole punch stock. If used, the system ignores
the Reduce Up-Curl feature and prints side 1first.

• Cycle Up Purge Enabled - Not available to the user. This feature is used only by a
Xerox technical representative.

• Feed Until Empty Algorithm - When enabled, the system empties stock from the
secondary feed tray in use before switching back to the primary tray.

• Pass Through Mode - For the Xerox Nuvera 200/288/314 EA/MX Perfecting Production
System only. From this menu, select the specific print engine (Print Engine A1 Only
or Print Engine A2 Only) that you want the system to use to continue printing 1-sided
or 2-sided jobs when the other print engine is shut down. Pass Through Mode is in
effect and paper will simply pass through the idle print engine. Select Off to disable
Pass Through Mode and allow paper to print using both print engines.

• Crash Recovery: Last Sheet Delivered Not Known - If the system crashes while
printing a large job and you need to restart FreeFlow Print Server and reboot the
system, the system will attempt to perform a job recovery. If the system knows the
last sheet delivered to the finisher, the settings for this feature are not required and
the job is recovered automatically. However, in case the system crash affects the
finisher's ability to correctly detect the last sheet and automatically perform job
recovery, use this feature to select either [Use Best Guess](default) or [Do Not Recover
Job] from this drop-down menu to indicate the type of job recovery to use. Select
[Use Best Guess] if the last sheet delivered is not known and you want the system to
still attempt to recover the job. The system displays messages to check the output
for duplicate pages or missing sheets. Select [Do Not Recover Job] if you want to
recover the job, perform paper clearance and resubmit the job manually. The job
remains unrecoverable in the inactive queue. This feature is not used when the system
is only experiencing jam recovery or jam faults.

Note
After a system reboot (due to power outage/tripped breaker, kernel panic, or power
cycle using the white button), if the job does not recover correctly, the recommended
procedure is to open the Job Properties and set the Pages to Print values to the range
of pages remaining to be marked.
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• Recovery Offset Enabled - If selected, on systems equipped with either an MFF or
BFM only, the first recovered sheet delivered to the finisher following a jam will be
offset from the rest of the unfinished set (this applies to unfinished sets only and not
stapled sets). It is intended to help the operator examine the set for completeness
following a jam. Only the first sheet after recovery is offset.

• Stacker Auto Switching Rules - Select a method the system will follow to
automatically switch to another stacker when one stacker becomes empty. The
default, Closest Stcker First, allows the system to switch to the closest available
stacker. Select Round Robin for the system to switch to the next stacker in the
configuration (last stacker will switch to the first stacker). Select Fill One Stacker at
a Time for the system to completely fill both the inner and outer stacks before
switching to the next stacker in the configuration.

• Enable Tab Leading Sheets in IOT - Only available on the 200/288/314 systems.
This feature is accessible by a trained customer operator or a Xerox technical
representative only. It should always be selected to ensure that jobs containing precut
tabs are oriented correctly in Tabs Optimization Mode and will run optimally with
the print rate maximized. This feature should only be deselected if Print Engine A2
is unable to process precut tabs without damaging them.

System: Advanced User Diagnostics

If the Xerox Productivity Plus (XPP) or XPP Basic service options are enabled, this
diagnostic mode is intended for and accessed by a trained customer operator only. The
trained operator logs onto and accesses these advanced diagnostics to perform certain
repair and maintenance procedures without the need to contact Service. For more
information, refer to your XPP documentation or contact a Xerox sales representative.

MFF B (not applicable to the Xerox Nuvera 100/120 EA/MX Perfecting
Production System)
• dC1255 Booklet Staple Position Setup - used to align the staples on a folded booklet
• dC1254 Booklet Crease Position Setup - used to align the folded edge on a folded

booklet

Adjustments
The Xerox Nuvera is designed to work in Production publishing environments and perform
a high volume of printing. Because of this, the machine may require slight adjustments
to keep it working effectively. Click the links at the left for details about adjusting the
machine.
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Managing Paper Curl

To remove upcurl or downcurl (an upwards or downwards bend) in the paper in the
stacked output, your Nuvera system provides the ability for you to make the necessary
adjustments.

If your configuration does not include a Multifunction Finisher (MFF), you will use the
Sheet Enhancement Module (SEM) and the FreeFlow Print Server Adjust Decurler feature
to achieve sheet flatness in the stacker. If your configuration does include a MFF, you
will adjust only the Decurler Knob located in the print engine.

What Would Cause Paper to Curl?
• Your paper supply is exposed to a humid environment, or otherwise stored improperly
• You have begun using lighter-than-normal paper stocks (lightweight paper), carbonless

stock, or poor quality recycled paper
• You are experiencing jams in your finishing device, poor set registration or stacking

problems.
• Paper left in the tray or left out unwrapped may require a change in the SEM decurl

setting.
• Some papers require a different decurl setting for one-sided vs. two-sided jobs.

Note
Storing or using paper under humid conditions may increase paper curl. See Handling
and Storing Paper.

Caution
Do not use any paper that is not suitable for the system. For details on accepted papers,
see Supported Paper.
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How to Manage Paper Curl on Systems without a SEM

All Xerox Nuvera systems are equipped with a manual Decurler Adjustment Knob, or
dial, located near the fuser in the print engine. Adjusting the Decurler Knob minimizes
or eliminates curl in the stacked output.

However, only adjust the Decurler Knob to achieve paper flatness if your Nuvera system
includes a MFF.

How to Manage Paper Curl for Simplex Jobs
1. Open the right door of the Xerox Nuvera print engine module.
2. Locate the Decurler Knob near Area 4 of the print engine paper path.
3. Adjust the Decurler Knob to a higher setting to reduce upcurl and adjust to a lower

setting to reduce downcurl. The decurler introduces curl in the opposite direction of
the curl created in the paper path.

Most simplex jobs work best with the Decurler Knob set at 4. If you continue to experience
upcurl with the Decurler Knob set at the maximum, consider running jobs N-1. This will
cause a slight productivity loss. Printing N-1 is not to be used for stapled jobs or
transactional printing.

How to Manage Paper Curl for Duplex Jobs

For best performance, always set the Decurler Knob at the minimum for duplex jobs.

If you notice excessive upcurl, set the Decurler Knob at 4 and select the Reduce Upcurl
for 2-sided Jobs option. The system prints side 2 before side 1 thereby reducing curl in
the stacker. However, a slight productivity loss will occur. If you notice excessive downcurl,
set the Decurler Knob from 4 to MIN. If this is not enough, disable the Reduce Upcurl
for 2-sided Jobs option.

To enable or disable Reduce Upcurl for 2-sided Jobs:

1. Select System > User Diagnostics to open the User Diagnostics window.
2. Select System > System Optimization Customer Setting.
3. Check or uncheck Reduce Upcurl for 2 sided Jobs.

How to Manage Paper Curl using the Sheet Enhancement Module

The Xerox Nuvera systems (except for systems with a MFF) are equipped with a Sheet
Enhancement Module located to the right of the print engine. This module is designed
to automatically remove upcurl or downcurl in stacked paper as it passes from the print
engine through the SEM.

Xerox® Nuvera®14-12
User Guide and Training Aid (UGTA)

Maintaining Your Xerox Nuvera



If you notice excessive upcurl or downcurl in the paper in the stacked output, adjust the
Sheet Enhancement Module's setting at the FreeFlow Print Server interface to achieve
the amount of sheet flatness you need. By ensuring sheet flatness, the Sheet
Enhancement Module can prevent problems, such as paper jams and skew, and improve
print performance.

Note
For all systems with a SEM, it is recommended that you only use the Sheet Enhancement
Module to remove curl and do not adjust the Print Engine Decurler Knob. Make sure the
Decurler Knob remains set at MIN.

Use Automatic or Manual Mode

The amount of decurl applied to paper passing through the Sheet Enhancement Module
is set at the FreeFlow Print Server interface from the Printer menu.

The FreeFlow Print Server provides the option of operating the SEM in one of two modes:

• Auto Decurl Mode (default) - For optimal print productivity, use Auto Decurl Mode.
When selected, the system automatically calculates the amount of decurl to apply
using the target values in the NVM and the paper tray programming to best position
the decurler rolls. You must have set the correct paper properties in the Paper Tray
window for this mode to work accurately.

• Manual Decurl Mode - Adjusts the amount of decurling based strictly on the user's
decurl setting. Select when you want to manually adjust the amount of decurl to
apply.

How to Set the Auto Decurl Mode for Simplex or Duplex Jobs

Typically you will only need to select the Auto Decurl Mode. The system will automatically
calculate the amount of decurl to apply to your job. In this mode you can still use a slide
bar to make further setting adjustments.

If you are in the process of running a job and want to switch from using Auto Mode to
Manual Mode, you must first pause the job.
1. The Decurler Adjustment Knob located in the print engine should be set to MIN.
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2. From the menu bar, select Printer  > Adjust Decurler.
The Adjust Decurler window displays.

3. Select the Auto Decurl Mode radio button. The system uses the NVM values and the
paper properties to automatically calculate the amount of decurl to apply to the job.

4. Check your stacker and verify that the amount of sheet flatness is acceptable.
5. If you need to further adjust the calculated decurl setting, move the slide bar from

-1 to - 3 to decrease and remove downcurl. Move the slide bar from 0 to +3 to decrease
and remove upcurl. The value you select displays in the text field.

6. To select the default decurler setting (0), click Default.
7. Click OK to apply and save your setting.

The amount of decurl is immediately applied to the paper passing through the Sheet
Enhancement Module paper path.

8. When the job runs, check your stacker. If the stacked paper is still curled and the slide
bar settings are already at the highest or lowest setting, use Manual Decurl Mode.

9. Before switching to Manual Decurl Mode, pause the job.
10. In the Manual Decurl Mode area, move the slide bar to -5 to remove the downcurl.

Move the slide bar to +5 to remove upcurl.
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How to Set the Manual Decurl Mode for Simplex or Duplex Jobs
If you are in the process of running a job and want to switch from using Auto Mode to
Manual Mode, you must first pause the job. To make further decurl adjustments in
Manual Decurl Mode, follow these steps. Make sure the Decurler Knob in the print engine
is still set to MIN.
1. From the menu bar, select Printer  > Adjust Decurler.

The Adjust Decurler window displays.

2. Select the Manual Decurl Mode radio button.
The system defaults to +3 to compensate for slight upcurl.

3. Move the slide bar from -1 to -5 to decrease and remove downcurl. Move the slide
bar from 0 to +5 to decrease and remove upcurl.
The value you select displays in the text field.

4. To select the default decurler setting (+3), click Default.
5. Click OK to apply and save your setting.

The amount of decurl is immediately applied to the paper passing through the Sheet
Enhancement Module paper path.

6. When the job runs, check your stacker. Continue to adjust the settings as needed. If
this is a duplex job and the stacked paper is still experiencing upcurl with the slide
bar settings for both Auto and Manual Mode already at the highest setting, use the
Reduce Upcurl feature in the User Diagnostics window on the FreeFlow Print Server.

7. For a duplex job only, access user diagnostics and select System > User Diagnostics.
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8. Select System > System Optimization Customer Setting.
9. Enable Reduce Upcurl for 2-sided Jobs.

10. Make sure the SEM Manual Mode is set to -5.

The system prints side 2 before side 1 thereby reducing curl in the stacker.

Note
Do not use Reduce UpCurl if printing jobs with ordered stock or 3 hole punch stock. The
system will ignore this setting and print side 1 first.

Product Recycling and Equipment End of
Life Disposal: USA & Canada
• If you are managing the disposal of your Xerox product, please note that the product

contains lamp(s) with mercury and may contain lead, perchlorate, and other materials
whose disposal may be regulated due to environmental considerations. The presence
of these materials is fully consistent with global regulations applicable at the time
that the product was placed on the market.

• Xerox operates a worldwide equipment take back and reuse/recycle program. Contact
your Xerox sales representative (1-800-ASK-XEROX) to determine whether this Xerox
product is part of the program. For more information about Xerox environmental
programs, visit . For recycling and disposal information, contact your local authorities.
In the United States, you may also refer to the Electronic Industries Alliance web site
.

• Perchlorate material - This product may contain one or more perchlorate-containing
devices, such as batteries. Special handling may apply. Please see

European Union

WEEE Directive 2002/96/EC

Some equipment may be used in both a domestic/household and a professional/business
application.

Equipment used in a domestic/household environment.

Application of this symbol on your equipment is confirmation that you should not dispose
of the equipment in the normal household waste stream.

Xerox® Nuvera®14-16
User Guide and Training Aid (UGTA)

Maintaining Your Xerox Nuvera



In accordance with European legislation end of life electrical and electronic equipment
subject to disposal must be segregated from household waste

Private households within EU Member States may return used electrical and electronic
equipment to designated collection facilities free of charge. Please contact your local
disposal authority for information.In some Member States when you purchase new
equipment your local retailer may be required to take back your old equipment free of
charge. Please ask your retailer for information

Equipment used in a professional/business environment

Application of this symbol on your equipment is confirmation that you must dispose of
this equipment in compliance with agreed national Procedures.

In accordance with European legislation, end of life electrical and electronic equipment
subject to disposal must be managed within agreed procedures.

Prior to disposal please contact your local dealer or Xerox representative for end of life
take back information.

Contact Information

For more information on Environment, Health and Safety in relation to this Xerox product
and supplies, please contact the following customer help lines.

USA and Canada: 1-800-828-6571

Europe: +44 1707 353 434

Other Countries: Please contact your local waste authority and request disposal guidance.
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15
Cleaning Procedures

In order to keep the Xerox Nuvera in good working condition, it is important to carefully
clean it at regular intervals. Depending on your work environment, your cleaning schedule
may be frequent or occasional.

Click the links at the left to learn how to clean the system.

Cleaning the Document Glass
In order to produce high-quality images, free from defects, it's important to keep the
Xerox Nuvera clean.

Depending on your work environment, you may need to perform these steps frequently.

There are two areas that comprise the Document Glass:

• Document Feeder Scan Area
• Main Document Glass

Spots and specks in the Document Feeder Scan Area can show up as streaks on copies
made when using the Document Feeder.

Additionally, dirt on the Document Glass can show up as spots on copies made from the
Document Glass.

Specks and dirt can cause image detection problems. The scanner may interpret
contamination as part of the image, and produce faulty copies.
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To clean the document glass

Caution
To avoid damage to the machine, do not pour or spray water or cleaner directly on the
document glass of the Xerox Nuvera . Do not use any abrasive cleaners to clean the
document glass of the Xerox Nuvera .

Recommended cleaning materials:

• Soft, lint-free cleaning towels (part # 600S4372).
• Xerox Glass Lens and Mirror Cleaner (part # 8R3669) (See

CRU/Maintenance/Consumables part names and numbers).

For information on ordering supplies, see Contacting Xerox.
1. Apply cleaner to the cleaning towel.
2. Wipe the entire Document Glass with the dampened towel, until the glass is free of

dirt and smudges.
3. Wipe the Document Feeder Scan area on the far left side of the glass. Wipe in one

direction along the divider strip.
4. Using a clean, dry cleaning towel, wipe away any cleaner residue.
5. See Cleaning the Document Feeder.

Cleaning the Document Feeder
Cleaning the Document Feeder at regular intervals will help to prevent misfeeds.

Depending on your work environment, you may need to perform these steps frequently.

To clean the document feeder

Caution
To avoid damage to the machine, do not pour or spray water or cleaner directly into the
Xerox Nuvera . Do not use any abrasive cleaners to clean the Xerox Nuvera .

Recommended cleaning materials:

• Soft, lint-free cleaning towels (part # 600S4372).
• Xerox Glass Lens and Mirror Cleaner (part # 8R3669) (See

CRU/Maintenance/Consumables part names and numbers).

For information on ordering supplies, see Contacting Xerox.
1. Dampen one end of a towel with Xerox Lens and Mirror Cleaner (part # 8R3669).
2. Open the Document Scanner Top Cover. Clean the Nudger Rollers and all visible,

black-colored surfaces.
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3. Close the Document Scanner Top Cover and raise the Document Feeder. Clean the
rolls and all visible, black-colored surfaces.

4. Clean both parts of the Document Glass. See Cleaning the Document Feeder.
5. Lower the Document Feeder.

Note
It is important to clean the white Nudger Rollers to prevent poor paper feeding, misfeeds,
and multi-feeds.

Cleaning Dry Ink (Toner) Spills
There may be a time when Dry Ink gets spilled while changing containers, or may leak
during usage.

If Dry Ink is spilled or inadvertently gets into the paper path or anywhere else in the
machine, the best course of action is to contact a Xerox Service Representative. They
have equipment specifically suited for dealing with Dry Ink spills.

For details, see Contacting Xerox.

Warning
Do not attempt to use a standard shop vacuum or home vacuum to clean Dry Ink. These
types of vacuums are not equipped with correct filtration.

Cleaning the Display
If the control panel display gets dirty or smudged, use this procedure to clean it.

Depending on your work environment, you may need to perform these steps frequently.

To clean the display

Caution
To avoid damage to the machine, do not pour or spray water or cleaner directly into the
Xerox Nuvera . Do not use any abrasive cleaners to clean the Xerox Nuvera .

Recommended cleaning materials:

• Soft, lint-free cleaning towels.
• Xerox Glass Lens and Mirror Cleaner (part # 8R3669) (See

CRU/Maintenance/Consumables part names and numbers).

1. Dampen a cleaning towel with Xerox Glass Lens and Mirror Cleaner.
2. Gently wipe the display until it is free of dust and smudges.
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3. Wipe away any cleaner reside with a clean, dry towel.

Cleaning the 'Optical' Mouse
Dirt and dust settling on the Xerox Nuvera machine can work its way into the mouse,
causing the user difficulty in efficiently navigating the controls on the machine display.

Depending on your work environment, you may need to perform these steps frequently.

To clean the 'optical' mouse

Caution
To avoid damage to the machine, do not pour or spray water or cleaner directly into the
Xerox Nuvera . Do not use any abrasive cleaners to clean the Xerox Nuvera .

1. With a damp lint-free cloth, clean the exterior of the entire mouse. Be sure to clean
the four pads on the bottom of the mouse that come in contact with the surface your
mouse travels on.

2. With a damp lint-free cloth, clean the center scrolling wheel. Roll the wheel with your
finger to clean all exposed surfaces.

3. Pick up the mouse and turn it over. Using a damp cotton swab, clean the plastic area
in front of where the red optical light is emitted.

4. Use a dry cotton swab to remove any remaining moisture from step 3.
5. With a damp lint-free cloth, wipe off the surface (mouse pad or directly on the Xerox

Nuvera) your mouse travels on.

Cleaning the Keyboard
Depending on the environment where your system is placed, keeping the keyboard free
of dirt and other contaminants will assure quick and accurate job programming.

To clean the keyboard

Caution
To avoid damage to the machine, do not pour or spray water or cleaner directly into the
Xerox Nuvera . Do not use any abrasive cleaners to clean the Xerox Nuvera .

Cleaning the keyboard can be performed fairly quickly. It is recommended that you
perform the following actions before the machine is started, or after the machine is
completely shut down for the day.
1. Over a waste container, turn the keyboard upside down and gently shake to allow

any large contaminant particles to fall out.
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2. Using canned air (commonly found at office supply stores), direct the air stream
directly at the keys, blowing away any remaining dust and other contaminants.

3. Using a lightly moistened cloth, gently wipe down the keyboard; including the keys
and any surface where contact occurs.
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16
Problem Solving

The Xerox Nuvera is designed to allow the user to easily correct any problem that may
arise. Click the links at the left for details on correcting system problems. Contact your
System Administrator if these topics do not help you solve the problem.

Mode Indicator Icons
The feature modes that are in effect on the system are displayed as icons in the status
indicator window in the upper right of the user interface above the printer graphic. The
mode icons only display when that feature is in effect and active. For example, when
the Logging mode icon displays, the logging feature is on and the system is recording
an event history for diagnostics.

Move the cursor on top of each icon to view information on where to find that feature
and how to disable it when not needed.
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The following mode icons that display on the user interface when in effect are:

Enhanced Image Permanence (EIP) mode

Diagnostics mode

Logging mode

Not Accepting mode

Not Releasing mode

Secure mode

Job Fault mode

Remote Workflow mode

Fault Messages
Messages are displayed in the Message window on the UI revealing a status or fault
that requires action. An icon is also displayed by the machine mimic indicating that
there may be a problem requiring action.

Attention Light
The Attention Light located on top of the Control Console alerts you that the system
requires attention.

A blinking light indicates that production has been interrupted and the system requires
attention. Follow the fault message instructions.

A steady light indicates a functional capability problem. Follow the fault message
instructions.

You can turn the Attention Light on or off by selecting Printer: Attention Light to display
the Attention Alerts window. Make the Attention Light settings.

The status of the Attention Light can be determined by selecting Printer and looking for
Attention Light On or Attention Light Off.
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Paper Curling
Paper curl can be caused by several factors such as, relative humidity, paper weight,
paper size, sides imaged or amount of image. Too much paper curl can cause jams, poor
set registration and poor stacking quality.

The Xerox Nuvera offers a Sheet Enhancement Module that can be adjusted to ensure
sheet flatness in the paper sent to the stacker. To learn more go to Managing Paper
Curl.

Poor or Slow System Performance
If your machine performance becomes degraded, or it ceases to function correctly for
any reason, executing a Restart will usually restore correct functionality. If the problem
continues, contact your Xerox representative.

Related Hints and Tips

There are several things that affect the performance of the system and RIP speed when
processing print jobs. The following is a list of common situations that negatively can
impact throughput:

• The nature of printing is that the complexity of images is non-deterministic until
those images are being processed so that rated speed of the engine is not guaranteed
during RIP. When printing multiple sets of a document, Nuvera retains all images
after RIP for all subsequent sets. Therefore, any performance penalty encountered
will only be experienced during the first set.

Note
The default print resolution is 1200 dpi. 600 dpi printing may be adequate for your
job. Try setting your resolution to 600 dpi to improve the RIP performance of complex
1200 dpi jobs. 1200 dpi results in four times the internal image data of a comparable
600 dpi image that has to be transferred through the system. When the print
resolution is changed from 1200 to 600 dpi, the stroke thickening value may also
need to be changed from 1 to 0 to avoid excessive line thickening.

• It is common to embed logos and watermarks in submitted print files. These are
typically bitmap images that, when embedded in a print stream (such as PostScript),
can take a long time to process. Note also that resolution selections, such as 600 dpi
vs. 1200 dpi, can have a significant further impact on processing of these types of
embedded images. Consider the design of documents and impacts to printing speed
in such cases. There are methods available, through PostScript for example, to cache
these embedded images, process them once, and retain them as a resource for
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application on each page without having to render and scale them for each page.
Refer to your PostScript reference manuals and FreeFlow Print Server reference
manuals for information about caching.

• Submission of multiple TIFF images simultaneously is a common application. There
are several batch printing tools available on the market. Most of them require the
selection of a print driver for the target printer through which these images files are
submitted. In these cases, the TIFF files are converted to a Printer Description
Language (PDL), such as PostScript, by the batch tool using the printer driver. Then
they are submitted to the printer, which in turn RIPs that PDL and re-renders the TIFF
bitmap images back into bitmaps. This is an inefficient process that can significantly
slow the machine down. Nuvera includes a native TIFF interpreter that can process
TIFF files sent to it directly. Some of the batch tools on the market support a native
TIFF submission capability. It may be referred to as a bypass mode or something
similar. If such a capability is available, the Nuvera's performance can be significantly
improved by taking advantage of that capability.

Note
When printing to a DFA-compliant 3rd party finisher, do not select Bypass Transport
as the output location.

• The PDF Optimization feature should not be used when printing PDFs that were saved
in FreeFlow Print Server using the RIP Save or Scan to File selections. These types of
documents will take much longer to RIP when PDF Optimization is enabled. Before
enabling PDF Optimization, it is recommended that the user run performance tests
using representative customer jobs.

Restart procedures

Please see the Restarting the System topic for more information.

Improving print speed and productivity

Please see the Improving Print Speed Performance topic for more information.

Improving Print Speed Performance

Use the Parallel RIP feature for complex documents

If you have the Xerox Nuvera 200/288/314 EA/MX Perfecting Production System, you
can enable the Parallel RIP feature to improve image processing time and increase RIP
print speeds for long jobs with nonrepeating images.

For more information about using Parallel RIP with the Xerox Nuvera 200/288/314
EA/MX Perfecting Production System, see Printing with the Parallel RIP feature.
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Enable the Wide Stock feature when printing 9.25 inches or 9.5
inches wide stock

If you are printing stock greater than 9.0 inches wide up to 9.5 inches wide, you can
optimize the print speed of the job by selecting the Wide Stock feature from the Printer
menu on the FreeFlow Print Server user interface.

For details on how to enable this feature, refer to Optimizing productivity for jobs
containing wide stocks measuring 9 - 9.5 process direction.

How page/image size affects Pitch

The system senses paper sizes requested, and optimizes the use of the belt and the paper
path to ensure maximum productivity. For details on how page image size impacts belt
pitch, which in turn impacts overall throughput, see About Pitch.

PDF to PS conversion

The PDF to PS conversion is a streaming workflow which allows the RIP to begin before
the entire PDF to PS conversion is complete. Since the PDF to PS conversion is streaming,
file size limitation is not an issue.

Variable Data image caching

Variable Data image caching retains repeated image data to achieve improved RIP
performance. Caching and reusing this data makes processing of variable data jobs
more efficient, and results in significant performance gains at the printer, especially in
jobs with many repeated images.

Note
You can enable or disable image caching in the IPDS Manager without restarting the
FreeFlow Print Server. In addition, you can program the image caching option on a per
job basis using the IPDS Job Profile user interface.

Solving Image Quality Problems
The Xerox Nuvera is capable of reproducing and generating high-quality images.

However, image defects may occur. These image quality problems are usually attributed
to a defective original, or the user applying too much, too little, or the wrong type of
image quality control.
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Image quality and system maintenance

Image defects can also occur because the Xerox Nuvera is in need of maintenance. The
condition of the photoreceptor belt, transfer blade and heat roller can affect the amount
of dry ink (toner) transferred onto the paper.

Click on the links at the left to learn how to differentiate between machine and original
problems, and how to avoid image quality problems.

Solving dark or light image problems

Using the Image Quality selection on the Printer menu, you can globally set the darkness
and resolution levels for system supported file types. Check the Image Quality tab settings
if you are having image quality problems on a consistent basis (for example, your entire
job is either too light or too dark).

If you are using the Xerox Nuvera 200/288/314 EA/MX Perfecting Production System,
the machine typically ensures that the print darkness between the print engines is equal
and balanced. However, if you notice light or dark image quality differences between
side 1 and side 2 of the print job, check the dC965 user diagnostic routine before
contacting Service

Tip
Before running any jobs, click Printer  > Image Quality to quickly determine what global
machine darkness and resolution settings are currently configured.

Note
See your System Administrator to change the darkness and/or resolution settings on
the Image Quality window. If you are using the Xerox Nuvera 200/288/314 EA/MX
Perfecting Production System and side 1 of your job is either lighter or darker than side
2, refer to the image quality diagnostic routine, dC965, for more information.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do the job programming pertinent to your job.

Removing Moiré Patterns from Images (when scanning or copying)

The following excerpt is taken from Real World Scanning and Halftones by Glenn
Fleishman, David Blatner, and Steve Roth:

"Moiré ("mwah-RAY") patterns are caused by our eyes' perception of straight lines and
repeating patterns. Anytime you overlay a bunch of straight lines or grids on top of each
other, you have the opportunity for moiré patterns. One grid, all by its lonesome, never
has a problem with these patterns. It's when you have two or more overlaid on each
other that the wires in your perceptual system get crossed, and these little gremlins start
to appear."
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Moiré patterns occur when scanning copying an original that is comprised of a halftone.
Moiré is a form of digital artifact that occurs when two regular patterns intersect to form
a new pattern. Because the new pattern is always more coarse that the two original
patterns, the appearance will change as a function of screen frequency and angle.
Typically, the finer of the two originals patterns are the easier it is to see the Moiré.
Lower frequency halftone screens are less prone to visible Moiré.

Moiré can occur while viewing scanned halftones on a monitor screen, because the
monitor has a certain screen frequency, which may or may not be in alignment with the
screen frequency and angle of the original image.

Suggestions for removing moiré patterns:
• From Copy or Scan Services, select the Image quality tab.
• If your image contains a halftone, make sure you are NOT using Text Mode. If legibility

of the the text is important, and good reproduction of any pictures is also needed,
consider using Mixed Text & Halftones as the original type.

• Decrease the Sharpen control slightly. See Adjusting Sharpness (when scanning or
copying).

• Rotate the original slightly on the Document Glass.
• Scan/Copy at the highest possible resolution capable by the system.
• Wherever possible, scan/copy continuous tone images (for example, photographs)

only. If there is no continuous tone original available, scan/copy the halftoned image
as a last resort.

• When submitting a print job, you may need to select a different halftone.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

Examples

Figure 21. Result of two distinct patterns superimposed
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Figure 22. Patterns with distinct screen angle and LPI frequency superimposed to form Moiré pattern.

About Halftones and Gray Levels

A halftoned image is a series of dots arranged in a patterned grid of halftone cells, which
yields the appearance of a complete image.

Screen frequency refers to the number of rows of halftone cells. The higher the screen
frequency (in lines per inch) the sharper the halftone image appears (see 33 and 75 LPI
examples in the figure).

Screen angle refers to the number of degrees from vertical at which the halftone grid is
set. The halftone is set at an angle (usually 15, 45, or 75 degrees), to reduce moiré
patterning. The idea behind halftone screens is to make the dots as fine as possible, so
that the image itself is more visible that the dots. The observer will tend to focus on the
'big picture' while ignoring the microscopic halftone texture. When the dots are so fine
that the eye can not resolve them, the image appears to be continuous.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.
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Go to Choosing the Best Halftone Setting for information on the Production System
Screen Frequency Demo Job.

Removing Lines, Streaks or Shadows (when copying or scanning)

This problem can usually be attributed to a poor original, or a dirty scanner. Try one or
a combination of the following to correct the problems.

To remove lines, streaks or shadows

• Clean the Document Glass, especially near the white plastic ramp on the left edge
of the glass, if using the Document Feeder

• Run the job from the Document Glass
• Check the quality of the original. Use Border Erase or Edge Erase to remove lines from

the edges of the document
• Turn on Background Suppression
• Load fresh paper

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

If the problem continues, you may want to run the Corotron Cleaning Routine under
User Diagnostics. See your Xerox Representative for advice.

Correcting Posterization (when scanning or copying)

Obvious "stair-stepping," or sudden shifts in tones, rather than smooth transitions in
areas of tonal gradation (see left half of figure), is called Posterization. It results because
of a lack of available gray levels. The number of gray levels is determined by the number
of dots in a halftone cell.

To correct posterization
If you are copying or scanning a halftoned or photographic image, and getting posterized
output, try the following:
1. On the Home Screen, click Copy.
2. On the Image Quality tab, click the Original Type button and make sure Mixed Text

and Graphics is not selected.
3. If satisfied with settings, click the Copy button.

Other options include:

• Scan at a higher resolution.
• Select a Original Mode with low contrast.
• Use the Contrast Control to lower the contrast.
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For more details about posterization, see About Posterization and Gray Levels.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

About Posterization and Gray Levels

The number of dots in a halftone spot determine the number of available gray levels.
For example, a four by four dot halftone cell will yield 17 gray levels (multiply 4 x 4 =
16, + 1 for either all dots on [black] or all dots off [white]). A 16 x 16 dot halftone cell
will yield 257 gray levels (multiply 16 x 16 = 256, + 1 for either all dots on or all dots off).

However, there is an inverse relationship between the halftone screen frequency and
printer resolution. When you have a halftone with a high screen frequency, you are
asking the printer to create more "spots" per inch. In order to create more spots, the
spots must become smaller. In other words, a finer halftone screen slices the printer dot
grid into smaller cells. When halftone cells shrink in size, the number of dots in each cell
is reduced. This results in fewer available gray levels, and leads to images becoming
posterized.

Therefore, ways to maintain gray level availability are:

• Use a lower screen frequency when scanning at high resolution
• Scan at lower output resolution when using fine halftone screens

Note
This information is important when scanning below 600 dpi. It does not apply to copy
or during reduction.

Note
For more information on how halftone screen frequency and printer resolution are
related, consult Real World Scanning and Halftones, 2nd Edition by Blatner, Fleishman,
and Roth.
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Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

Correcting Halo (when scanning or copying)

Halo appears as objects in an image looking artificial, or not quite matching their
surroundings. A faint glow or "halo" surrounds objects in the scanned image (see the
numbers on the sail in the figure).

Reducing Sharpness also minimizes aliasing (jaggies on lines).

To decrease sharpening
1. Click the Copy Services button, then select the Image Quality tab.
2. Select the Image Adjustments button.
3. Decrease the amount of sharpness by moving the slider control to the left, or entering

a lower number in the text box to the right of the slider control.
4. Click the Copy button when satisfied with your adjustments.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

Removing Background Artifacts (when scanning or copying)

If your original document is on colored stock, the output copy may display background
artifacts.

Background is only detected on the first few mm of the lead edge. Ensure the lead edge
is not solid black and the document is registered against the registration edge indicated
on the platen.

To remove background artifacts
1. In the Xerox Nuvera user interface, click the Copy Service button.
2. Click the Image Quality tab.
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3. Click the Image Adjustments button.
4. Make sure the Background Suppression Normal checkbox is enabled. It is on by

default.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

Removing Image Show Through (when scanning or copying)

When scanning translucent originals, sometimes the image on the back side of the page
is detected, resulting in a scan of the image on the other side of the sheet (see figure).

Figure 23. Example of Show Through

To correct image show through
1. In the Xerox Nuvera user interface, click the Copy Services button.
2. Click the Image Quality tab.
3. Click the Image Adjustments button. Verify that the Background Suppression

Strong checkbox is enabled. If it is not, click in the checkbox.
4. Click Copy to scan or copy your document.

Tip
While this selection is not recommended for documents with pictures, select the Image
Quality tab and click on Original Type, then click Text if you are scanning an image
from a two-sided page. The scanner will not attempt to interpret and scan the image
that shows through from the second side.

Tip
When scanning a two-sided original, to reduce or eliminate image show through, place
a piece of dark (preferably black) paper behind the original document before scanning.
You can also leave the platen glass cover open when scanning.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.
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Removing Spots & Specks (when scanning or copying)

If you notice spots or specks on your image, try the following:

• Clean the Document Glass

• Clean the Document Feeder

Clean the Document Glass

Dirt and dust in the work environment, finger prints, and paste-up residue from documents
will gradually build up on the Document Glass. Sometimes this shows up on scans as
specks or spots.

Optimally, the Document Glass should be cleaned at the start of each work day.

Clean the Document Feeder

Though the Document Feeder is mainly enclosed, dirt and paper dust can get into the
paper path and rollers, causing spots, streaks and specks on the output image.

Optimally, the Document Feeder should be cleaned at the start of each work day.

Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking Clear All or Reset
in the user interface. Then proceed to do job programming pertinent to your job.

Recovering Missing Parts of the Image

If the image you are printing is comprised of very fine lines and/or you are printing at
high resolution (for example, 1200 x 1200 dpi), there may be instances when those parts
of the image may not appear on the final output.

To recover missing parts of the image
To recover missing parts of an image, you must change the PostScript stroke thickening
control from 0.0 to 1.0.
1. On the Printer menu, select Image Quality.
2. Double-click the PostScript processing resolution you wish to change (there may be

several). The PostScript/PDF Image Quality window appears.
3. Select a True Type Spot Size to adjust the darkness of the scalable font.
4. Select a Font Rendering to process the jobs containing Adobe Type 1 scalable fonts.
5. Define, in pixels, the amount of thickening or darkening to apply to the font in the

Font Thickening box.
6. Use Half Bitting to remove digital edge roughness.
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Tip
If you have programmed and run a job, and received unexpected results, ensure that
the system-wide settings are all set back to their defaults by clicking <Clear All> or
<Reset> in the user interface. Then proceed to do job programming pertinent to your
job.

Removing Drill Holes From Output (when scanning or copying)

If you are scanning or copying originals that have been drilled for insertion in a multi-ring
binder, or the paper is otherwise damaged at the edge, you may notice black holes or
other unacceptable marks on one edge of your output image. Electronic Hole Removal
can be enabled to eliminate such defects.

Tip
The Electronic Hole Removal feature is also useful for removing output image defects
caused by folded-over corners (dog-ears) and/or torn edges located within approximately
one inch from the edge of the original document.

Note
Electronic Hole Removal is only functional for originals placed in the Document Feeder.
For details, see Using the Document Feeder.

Note
Electronic Hole Removal is NOT available when Photo is the Original Type selected.

To remove drill holes from output
1. Place original documents in the Document Feeder.
2. Make sure Electronic Hole Removal is enabled.

a) Click the Copy button.
b) Select the Image Edit tab.
c) Click the Edge Erase button.
d) Select Electronic Hole Removal. It should have a checkmark in it. If it does not,

select None from the Edge Erase list.
This will enable the Electronic Hole Removal control.

3. When you are satisfied with your settings, click Copy.
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17
Clearing Paper Jams

In the event of a paper jam, the paper path has been designed to allow the user to easily
clear the jam and continue the job. Take the time to familiarize yourself with the following
procedures on clearing paper jams.

Clear jams from left to right and in the order shown in the message displayed on the
User Interface. Try to avoid tearing any jammed sheets.

It is more desirable to prevent paper jams from occurring. Proper handling and storage
of paper stocks will minimize jams. For details, see Handling and Storing Paper.

Warning
Metallic surfaces in the fuser area are hot. Please use caution when removing paper
jams from fuser areas, and avoid touching any metallic surfaces.

Tip
If the system declares a jam in the feeder at area 2, check area 2 and area 1 since the
sheet may be stuck in between.

Tip
If you experience multi-sheet feed jams at any of the paper trays, make sure that the
paper actually loaded in the tray matches what has been programmed in the user
interface.

Tip
If you load any type of drilled paper, to aid in sheet separation and to prevent jams, fan
the reams before loading into the tray.

Note
For 100/120/144 speeds, the recovery procedure for the 12-2505 fault is improved. The
jam clearance procedure instructs you to unload the main stacker. These sheets are now
all considered good. After closing the front door, the system instructs you to open the
top main cover and remove and discard the sheets from area 3. After the sheets have
been removed, close the top main cover. The system will purge any other sheets in the
system before resuming the job. If any sheets on the stack are damaged or poorly
stapled, the operator may have to remake those sheets/set when the job is done.
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Note
For 157 and 314 systems with a SRM/BFM configuration, recovery faults will require you
to clear all sheets manually. Sheets are not purged to the top tray. To learn how to clear
paper jams in the SRM, refer to Clearing Jams in the Sheet Retime Module.

There are a few rare cases in which sheets can fall from the Compiler Arms onto the
stacker. Check your output for any duplicates. The status message informs the user to
mark the stack and check output for duplicates.

Paper jam notification
When paper becomes jammed anywhere in the paper path, the Xerox Nuvera notifies
you by one or more of the following:

• a text notification in the status area of the User Interface, describing the location of
the jam. Double-clicking the notification will launch a window providing more
information about the problem.

• a machine "mimic," or pictorial representation of the machine on the UI screen,
depicting the location of the jam.

• a steady or blinking Attention Light.

Clearing jams in the Xerox Nuvera
200/288/314 EA/MX Perfecting
Production System Print Engines
During paper jam recovery, the two print engines coordinate automatically so that after
both paper paths are cleared, the job can start printing at the correct position.

Clearing jams in the BFM Plus Area 2
When accessing a jam clearance in area 2, gently open the Bypass Unit cover to the first
stop.

Warning
When you raise the Bypass Unit cover to clear a paper jam, do NOT raise the Bypass
Unit cover beyond the first stop.The Bypass Top Cover may open suddenly, causing a
risk of injury to anyone standing behind the finisher.
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Tip
An unclearable jam situation may occur that requires service intervention. To minimize
this occurrence, for any jam condition, clear the offending jam and then check and clear
area 6 of the print engine before closing door for cycle up.

Clearing Jams in the Sheet Retime Module
For Xerox Nuvera 157/314 systems with a single BFM, the Sheet Retime Module (SRM)
is required to be installed in front of the BFM. Use the following information to clear
any paper jams that may occur in the SRM.

Note
Refer to the Xerox Nuvera user interface for any clearance instructions.

Caution
When clearing long sheets that overlap areas, you may need to open more than one
area at a time to remove the sheet. If you open areas 1 and 2 or 1 and 3 simultaneously,
make sure to open each area only slightly and not fully. These areas cannot be fully
open at the same time or they will touch each other.

Note
When clearing a paper jam in both areas 1 and 2, make sure to open area 2 first and
then area 1. If a sheet jams between areas 1, 2 and 3, open area 2 first, then area 3 or
1. Pull sheets out of one area first and then the other.

1. Make sure jobs have stopped printing.
2. Open the interlocked SRM Front Door.

When the safety interlock opens, it removes power to the module.
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3. Locate Area 1. Pinch the green levers (1) to release pressure. Continue to grasp the
levers and move them to the right. Remove the paper completely and return the
levers to their original position.

4. Locate Area 2. Pinch the green levers (2) to release pressure. Continue to grasp the
levers and move straight up. Remove the paper completely and return the levers to
their original position. Use strength to make sure to push into position fully.
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5. Locate Area 3. Pinch the green levers (3) to release pressure. Continue to grasp the
levers and move it to the left. Remove the paper completely and return the levers to
their original position.

6. Locate Area 4. Pinch the green levers (4) to release pressure. Continue to grasp the
levers and move it to the left. Remove the paper completely and return the levers to
their original position.

7. Close the SRM Front Door.
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Paper Purge
When a paper jam occurs, paper is purged from the paper path. Paper purges to the
following areas:

• The first top tray after the print engine

• Area 5b of the print engine

Please see the topics below for more information.

Note
For the Xerox Nuvera 200/288/314 EA/MX, the paper is purged to area 5b of both print
engines as required.

Top tray paper purge

This is the default purge location. However, for a 157 system with a SRM/BFM
configuration, jammed sheets in the BFM or SRM are not purged to the Top Tray. Make
sure to manually clear all sheets in those two modules.

Area 5b paper purge

Area 5b can be accessed by a door located at the lower front right corner of the print
engine.

This paper purge location is enabled by default. If for any reason you want to disable
the area 5b purge, follow these steps:

1. Logon to the FreeFlow Print Server as a System Administrator.

Note
Accessing the User Diagnostics mode pauses the printer.

2. Select System and User Diagnostics.

3. From the left navigation bar, select System Optimization Customer Setup.

4. Select/deselect the checkbox next to Enable Area 5B Purge.

5. Select OK to apply the setting.

6. Select File and Close.

7. Resume the printer.
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18
Clearing Stapler Jams

In the event of a stapler jam, the system staplers have been designed to allow the user
to easily correct the jam and continue with the job. Take the time to familiarize yourself
with the following procedures on clearing staple jams. In addition, view the videos
depicting clearing jams.

Stapler jam notification
When any of the staplers become jammed, the Xerox Nuvera will provide notification
by:

• alpha-numeric messages
• a machine "mimic", or pictorial representation of the machine on the UI screen,

depicting the location of the jam
• a steady or blinking Attention Light.

Note
If stapling is not possible due to out of staples and this condition is detected prior to
running the job, the system shall hold the job until the staples can be replaced, but will
allow other jobs to proceed.

Note
If stapling is not possible due to out of staples and this condition is detected while the
job is running, the system shall hold the job and wait until the staples can be replaced
or the job to be cancelled before continuing to run other jobs.

To clear stapler jams
Double-click the system alert to see details on the action needed, as well as the location
of the staple mechanism.
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Access the Main Stapler Mechanism in the MFF
1. Once you have identified the location of the stapler, open the access panel and locate

the stapler housing. It is identified with a pictorial representation of a staple.
2. Grasp the stapler housing drawer handle and pull out towards you.
3. There are pictorial instructions affixed to the machine chassis near the stapler access.

Follow these pictorial instructions in order to remove and replace the Main Stapler
Cartridge.

Access the Main Stapler Mechanism in the BFM or BFM Plus
1. Once you have identified the location of the stapler, select Printer  > Unlock Finisher

in the User Interface.
The Unlock Base Finisher window appears.

Note
Staple error messages will automatically unlock the finisher.

2. In the Stapler Drawer field, click Unlock.
3. Pull out the Stapler Drawer.
4. There are pictorial instructions affixed to the machine chassis near the stapler access.

Follow these pictorial instructions in order to remove and replace the staple cartridges.
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19
Machine Specifications

The Xerox Nuvera machine is available in several configurations. The configuration you
have may include an insertion module, a Sheet Enhancement Module and any number
of feeding modules and finishing options. Click the subtopics at the left to learn about
each machine subsystem, as well as machine capabilities.

Supported Paper
The Xerox Nuvera will accept a wide variety of paper types and sizes. For best results,
use only the papers mentioned in this topic. For more information, see Recommendations
for Paper Usage.

For details on expected performance of papers through the system, see Expected Paper
Handling.

For details on paper handling and storage, see Handling and Storing Paper.

Compatible Stock Types
• Uncoated papers
• Coated papers (except for systems with an MFF)
• Transparencies
• Tabs
• Envelopes
• Label stock
• ID cards

Warning
Do NOT use envelopes with latex-based glue closures. For example, self sealing envelopes
contain latex-based glues, and should NEVER be used.
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Paper size tables

Supported Paper Sizes: Trays 1 and 2

Supported Paper Sizes: Trays 3 and 4

Supported Paper Sizes: Trays 1 and 2

SizePaper TypeFeed
Orientation

LEF(long edge
feed)

SEF (short edge
feed)

mmInches

X228.6 x 279.49 x 11Letter Cover

X184.15 x 266.77.25 x 10.5Executive

X194 x 2677.64 x 10.5116 K (Taiwan)

X210 x 2708.27 x 10.63210 x 270

X215 x 2758.46 x 10.83215 x 275

X216 x 2738.5 x 10.75216 x 273

X215.9/216 x
279.4

8.5 x 11Letter

X223 x 2978.78 x 11.69A4 Cover

X226 x 3108.89 x 12.2226 x 310

X320 x 22512.59 x 8.86SRA4
2 up-A5

X210 x 2978.27 x 11.69A4

X215 x 3158.46 x 12.4Spanish XE

X177.8 x 2547 x 107 x 10

X182 x 2577.17 x 10.12B5 -- JIS

X203.2 x 2548 x 108 x 10

X148 x 2105.83 x 8.27A5

X139.7 x 215.95.5 x 8.5Statement (See
note below)

Note
The Xerox Nuvera 200/288 EA/MX Perfecting Production System no longer supports
Statement paper but continues to support A5 paper. In addition, the Xerox Nuvera
200/288 EA/MX Perfecting Production System now supports up to 19.33 inches (491
mm) in the process direction.
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Supported Paper Sizes: Trays 3 and 4

SizePaper TypeFeed
Orientation

LEF(long edge
feed)

SEF (short edge
feed)

mmInches

X184.15 x 266.77.25 x 10.5Executive

X194 x 2677.64 x 10.5116 K (Taiwan)

X210 x 2708.27 x 10.63210 x 270

XX215 x 2758.46 x 10.83215 x 275

XX216 x 2738.5 x 10.75216 x 273

XX215.9/216 x
279.4

8.5 x 11Letter

XX228.6 x 279.49 x 11Letter Cover

X241.3 x 279.49.5 x 119.5 x 11 tabs

X267 x 38811 x 17Ledger

X267 x 38810.51 x 15.288K (Taiwan)

XX210 x 2978.27 x 11.69A4

XX215 x 3158.46 x 12.4Spanish XE

XX223 x 2978.78 x 11.69A4 Cover

XX226 x 3108.89 x 12.2226 x 310

X320 x 22512.6 x 8.86SRA4
2-up-A5

X317.5 x 241.312.5 x 9.52up-6 x 9

X297 x 42011.69 16.54A3

X310 x 43212.2 x 17.01310 x 432

X320 x 45012.6 x 17.71SRA3
4up-A5

X304.8 x 457.212 x 1812 x 18

X304.8 x 469.912 x 18.512 x 18.5

X317.5 x 469.912.5 x 18.54 up-6 x 9

X182 x 2577.17 x 10.2B5 - JIS

XX203.2 x 2548 x 108 x 10

X252 x 3589.92 x 14.09SB4

X257 x 36410.12 x 14.33B4-JIS
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SizePaper TypeFeed
Orientation

LEF(long edge
feed)

SEF (short edge
feed)

mmInches

X203.2 x 330.28 x 138 x 13

X210 x 3308.27 x 12.99210 x 330

X215 x 3308.46 x 12.99215 x 330

X215.9 x 330.28.5 x 13Foolscap - XE

X220 x 3308.66 x 12.99220 x 330

X210 x 2708.27 x 10.63210 x 270

X215.9 x 355.68.5 x 14Legal

Recommendations for Paper Usage

Usage RecommendationPaper Type

Not supported on systems with a Multifunction Finisher.Coated stocks

Otherwise, stocks coated on both or only one side are supported.
When printing on stocks that have only one side coated, load
the coated side up.

For systems that do not have the Productivity Pack license en-
abled:

• Normal - 56 to 84 gsm (ex: standard copier paper, inkjet
paper)

• Medium - 85 to 105 gsm (ex:slightly heavier than Normal.
Good for brochures, advertisements)

• Heavy - 106 to 280 gsm (index cards, cover stock, posters)

For systems with the Productivity Pack license enabled, you can
enter exactly the paper weights for the stock that is being
loaded. The upper limit of the stock weight is determined by
the finisher on the system.
When using the BFM, the system supports:

• 56 gsm - 280 gsm uncoated stock
• 90 gsm - 280 gsm coated stock

A system with a MFF supports:

• 56 gsm - 220 gsm uncoated stock; coated not supported

The weight range supported on a system with a DS3500 de-
pends on the 3rd party device, but most are 56 gsm - 280 gsm
for uncoated stock and 90 gsm - 280 gsm for coated stock.

Paper weight range

If you are loading any type of drilled paper, to aid in sheet
separation and to prevent jams, it may be helpful to fan reams
before loading into the tray.

Drilled stocks
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Usage RecommendationPaper Type

Loading limit in Paper Feeder trays: 50 sheets.Transparency or Mylar rein-
forced sheets

Loading limit in Paper Feeder trays: 50 sheets.
Load with stripe down on the lead edge.

Note
For dedicated transparency trays, first place approximately half
an inch (12 mm) worth of plain paper at the bottom of the tray.
This will ensure that all 50 of the transparencies get used.

Removable stripe transparen-
cies

• LEF
• Loading limit in Paper Feeder trays: 50 sheets.

Label Stock

• LEF
• For 1 to N printing order, load with top (white) sheet on top
• For N to 1 printing order, load with top (white) sheet at the

bottom

Carbonless Forms

• 6"x9"
• 9"x12"
• 162x229
• 220x312
• Types: Closed flap, flap on long edge.
• Loading orientation: Address side up and flap-side leading
• Output to MFF top tray only
• Loading capacity limit - 60
• Output to top tray limit - 15** **More than 15 envelopes can

be output to the tray, as long as the tray is tended and
emptied every 10-15 envelopes.

Booklet Envelope (closed flap)

• 6"x9"
• 7"x10"
• 162x229
• 178x254
• Type: Open flap.
• Loading orientation: Address side up and and flap oriented

towards operator.
• Output to MFF top tray only
• Loading capacity limit - 60

Catalog Envelope (open flap)

Do Not Use.Window stock
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Usage RecommendationPaper Type

• Design the preprinted image so that no ink, varnish, or
aqueous coating is placed in the area to be printed. Toner
adhesion can not be assured when printing over inks or var-
nish. If the image must be printed over pre-printed ink, results
are more likely to be acceptable if the color is screened back
to less than 30% or the base stock is uncoated paper

• Select papers printed with laser-compatible, lithographic
inks to minimize offsetting. UV-cured inks are recommended,
especially on coated stocks, to insure complete drying before
printing on a Xerox Nuvera. Laser inks can be oxidative, or
heat set types.

• Do not use papers preprinted with xerographic processes.
• Select preprinted sheets that are free of excessive curl.
• Select base paper stock approved for use on a Xerox Nuvera

system.
• Refer to the Xerox Nuvera Production Paper Guide for more

Information.

Preprinted materials

• DocuCard sheet with a single card
• LEF for 8 x 11" and A4
• SEF for 11 x 17"
• Loading capacity 50 sheets
• If using a Tiltatron, capacity is 200 sheets in trays 1 and 2.

DocuCards

Loaded with side to be imaged facing up, and glued end to the
left.

Paper backed transparencies

Requires the same IB/OB dimension for all sheets.Mixed size sheet handling in
Document Feeder and Multi-
function Finisher

Related Information
• Supported Paper
• Expected Paper Performance Tables
• Configuring Paper Stocks and Trays
• Adding Pages To A Document

Document Feeder & Scanner Specifications
Note
This feature is only available if your system includes the integrated Document Scanner
module for copying and scanning jobs.

The scanner includes the Simultaneous Duplex Document Feeder ("Document Feeder")
and the Document Glass (or "Platen").
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The Document Feeder uses a Constant Velocity Transport (CVT) to scan each page as
it passes the stationary scan module. The Document Feeder can scan both sides of a
page at once (hence the name "Simultaneous Duplex"), using a second CVT to move
the document past the second scan module. This reduces the time required for copying
or scanning 2-sided originals.

The Document Glass provides a means for scanning documents that cannot be fed
through the Document Feeder, such as fragile, bound, and extra large documents. The
maximum paper size that can be placed on the platen is 12.6 inches x 18.5 inches (image
size 12.0 inches x 18.0 inches). The original is placed face down on the Document Glass
and the scan module passes under the Document Glass.

For details on proper usage of the Document Feeder, see Using the Document Feeder.

Document Feeder Paper Capacities and Capabilities

SpecificationItem

11 x 17 inches (279.4 mm x 432 mm) (see
NOTE below)

Maximum paper dimensions

5.5 x 8.5 inches (140 mm x 216 mm)Minimum paper dimensions

300 sheets (20 lb. bond, 75 gsm weight)
Weight 13 lb. bond to 113 lb. index (49 to 250
gsm)

Paper capacity

8-bit Gray (256 shades) at 600 x 600 dpi 120
images per minute one-sided 8.5 x 11"/A4 - 120
sheets per minute
120 images per minute two-sided 8.5 x 11"/A4
- 60 sheets per minute

Resolution
Throughput

Note
A5 and Statement stock should be fed SEF(Short Edge Feed). LEF (Long Edge Feed) of
A5 and Statement stock is not supported by the Document Handler.

Note
A 12x18 inch original will travel through the Document Feeder, but some information
on the output may be lost. To ensure all image information from a 12 x 18 inch original
is captured, use the Document Glass.

Print Engine Specifications
Before making prints with the Xerox Nuvera System, take the time to learn about its
capabilities and capacities.
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Fuser Temperature

180/195 degrees Celsius (356 degrees Fahrenheit) when printing in Normal mode on
144/157 systems respectively.

EIP Mode: 200 degrees Celsius (392 degrees Fahrenheit)

Registration

Benchmark registration system holds image to sheet alignment at +/- .65mm per side
and front-to-back on Letter/A4 size papers; +/- .75 mm per side and front-to-back on
Tabloid/A3 size papers.

Printer Resolution

4800 x 600 dpi

RIP (Raster Image Processor) Resolutions

The Parallel RIP feature is available on the Xerox Nuvera 200/288 EA/MX Perfecting
Production System, increasing processing time and RIP speed for complex jobs. For more
information about Parallel RIP, see Printing with the Parallel RIP feature.

The processor can process images for printing (RIP) at the following resolutions:

• 600x600 dpi - The 600 dpi option provides faster performance when processing and
saves files that are smaller in size

• 1200x600 dpi
• 1200x1200 dpi - 1200 dpi is the system default

Print Quality (halftone screens)

The base configuration (without the Enhanced Line Screen license enabled) supports
only a 125 lines per inch (lpi) halftone screen. With the Enhanced Line Screen license
enabled, the system supports 85, 106, 125, 134, and 156 lpi halftone screens.

Print Engine Type

Xerographic monochrome (black and white) only. The single engine models provide one
of the following speed licenses: 100, 120, 144 or 157 EA Production Systems or 100, 120
or 144 MX Production Systems.

The Xerox Nuvera 200/288/314 EA and Xerox Nuvera 200/288 MX Perfecting Production
Systems are comprised of two EA Production System print engines (A1 and A2).
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Printer Speed

The Xerox Nuvera EA Production System can be licensed to support 100, 120, 144 or
157 ppm print speeds. The Xerox Nuvera MX Production System supports 100, 120, or
144. For systems with a Multifunction Finisher, only 100 and 120 are available.

The Xerox Nuvera EA Perfecting Production System can be licensed to support 200, 288
or 314 impressions per minute at duplex mode with 2 - 3 Parallel RIP running on the
dual core CPU. The Xerox Nuvera MX Perfection Production System supports 200 or 288.

Note
*Print speeds will be impacted on 157/314 systems with an SRM/BFM configuration
when running tab jobs and stock sizes 7.0 inches to 8.2 inches.

Images Per Minute (ipm)Pages Per Minute (ppm)Xerox Nuvera System

100 ipm simplex
100 ipm duplex

100 ppm simplex
50 ppm duplex

Xerox Nuvera 100 EA Produc-
tion System

120 ipm simplex
120 ipm duplex

120 ppm simplex
60 ppm duplex

Xerox Nuvera 120 EA Produc-
tion System

144 ipm simplex
144 ipm duplex

144 ppm simplex
72 ppm duplex

Xerox Nuvera 144 EA Produc-
tion System

157 ipm simplex 157 ipm du-
plex

157 ppm simplex 78 ppm du-
plex

Xerox Nuvera 157 EA Produc-
tion System*

100/144 ipm simplex
200/288 ipm duplex

144 ppm simplex
144 ppm duplex

Xerox Nuvera 200/288 EA/MX
Perfecting Production System

157 ipm simplex 314 ipm du-
plex

157 ppm simplex 157 ppm du-
plex

Xerox Nuvera 314 EA Perfect-
ing Production System

Variable Pitch Xerographics for maximum throughput

The Xerox Nuvera is equipped with a variable pitch Xerographic belt. Pitch refers to the
number of page images that can be placed on the belt, which are then transferred to
the paper. For details on how page image size impacts belt pitch, which in turn impacts
overall throughput, see About Pitch.

Dry Ink (Toner)

For the Xerox Nuvera Production Systems and Xerox Nuvera Perfecting Production
Systems, EA dry ink or MICR ink is used.

Paper Sizes Supported

Nuvera EA

• Minimum size: A5 / 5.5 inches x 8.5 inches (140 mm x 216 mm)
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• Maximum size: 12.2 inches x 18.5 inches (320 mm x 470 mm)

Xerox Nuvera 200/288 EA/MX Perfecting Production System

• Minimum size: A5 / 5.7 inches x 8.5 inches (144 mm x 216 mm)
• Maximum size: 12.2 inches x 19.33 inches (320 mm x 491 mm)

For details on papers supported, see:

• Supported Paper
• Recommendations for Paper Usage
• Expected Paper Handling and Copy Performance

Machine Warm-up Times

From cold start (ex: first thing in the morning): 4.5 to 7 minutes

From power saver mode: 3.5 minutes

From system restart: 4 to 5 minutes

FreeFlow Print Server Capabilities

All of the Xerox Nuvera systems are driven by one FreeFlow Print Server. For more detail
on system information, select Setup from the FreeFlow Print Server menu bar.

• Removable storage device(s): DVD - R/W drive
• Ethernet connector type: 10/100/1000 BaseT
• PDL (Printer Description Language) support: PostScript Level 3, HP/PCL 5e & PCL 6,

TIFF, Multi-page TIFF, Adobe PDF, ASCII, PPML, LCDS, IPDS
• Network protocols supported: TCP/IP, LPR, IPP, HTTP, AppleTalk, Novell (SPX-IPX),

SNMP

Xerox Nuvera 100/120/144/157 EA Production System
• System Processor: Dual Core 2.8 GHz, 250 GB SATA hard drive, 4 GB of RAM, up to 5

available USB ports, DVD-RW drive, one 10/100/1000 Megabit Ethernet port for
customer use

• Monitor screen: 19-inch (size may vary depending on location) flat color LCD monitor
operated with USB keyboard and mouse

Xerox Nuvera 200/288/314 EA/MX Perfecting Production System
• System Processor: Dual Core 3.0 GHz, 250 GB SATA hard drives, 4 GB of RAM, up to

5 available USB ports, DVD-RW drive, one 10/100/1000 Megabit Ethernet port for
customer use

• Monitor screen: 19-inch (size may vary depending on location) flat color LCD monitor
operated with USB keyboard and mouse
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Note
A second optional hard drive is available. Also, there is an optional kit to add 4GB and
replace the 3.0 GHz Dual Core processor with a 2.66 GHz Quad Core processor.

For details on printing from a client, see Printing a Job from your Networked PC.

Multifunction Finisher (MFF)
Specifications
The Multifunction Finisher offers the basic publishing option on the Xerox Nuvera EA
Production System. It is the only finisher in the configuration and can not be followed
by any other finishing devices. It provides stacking and stapling capabilities as well as
the ability to make booklets and trifold documents.

There are two MFF models available.

• The Professional is a finisher that provides high capacity collating, stacking and
stapling. It also allows the ability to make booklets and trifold documents. This model
consists of a Top Tray for collecting or purging sheets, a Main Tray and a Bottom
(Booklet) Tray.

• The Pro Plus is the Professional model with added functionality provided in the
Interface Module area. The Interface Module contains a sheet insertion module as
well as a hole punch module. The post process insertion capability of the MFF Pro
Plus can insert covers, preprinted tabs and colored paper. The hole punch module
offers either a 2 and 3 Hole Paper Punch or a 2 and 4 Hole Paper Punch that allows
you to punch 2, 3 or 4 holes in the printed document, depending on the paper punch
installed and the finishing hole punch option selected.

Using the MFF

Go to Using the Multifunction Finisher (MFF)for information on how to use the MFF.
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Specifications

MFF Pro PlusMFF Professional

Same250 sheets of 20 lb bond (75
gsm) or equivalent
Output to the Top Tray is de-
livered with Side-1 down and
sets are not offset. It can be
set as a destination tray for
non-stapled jobs. Sheets less
than 7 inches in the process
direction or 8 inches in the
cross-process direction will
automatically go to the Top
Tray. The Top Tray also re-
ceives sheets that are purged
from the system.

Top Tray

Does not accept hole punched
finishing output

250 sheets of 20 lb bond (75
gsm) or equivalent
Output to the Top Tray is de-
livered with Side-1 down and
sets are not offset. It can be
set as a destination tray for
non-stapled jobs. Sheets less
than 7 inches in the process
direction or 8 inches in the
cross-process direction will
automatically go to the Top
Tray. The Top Tray also re-
ceives sheets that are purged
from the system.

Bottom/Booklet Tray

200 sheets of 20 lb bond (75
gsm) or equivalent
56-220 gsm
Delivers output to all 3 trays

Not availableInsertion Tray

Same3000 sheets of 20 lb bond (75
gsm) or equivalent
The stack limit can be set from
the UI for each BFM independ-
ently.
Stapled sets with <15 sheets
are limited to 100 sets.
The Stacker is the output tray
for receiving compiled stapled
and unstapled sets as well as
single sheets. Output is nor-
mally delivered with side-1
down and sets can be offset.

Main Tray/Stacker Capacity
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MFF Pro PlusMFF Professional

SameUp to 100 sheets of 20 lb bond
(75 gsm) (one or two staples)
or equivalent substrates (re-
duced stapled sheet capabilit-
ies can result based on sub-
strate properties (i. e. thickness,
density, material, coating, etc.)
Includes two internal pass-
through 100 sheet upside
down staplers. The stapler
devices have the ability to por-
trait, landscape or dual staple
all supported paper sizes. Fin-
ished sets can be stacked in-
ternally to the lower stacker
tray.
If either of the Staplers runs
out of staples see Replacing
Staples in the BFM or if it jams
see Clearing Stapler Jams.
An alternate Staple Cartridge
for up to 30 sheets of 20lb is
available. (75-80 gsm) paper
capacity. Contacting Xerox for
information on ordering refills.
Each Stapler Cartridge holds
5000 staples. Contacting Xerox
for information on ordering re-
fills.

Stapler Capacity

Same8.26 in to 18.5 in (210 mm to
457 mm)
8.26 in to 12 in (210 mm to
305 mm)

Paper Size Range
process direction
cross process direction

Same16 lb bond to 113 lb index (56
to 220 gsm)
No coated stock

Stock Weight Range
uncoated:
coated:

The MFF Professional Model

MFF Stapling

Portrait, Landscape and Dual stapling is available for all media types, except Tabs and
Transparencies. Stapling is offered for mixed sized sets if the length of the feed edge is
the same size for all sheets.

For details and specifications on the staplers, see Stapler Specifications.
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MFF Capacities

The Xerox Nuvera Multifunction Finisher (MFF) adds the finishing touches to your job
by collating and stapling your output. The MFF Professional can be used to make folded
and stapled booklets and various folding options; Folded-Only Booklets, Tri-Fold
C-Configuration and Z-Configuration folded documents.

• 2,250 sheet total capacity of 20 lb. (75-80 gsm) paper or equivalent
• 250 sheet Top Tray
• 2,000 sheet Main Tray
• 1 and 2 Position Stapling in Main Tray
• 100 sheet staple capacity, sizes 8.5 x 14 inch or B4 and smaller. Contacting Xerox to

order this consumable part.
• 50 sheet staple capacity paper sizes over 8.5 x 14 inch or B4. Contacting Xerox to

order this consumable part.

Top Tray

Output to the Top Tray is delivered with Side-1 down and sets are not offset. The Top
Tray can hold up to 250 sheets of 20 lb. (75-80 gsm) or equivalent paper. It can be set
as a destination tray for non-stapled jobs. Copies that are less than 6.7 inches long in
feed direction or 8 inches in the cross-feed direction will go to the Top Tray rather than
the Main Tray. The Top Tray also receives sheets that are purged from the system when
using the Main Tray or the Bottom Tray.

Main Tray

The Main Tray is the output tray for receiving compiled stapled and unstapled sets as
well as single sheets. Output is delivered with Side-1 down and sets are offset. It can
staple up to 100 sheets of 8.5 x 11 inch or A4 LEF, and 8.5 x 14 inch or B4 SEF of 20 lb.
(75-80 gsm). It also can staple up to 50 sheets for paper sizes over 8.5 x 14 inch or B4
SEF of 20 lb. (75-80 gsm). Portrait, landscape, and dual position stapling are available.

"Stack Limit" allows you to set the Main Tray to the size of the stack from 200 to 2500
sheets. Once the set stack limit is achieved, the system will cycle down and display an
Empty Main Tray message. The default setting is 2500 sheets.
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Bottom (Booklet) Tray

The Bottom Tray is the output tray for receiving compiled stapled and unstapled booklets.
It can receive up to 20 booklets of 15 sheets maximum of 8.5 x 11 inch or A4, 8.5 x 14
inch or Foolscap, and 11 x 17 inch or A3 20 lb. (75-80 gsm) or equivalent thickness with
the Bottom Tray Stop in the up position. It also can receive Folded-Only Booklet up to
5 folded sheets per set of 8.5 x 11 inch or A4, 8.5 x 14 inch or Foolscap, and 11 x 17 inch
or A3 or equivalent thickness with the Bottom Tray Stop in the up position. It can receive
Tri-Fold C-Configuration and Tri-Fold Z-Configuration of single sheets only of 8.5 x 11
inch or A4 SEF.

When using the MFF for folded output, the Banner Sheets that separate your print jobs
from one another will come out folded on the long axis of 8.5 x 11 inch or A4 paper,
allowing the customer to see separation easier.

Booklet Making
• Folded Only Booklets 1-5 sheets
• Folded and Stapled Booklets 2-15 sheets
• Sizes from 8.5 x 11 inch or A4, 8.5 x 14 inch or Foolscap, and 8.5 x 17 inch or A3

The Booklet Maker on the Professional Finisher produces Booklets ( Folded Only and
Folded and Stapled ) and Letter Tri-Fold (C- and Z-Configuration).

All Booklet and Tri-Fold jobs must use SEF oriented paper supply.

The Booklet Maker can fold 1-5* sheets or fold and staple 2-15* sheets of the following
papers:

OrientationPaper Size

SEFmm (WxL)Inch (WxL)Name

X216x2798.5x11Letter

X210x2978.27x11.69A4

X215x3308.5x13Foolscap

X216x3568.5x14Legal

X297x42011.69x16.54A3

X279x43211x17Ledger

*Booklet Maker: 15 sheets or less of 80 gsm (20 lbs) or equivalent thickness, e.g., 12
sheets of 80 gsm (20 lbs) with one cover of 200 gsm.

Fold: 5 sheets or less of 80 gsm (20 lbs) or equivalent thickness.

Tri-Folding enables bulk mailing applications and ease of fit into standard U.S. #10
business size and DL (A4) size envelopes.
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Special materials such as transparencies, drawing film, labels, and coated stocks are not
compatible with the Booklet Maker.

Finished jobs are delivered to the Bottom Tray with side 1 down. If you use Banner
Sheets, they will be folded LEF orientation to separate jobs in the tray.

Folding Options (single sheets only)
• C-Configuration and Z-Configuration folds
• Output 8.5 x 11 inch or A4 only

Finisher Pause Button

Removing output while the Finisher is running may produce sets that are incorrectly
stapled. The Finisher Pause Button delays processing to allow you to remove finished
sets from the main tray without disturbing sets in progress.

The Finisher Pause Button is located near the right front corner of the top cover. When
selected, it affects the operation of the Main Tray only.

To activate the Finisher Pause feature
1. Press the Pause Button.
2. Wait for the tray to lower.
3. Unload the tray.
4. Press the Pause Button again to continue subsequent processing.

Note
The finisher will pause after producing between 80 to 100 sets of thin sets (2-15 sheets).
This allows you to unload the finisher. It automatically resumes printing after a lapse
of 1 minute.

The MFF Pro Plus Model

Post Process Insertion Tray

Use this insertion tray on the MFF Pro Plus to add covers, preprinted sheets or tabs into
your job, and program these sheets as Special Pages at the FreeFlow Print Server interface.

Hole Punching

This finishing option is selectable from the Output tab of the Job Properties window.
Select Stapling/Finishing and the Stapling/Finishing pull-down menu. If the 2/3 Hole
Paper Punch is installed, you can select 2 or 3 hole punch and the various hole placement
options such as portrait or landscape, and top or bottom. If the 2/4 Hole Paper Punch
is installed, you can select either 2 or 4 hole punching along with the same placement
options. Your output punched documents can then be placed in a 2, 3 or 4-ring binder.
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Select the Multiple Finishing option from the same Finishing area on the FreeFlow Print
Server to simultaneously select stapling and hole punching for the job.

Paper Specifications for the Hole Punch Module

WeightSizeType

56-200 gsm171-321mm (6.74-12.63 in)
width
148-457mm (5.83-17.99 in)
length

2-punch

56-200 gsm232-321mm (9.14-12.63 in)
width
148-457mm (5.83-17.99 in)
length

3-punch

56-200 gsm255-321mm (10.04-12.63 in)
width
148-457mm (5.83-17.99 in)
length

4-punch

Insertion Tray Capacities

The MFF Insertion Tray specifications are:

• Holds and feeds up to 200 sheets of 20 lb bond (75 gsm), all same stock size
• Accepts media weight of 56 - 220 gsm
• Accepts sizes of 176-470 mm (6.93 - 18.5 in) length and 176-298 mm (6.93 x 11.73

in) width

For more information about loading special stock such as tabs, refer to Loading Special
Stock for Proper Finishing Output.

Configurations

The MFF is the basic configuration on the Xerox Nuvera EA Production System and is
the only configuration that does not include the Sheet Enhancement Module (SEM).
The Sheet Enhancement Module is a standard component on systems with a BFM or
DS3500.

The diagrams below show the MFF finishing configuration options.
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Figure 24. Print Engine / MFF Professional (can include an SFM Insertion Module)

Figure 25. Print Engine / MFF Pro Plus (can include an SFM Insertion Module)
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Xerox Production Stacker (XPS)
The Xerox Production Stacker (XPS) with Document Finishing Architecture (DFA) Finishing
is a finishing option available for the Model IV Nuvera.

This finishing device provides output trays that eject and rise to near waist height of
the user. If the height selected is not appropriate, this height can be adjusted. The sheet
capacity for these output trays is increased from other stackers. The XPS stacks 5,700
(2 stacks of 2,850). The stacker can be released to unload while the system is still running
and printing, which allows for constant production. This is also true when using a single
stacker.

For more detailed information about the XPS, refer to the Xerox Nuvera® Xerox
Production Stacker Operator Manual.

Basic Finishing Module (BFM/BFM Plus)
Specifications
The BFM is a finisher that provides high capacity collecting, stacking and stapling. It
also includes a top tray for collecting or purging sheets.

Note
For 157/314 systems with one of the BFM models, a Sheet Retime Module is required
to be installed before that single BFM to enable stapling and speed rate. Paper sizes less
than 6.9 inches (175mm) in the process direction are not supported in this configuration.
Tab jobs and paper sizes between 8.2 and 7.0 inches will run at less than 157 ppm.
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The Xerox Nuvera System offers the following BFM models:

• The BFM is a finisher that provides high capacity collating, stacking and stapling. It
also includes a top tray for collecting or purging sheets.

• The BFM Plus is comprised of the Bypass BFM and the Interface Module. The BFM
Plus module provides the same capabilities as the BFM. However, it does not have a
top tray and does include a bypass paper path that allows the BFM Plus to pass pages
through an Interface Module (IM) to another BFM or through an Interface Module
and Finishing Transport Module to other DFA-compliant finishers.

• The BFM Plus Top Tray with Direct Connect is comprised of the Bypass BFM with
an Interface Module that has Top Tray capabilities and is able to connect directly to
a DFA-compliant finisher(s). The DFA-compliant finishers are limited to devices that
have an 860mm height, Center registration, and a velocity of 1130mm/s.

Using the BFM

Go to Using the Basic Finishing Module (BFM) for information on how to use the BFM
and all of the adjustments that affect the BFM.

Capacities

Stacker
• 3,000 sheets total capacity of 20 lb. (75-80 gsm) paper or equivalent.
• The stack limit can be set from the UI for each BFM independently.
• Stapled sets with <15 sheets are limited to 100 sets.
• It can staple up to 100 sheets of 8.5 x 11 inch or A4 LEF, and 8.5 x 14 inch or B4 SEF

of 20 lb. (75-80 gsm). Portrait, landscape, and dual position stapling are available
• The Stacker is the output tray for receiving compiled stapled and unstapled sets as

well as single sheets. Output is normally delivered with side-1 down and sets can be
offset.

• You can use a combination of 3 finishers maximum.

Top Tray
• 250 sheets of 20 lb. (75-80 gsm) paper or equivalent.
• Output to the Top Tray is delivered with Side-1 down and sets are not offset.
• It can be set as a destination tray for non-stapled jobs.
• Sheets less than 7 inches in the process direction or 8 inches in the cross-process

direction will automatically go to the Top Tray. The Top Tray also receives sheets
that are purged from the system.

• Paper size greater than 18.5 inches in the process length will run to the top tray only.
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Stapler
• The Basic Finishing Module has two internal pass-through 100 sheet up side down

staplers. The stapler devices have the ability to portrait, landscape or dual staple all
paper sizes between 5.5"x8.5"; / A5 and 12.6"x18.5 inches. Finished sets can be stacked
internally to the lower stacker tray.

• These staplers have the capability of stapling 100 sheets of 20lb. (75-80 gsm) or
equivalent substrates (reduced stapled sheet capabilities can result based on substrate
properties (i. e. thickness, density, material, coating, etc.).

• If either of the Staplers runs out of staples see Replacing Staples in the BFM or if it
jams see Clearing Stapler Jams.

• An alternate Staple Cartridge is available with 30 sheets of 20lb. (75-80 gsm) paper
capacity. Contacting Xerox for information on ordering refills.

• Each Stapler Cartridge holds 5000 staples. Contacting Xerox for information on
ordering refills.

Specifications

BFM PlusBFM

Only available on the Bypass
BFM Top Tray with Direct Con-
nect

250 sheets of 20 lb bond (76
gsm) or equivalent
Output to the Top Tray is de-
livered with Side-1 down and
sets are not offset. It can be
set as a destination tray for
non-stapled jobs. Sheets less
than 7 inches in the process
direction or 8 inches in the
cross-process direction will
automatically go to the Top
Tray. The Top Tray also re-
ceives sheets that are purged
from the system.

Top Tray Capacity

Same3000 sheets of 20 lb bond (76
gsm) or equivalent
The stack limit can be set from
the UI for each BFM independ-
ently.
Stapled sets with <15 sheets
are limited to 100 sets.
The Stacker is the output tray
for receiving compiled stapled
and unstapled sets as well as
single sheets. Output is nor-
mally delivered with side-1
down and sets can be offset.

Stacker Capacity
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BFM PlusBFM

SameUp to 100 sheets of 20 lb bond
(75 gsm) (one or two staples)
or equivalent substrates (re-
duced stapled sheet capabilit-
ies can result based on sub-
strate properties (i. e. thickness,
density, material, coating, etc.)
Includes two internal pass-
through 100 sheet upside
down staplers. The stapler
devices have the ability to por-
trait, landscape or dual staple
all supported paper sizes. Fin-
ished sets can be stacked in-
ternally to the lower stacker
tray.
If either of the Staplers runs
out of staples see Replacing
Staples or if it jams see Clear-
ing Staple Jams.
An alternate Staple Cartridge
for up to 30 sheets of 20lb is
available. (75-80 gsm) paper
capacity. Contact Xerox for in-
formation on ordering refills.
Each Stapler Cartridge holds
5000 staples. Contact Xerox
for information on ordering re-
fills.

Stapler Capacity

Same8.26 in to 18.5 in (210 mm to
457 mm)
8.0 in to 12 in (200 mm to 305
mm)

Paper Size Range
process direction
cross process direction

Same16 lb bond to 113 lb index (56
to 280 gsm)
90 to 280 gsm

Stock Weight Range
uncoated:
coated:

Note
For information on how to use the BFM and BFM Plus and send documents to the stacker,
see Using the Basic Finishing Module (BFM) and Delivering Document Sets to the Stacker.

Configurations

There are a number of possible Feeder and Finishing combinations when installing the
Sheet Feed Modules, the Insertion Modules, the BFM, XPS and other external finishers
on a Xerox Nuvera system.
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Note
For increased productivity, the system can support up to four SFM feeders, up to two
Insertion Modules, and up to three XPS Modules. The BFM and BFM Plus or BFM Plus
and BFM Plus can be installed together to double the stacker capacity.

Configuration examples for the 100/120/144 and 200/288 system include:

The diagrams below highlight some of the more common finishing configuration options.
Only the Nuvera EA Production System with a MFF does not include a Sheet Enhancement
Module, which is always located directly after the print engine (or second print engine
on the 200/288/314 system).

Figure 26. Print Engine / Sheet Enhancement Module / BFM

Figure 27. Print Engine / Sheet Enhancement Module / Insertion Module / BFM

Figure 28. Print Engine / Sheet Enhancement Module / BFM Plus/ BFM
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Figure 29. Print Engine / Sheet Enhancement Module / Insertion Module / BFM Plus/ BFM

Figure 30. Print Engine / Sheet Enhancement Module / XPS -->connects to DFA compliant 3rd party
Finisher

Figure 31. Print Engine / Sheet Enhancement Module / Insertion Module/ XPS -->connects to DFA
compliant 3rd party Finisher
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Figure 32. Print Engine / Sheet Enhancement Module / Insertion Module/ BFM Plus/ DS3500 or XPS
-->connects to DFA compliant 3rd party Finisher

Figure 33. Print Engine / Sheet Enhancement Module / Insertion Module / BFM Plus / BFM Plus/ DS3500
or XPS -->connects to DFA compliant 3rd party Finisher

Note
If you have a GBC AdvancedPunch® Pro finisher, it will be installed before the XPS
Modules.

Configuration examples for the 157/314 systems with a BFM:

For a Xerox Nuvera 157/314, if a single BFM (BFM, BFM Plus or BFM Direct Connect) is
in the system configuration, the Sheet Retime Module (SRM) is required to be installed
directly in front of the BFM.
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The following lists some of the common SRM/BFM configurations.

• Print Engine / Sheet Enhancement Module / Sheet Retime Module / BFM
• Print Engine / Insertion Module / Sheet Retime Module / BFM
• Print Engine / Sheet Enhancement Module / Sheet Retime Module / BFM Plus / XPS
• Print Engine / Sheet Enhancement Module / Insertion Module / Sheet Retime Module

/ BFM Plus / XPS
• Print Engine / Sheet Enhancement Module / Sheet Retime Module / BFM Direct

Connect / XTB
• Print Engine / Sheet Enhancement Module / Insertion Module / Sheet Retime Module/

BFM Direct Connect / XTB

Stapler Specifications
• Basic Finishing Module Stapler

• Multifunction Finisher

• Stapler Maintenance

Basic Finishing Module Stapler

For more information, see Basic Finishing Module Specification

Multifunction Finisher

If the Xerox Nuvera is equipped with a Multifunction Finisher, this finisher includes two
stapling systems:

• Main Stapler
• Booklet Stapler

Before using any of the staplers on the Xerox Nuvera , take the time to learn about their
capabilities and capacities.

Document Size Requirements

Short Edge size range: 8 inches to 12 inches

Long Edge size range: 6.7 inches to 18 inches
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Stapling Limit

The Main Stapler will accommodate either a 50 Sheet Stapler Cartridge or a 100 Sheet
Stapler Cartridge. The maximum staple limit is either 50 sheetsof 80gsm (20lb.) paper
or 100 sheets of 80gsm (20lb.) paper. Papers of heavier weights or larger sizes will reduce
the maximum staple limits, accordingly.

Staple Cartridge Limitation

The machine software currently does not distinguish between the 50 Sheet Staple
Cartridge and the 100 Sheet Staple Cartridge. This means that if the 50 Sheet Staple
Cartridge is loaded in the machine, and a job with more than 50 sheets is sent to be
stapled, a mis-staple or stapler jam will probably occur. If the 50 Sheet Staple Cartridge
is used, it is the responsibility of the operator to ensure that jobs exceeding 50 sheets
are not submitted for stapling.

Stock Weight / Maximum Sheets

100 Sheet Cartridge
Capability

50 Sheet Cartridge
Capability

Weight (UI Classification)

1005015 to 22 lb. (Normal)Small Paper Sizes (A4,
Letter, Legal)

70 (105 gsm)35 (105 gsm)22+ to 28 lb. (Medium)

30 (216 gsm)15 (216 gsm)28+ lb. (Heavy)

505015 to 22 lb. (Normal)Large Paper Sizes (9 x
14, B4, A3, & Ledger)

5035 (105 gsm)22+ to 28 lb. (Medium)

30 (216 gsm)15 (216 gsm)28+ lb. (Heavy)

Stapler Maintenance

If either of the staplers runs out of staples, or jams, see Clearing Stapler Jams or Replacing
Staples in the Finishers.

Keyboard, Mouse & Display Specifications
The User Interface (UI) provides the means for the user (operator) to interact with a
printer, copier, or Multifunctional device. Architecturally, the UI is a client of services
within the printer, copier, or Multifunction device.

The user interface consists of the controls by which a user issues commands to a device
or system, and the displays by which the device or system informs the user of the current
state, its functions, and its processes.
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The UI will also provide a graphic display for messages, information, instructions, menus
and machine diagram (mimic).

Keyboard Specifications

USB

Navigating the user interface using only the keyboard

The Xerox Nuvera user interface, in addition to being navigable with the USB mouse,
can also be navigated through the keyboard.

Some examples of why the user interface is keyboard-accessible:

• Blind people cannot use a mouse because they cannot see where to click. They use
their keyboard almost exclusively.

• Some individuals with neuromuscular impairments cannot use a mouse either.

For information on keyboard accessibility, see Special Navigation / Activation Keyboard
Shortcuts.

Common Keyboard Shortcuts

You can use the keyboard to navigate the UI and program jobs. For a complete set of
documentation on keyboard navigation, see Keyboard Operations on the Sun/Java
website.

User Interface Components Key

Focusable Component: Any button or control in the UI that can be clicked or have data
entered into it.

Character: A letter or number inside an editable text field.

Pane: One of 3 main areas of the user interface: the status area, service buttons (Copy,
Print, etc...) on the left side, and the main content/tab area.

Keyboard Focus: The UI component that is enabled for some input from the user. This
is visible in the UI as a blue border around the component.

ActionKeyboard Operation

Navigates to the next focusable component.Tab

Navigates to the previous focusable compon-
ent.

Shift+Tab

Navigates to the next focusable component.
This works even if the component that previ-
ously had focus accepts tabs; for example this
is how to escape out of tables once a table
element gets focus.

Control+Tab
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ActionKeyboard Operation

Navigates to the previous focusable compon-
ent. This works even if the component that
previously had focus accepts tabs; for example
this is how to escape out of tables once a table
element gets focus.

Shift+Control+Tab

Moves focus left one character or component.Left arrow

Moves focus right one character or component.Right arrow

Moves focus up one line or component.Up arrow

Moves focus down one line or component.Down arrow

Moves up one pane of information.Page Up

Moves down one pane of information.Page Down

Moves to the beginning of the data; in a table,
moves to the beginning of a row.

Home

Moves to the end of the data; in a table, moves
to the last cell in a row.

End

Activates the default command button.Control Enter or Control-Return

Dismisses a menu or dialog box without
changes.

Escape

Activates the component that has keyboard
focus.

Spacebar

Special Navigation/Activation Keyboard Shortcuts

In addition to the common keyboard shortcuts, the Xerox Nuvera provides special
navigation and activation keys. These keys allow the user to navigate around the user
interface and interact with the components and features of the system.

ActionKeyboard OperationComponent Type

Moves the focus between the
panes to first focusable ele-
ment in pane.

F6Split Pane

Gives focus to splitter bar. Ar-
row, Home and End keys can
be used to move the bar. Arrow
keys give fine control of move-
ment. Home and End keys ef-
fectively hide an entire pane
from view.

F8
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ActionKeyboard OperationComponent Type

Shortcut puts focus on first
mode indicator, from which the
user can post the tool tip. Mode
indicators can include one or
more of the following modes:
Secure, Job Fault, Diagnostic,
Remote Workflow, and Log-
ging.

Control-DMode Indicators

Pauses the printer or scanner.Control-PPause button(s)

Puts focus at the selected tab.Control-Up ArrowTab Pane

Moves between tabs.Arrows

Moves to previous tab, prepar-
ing to enter first focusable
component in tab.

Control Page Up

Moves to next tab, preparing
to enter first focusable compon-
ent in tab.

Control Page Down

Moves the focus between a
FAB and the first focusable
element within that FAB.

Control-Shift-Left Arrow/ Con-
trol-Shift-Right Arrow

Feature Access Buttons (FAB)

Moves focus one cell to the
right. If the table cells are selec-
ted, the focus should wrap, left
to right, top to bottom and
then back to the top of the se-
lected region.

TabTables

Moves focus one cell to the left.
With cell selection, Shift tab
behaves similarly to Tab, but
in the reverse order.

Shift-Tab

Move focus one cell down, row
selection follows focus. At bot-
tom of table, focus wraps to
top of column. If more than
one cell is selected, the focus
should wrap to traverse each
selected column in turn and
then repeat from the begin-
ning.

Return/Enter

Behaves the same as Re-
turn/Enter but in the reverse
direction.

Shift-Return/ Shift-Enter
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ActionKeyboard OperationComponent Type

Deselects current selection and
moves focus up/down one cell,
re-establishing row selection in
focused cell row.

Up/Down Arrow

Deselects current selection and
moves focus left/right one cell.

Left/Right Arrow

Deselects current selection.
When no vertical scrollbar is
visible, moves focus and row
selection to last/first row in
table. The focused cell remains
in the same column in which it
originated. When a vertical
scrollbar is visible, scrolls the
table up/down one row and re-
establishes the selected row as
the last/first visible row in
table. The focus is moved,
within its current column to the
newly selected row.

Page Up/Page Down

Deselects current selection.
When no horizontal scrollbar is
visible, moves focus to first/last
cell in row and re-establishes
row selection where focused
cell resides. When a horizontal
scrollbar is visible, scrolls the
table to left/right to make first
incompletely displayed column
visible and places the focus in
that column. Row selection is
re-established in focused cell
row.

Control-PageUp/ Control-
PageDown

Deselects current selection.
Moves focus to first/last cell in
row and re-establishes row se-
lection in focused cell row.

Home/End

Deselects current selection.
Moves focus to first/last row in
table within the same column
where focus originated and re-
establishes the row selection.

Control-Home/ Control-End

Select all rows in a table.Control-A

Selects whole row.Shift-End

Extend selection up/down one
row in table.

Shift-Up Arrow/ Shift-Down
Arrow
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ActionKeyboard OperationComponent Type

Extend Selection up/down one
"table page" at a time. When
no vertical scrollbar is visible,
moves focus and row selection
to last/first row in table. The
focused cell remains in the
same column in which it origin-
ated. Row selection is estab-
lished from original row in
which focus resided to the row
in which the focus has been
moved. When a vertical scroll-
bar is visible, scrolls the table
up/down one row and moves
the focus within its current
column to the newly visible
row. Row selection is estab-
lished from original row in
which focus resided to the row
in which the focus has been
moved.

Shift-PageUp/

Extend Selection from current
row where focus resides to be-
ginning/end of table. Focus
does not move.

Control-Shift Home/ Control-
Shift End

Presents popup menu, if one
exists.

Space

Move table column where fo-
cus resides right/left, one
column in the table.

Alt-Right Arrow/ Alt-Left Arrow

Extend selection up/down one
row in table.

Shift-Up Arrow/ Shift-Down
Arrow
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ActionKeyboard OperationComponent Type

Extend Selection up/down one
"table page" at a time. When
no vertical scrollbar is visible,
moves focus and row selection
to last/first row in table. The
focused cell remains in the
same column in which it origin-
ated. Row selection is estab-
lished from original row in
which focus resided to the row
in which the focus has been
moved.
When a vertical scrollbar is vis-
ible, scrolls the table up/down
one row and moves the focus
within its current column to the
newly visible row. Row selection
is established from original row
in which focus resided to the
row in which the focus has
been moved.

Shift-PageUp/ Shift-PageDown

Extend Selection from current
row where focus resides to be-
ginning/end of table. Focus
does not move.

Control-Shift Home/ Control-
Shift End

Presents popup menu, if one
exists.

Space

Move table column where fo-
cus resides right/left, one
column in the table.

Control-Right Arrow/ Control-
Left Arrow

Sort column where focus
resides in ascending/descend-
ing order. (This assumes that
the table has sorting activ-
ated.)

Control-Shift-Up Arrow/ Con-
trol-Shift-Down Arrow

Deselects current selection and
moves focus up/down one ele-
ment, > re-establishing selec-
tion on focused list element.

Up/Down Arrow
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ActionKeyboard OperationComponent Type

Deselects current selection.
When no vertical scrollbar is
visible, moves focus and ele-
ment selection to last/first ele-
ment in list. When a vertical
scrollbar is visible, scrolls the list
up/down one row and moves
focus and element selection to
the last/first visible element in
list.

Page Up/Page Down

Moves focus and selection to
first/last element in list.

Home/End

Select all elements in list.Control-A

Extend selection up/down one
list element at a time. Focus
moves too.

Shift-Up Arrow/ Shift-Down
Arrow

Extend selection up/down one
"page view" at a time. Focus
moves to bottom/top of selec-
tion.

Shift-Page Up/ Shift-Page
Down

Extend selection to top/bottom
of list. Focus moves to top/bot-
tom of list.

Shift-Home/ Shift-End

Scroll viewing window up/down
one row at a time.

Up/Down ArrowScroll Bars

Scroll viewing window up/down
one "page view" at a time.

Page Up/Page Down

Scroll viewing window to the
top/bottom of displayed com-
ponent (eg. tree, table, or list).

Home/End

Select menu item with focus.Space/EnterPop Up Menu

Move focus to previous/next
menu item.

Up/Down Arrow

Assuming focus is at a cascad-
ing menu element, open up a
cascading menu.

Right Arrow

Assuming focus is at a cascad-
ing menu element, close the
cascading menu.

Left Arrow

Exit pop up menus.Esc

Post (activate) menu.Space/Down ArrowPull Down Box Menu
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ActionKeyboard OperationComponent Type

Move focus and select previ-
ous/next menu item.

Up/Down Arrow

Exit pull-down menus.Esc

Launch menu.F10Menu Bar

Move focus to previous/next
menu item.

Up/Down Arrow

Select focused menu item.Space/Enter

Exit menu.Esc

Move focus and selection
up/down one row in directory
tree.

Up/Down ArrowDirectory Tree

Move focus left/right one
column in directory tree. If
closed folder is selected, right
arrow opens folder when it is
not empty. If folder is open
and selected, left arrow closes
folder.

Left/Right Arrow

Move up/down one "page
view", first focusable compon-
ent in view gets focus and selec-
tion.

Page Up/Down

Move to first/last element in
tree. This element gets the fo-
cus and selection.

Home/End

Move focus up/down one row
in directory tree.

Control-Left Arrow/ Control-
Right Arrow

Move up/down one "page
view", first focusable compon-
ent in view gets focus.

Control-Page Up/ Control-Page
Down

Move to first/last element in
tree. This element gets the fo-
cus.

Control-Home/ Control-End

Select element in directory tree
where focus is located.

Space

Launch tool tip if one is at-
tached to focused component.

Control-F1Tool Tip

Dismiss tool tip.Control-F1/Esc
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Keyboard Shortcuts and Mnemonics

NotesResultKeyboard Shortcut

Pause dialog (pauses both
printing and/or scanning)

Pause buttonCtrl-P

PS onlyPause ScanningCtrl-N

When available on the UI (as
applicable to the configura-
tion)

Unload buttonCtrl-U

DC/ST onlyClear All buttonCtrl-A

Content Area

When pathway to the Start
button is open.

Start button (Copy, Scan to
File, Print Service)

Ctrl-S

List of Mnemonics

CommentsItem(s)Letter

Menus

Top level Logon menuAlt-L

Top level Logon menu needs to
be open. Once menu is open,
user would use the "l" key to
open the logon dialog.

LogonL

Top level Logon menu needs to
be open. Once menu is open,
user would use the "f" key to
open the logoff dialog.

LogoffF

Top level System menuAlt-M

Top level System menu needs
to be open. Once menu is open,
user would use the "p" key to
pause the RIP. The Ctrl-Shift-P
combination is an accelerator,
which does not require the user
to open the System menu.

Pause Processing Ctrl-Shift-PP

Top level System menu needs
to be open. Once menu is open,
user would use the "r" key to
resume the RIP. The Ctrl-Shift-
R combination is an accelerat-
or, which does not require the
user to open the System menu.

Resume Processing Ctrl-Shift-RR
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CommentsItem(s)Letter

Top level System menu needs
to be open. Once menu is open,
user would use the "d" key to
open the service diagnostics
dialog.

Service DiagnosticsD

Top level System menu needs
to be open. Once menu is open,
user would use the "s" key to
open the Shutdown dialog. The
Ctrl-Shift-S combination is an
accelerator, which does not re-
quire the user to open the Sys-
tem menu.

Shutdown Ctrl-Shift-SS

Top level Printer menuAlt-I

Top level Setup menuAlt-E

Top level Administration menuAlt-A

Top level Help menuAlt-H

Pathways

Copy Service PathwayAlt-C

Scan to Digital Service Path-
way

Alt-S

Print Service PathwayAlt-P

Job Manager PathwayAlt-J

Queue Manager PathwayAlt-Q

Content Area

When pathway with button is
open.

Reset button (Copy, Scan to
File, Print Service)

Alt-R

When pathway with button is
open.

Build Job button (Copy, Scan
to File)

Alt-B

When pathway with button is
open.

Continue Build Job button for
Build Job (Copy, Scan to File
Service)

Alt-O

When pathway with button is
open.

End Build Job button (Copy,
Scan to File Service)

Alt-N

When Build Job is on.Cancel Build Job (Copy, Scan
to Service)

Esc

Child Window Controls

When child window is open and
has focus.

OKAlt-O
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CommentsItem(s)Letter

When child window is open and
has focus.

ResetAlt-R

When child window is open and
has focus.

Apply, Add Insert, Add Excep-
tion, or Add Cover

Alt-A

When child window is open and
has focus.

HelpAlt-H

Mouse Specifications

USB track ball or Optical mouse.

Display (Monitor) Specifications

1024 x 768Screen Resolution

256,000Colors

19 inchesScreen Size

.27Dot Pitch

>50hzRefresh Rate

Media Drive Specifications
All Xerox Nuvera systems are equipped with a CD-RW/DVD drive, located just to the
right of the monitor in the Control Console.

File Submission

Systems equipped with the CD drive support reading from and writing to CD-R and
CD-RW formats.

Systems equipped with the DVD drive support reading from and writing to CD-R, CD-RW,
DVD-R, DVD-RW, DVD+R, and DVD+RW formats.

For details on submitting a job from the optical drive, see Printing from the Media Drive.

File Saving/Archiving

On Xerox Nuvera systems that support copying and scanning, you can save scanned
jobs through the Scan-To-File application. Scanned and printed jobs can be saved to
the system disk, the CD-RW or to any NFS-mounted drive. Both the "ripped" image and
the job ticket are saved.
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For best results use good quality optical media for saving and archiving.

Electrical and Environmental
Specifications
The print engine, which includes the FreeFlow Print Server, requires:

Frequency

50/60 hz

Voltage

US/Canada Line Voltage:

• Protection 115-127/200-220V 2 phase, 3 wire+ PE
• Line Current 24A or 40A, Frequency 60 and Branch Cir 30A or 50A

EU Line Voltage:

• Protection 200-240 V
• Line Current 24A, Frequency 50 and Branch Cir 30A

Amps

Dedicated 30 amps (Europe)

Dedicated 50 amps (US, Canada and Japan)

The outlets/circuits can not be shared with any other devices or equipment. Optional 50
amp Adapter Box and 30A Extension Box with appropriate circuit breakers are available.

Receptacle NEMA Part Number

14-30 R (NASG)

Temperature and Humidity

Recommended 50 degrees F to 87 degrees F (10 C to 30.6 C)

15% relative humidity (minimum) to 85% relative humidity (maximum)
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Altitude

Between 0 to 6000 ft (1828.8m) above sea level

Heat Emission

Approximately 2,018 BTU/hour (standby) and 11,600 BTU/hour (running)

Power Consumption

Approximately 0.658 kw maximum (standby) and 4.150 kw maximum (running). For
information on power consumption, see Power Saver Mode.

Sheet Feed Modules (SFM)
The Xerox Nuvera can be configured with up to four Sheet Feed Modules. They include
a 4-Tray Feed Module that can be installed with an optional Integrated Scanner, and
an optional large format, high capacity 2-Tray Feed Module.

The Xerox Nuvera can have any combination of the 4-Tray or 2-Tray Feed Modules
installed up to a total of four modules. If the 4-Tray Feed Module has a scanner, it should
be installed closest to the Print Engine.

The 4-Tray Feed Module, without a scanner, or the 2-Tray Feed Module can also be
installed as a post-fuser Insertion Module.

Note
The Xerox Nuvera 200/288/314 EA/MX Perfecting Production System 2-Tray SFM is
capable of feeding paper up to 19.33 inches (491 mm) in process length. This is not an
option on the Xerox Nuvera EA 2-Tray SFM.

Note
You can also configure your Xerox Nuvera with a 3-Tray Sheet Feed Module. If your
system includes a Roll Feeder, either a 3-Tray SFM or 4-Tray SFM must be installed.

4-Tray SFM Capabilities and Capacities
Note
Some of the sizes shown below are the actual range of tray guide adjustment, rather
than a nominal paper type. For example, 8.5 x 11 inches is a paper type and 5.5 x 8.27
inches is the range of tray adjustment.

• Paper Weight Range: 16 lb. bond to 120 lb. index (56 to 280 gsm)
• Paper Size Range: 5.5 x 8.27 inches to 12.2 x 18.5 inches
• Total Paper Input Capacity (based on 20 lb. bond/75 gsm): 5,800 sheets
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• Number of Feed Trays: 4

- Tray 1: 1,600 sheets (5.5 x 8.27 inches to 9.0 x 12.6 inches) (139.7mm x 210mm
to 228.6mm x 320mm)

- Tray 2: 3,100 sheets (5.5 x 8.27 inches to 9.0 x 12.6 inches) (139.7mm x 210mm
to 228.6mm x 320mm)

- Tray 3: 550 sheets (7.2 x 8 inches to 12.6 x 18.5 inches) (182.9mm x 203.2mm
to 320mm x 469.9mm)

- Tray 4: 550 sheets (7.2 x 8 inches to 12.6 x 18.5 inches) (182.9mm x 203.2mm
to 320mm x 469.9mm)

2-Tray SFM (18.5 inches) Capabilities and Capacities

Both trays have the same specifications.

• Paper Weight Range: 16 lb. bond to 120 lb. index (56 to 280 gsm)
• Paper Size Range: 8 x 10 inches to 12.6 inches x 18.5 inches (203.2mm x 254mm to

320mm x 469.9 mm)
• Total Paper Input Capacity (based on 20 lb. bond/75 gsm): 3,200 sheets
• Number of Feed Trays 2

- Tray 1: 1,600 sheets (8 x 10 inches to 12.6 x 18.5 inches) (203.2mm x 254mm
to 320mm x 469.9 mm)

- Tray 2: 1,600 sheets (8 x 10 inches to 12.6 x 18.5 inches) (203.2mm x 254mm
to 320mm x 469.9 mm)

2-Tray SFM (19.33 inches) Capabilities and Capacities - Available
for Xerox Nuvera 200/288/314 EA/MX Perfecting Production
System only

Both trays have the same specifications.

• Paper Weight Range: 16 lb. bond to 120 lb. index (56 to 280 gsm)
• Paper Size Range: 8 x 10 inches to 12.6 inches x 19.33 inches (203.2mm x 254mm

to 320mm x 491 mm)
• Total Paper Input Capacity (based on 20 lb. bond/75 gsm): 3,200 sheets
• Number of Feed Trays 2

- Tray 1: 1,600 sheets (8 x 10 inches to 12.6 x 19.33 inches) (203.2mm x 254mm
to 320mm x 491 mm)

- Tray 2: 1,600 sheets (8 x 10 inches to 12.6 x 19.33 inches) (203.2mm x 254mm
to 320mm x 491 mm)
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3-Tray SFM Capabilities and Capacities

The 3-Tray Sheet Feed Module is an optional feeder that can be used with any other
Feed Module combination. The paper and tray specifications are the same as the 4-Tray
Feed Module except that trays 3 and 4 are combined.

For more information on supported papers, see Recommendations for Paper Usage.

Caution
Paper trays do not lock and can be opened while paper is being fed from the tray, resulting
in misfeeds and/or paper jams. Wait for the LED light on the tray to turn OFF before
opening the tray.
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